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LEI, UFTRE AT v 7 &R LW, ay e —/LOE{EICHEA TRV A
Ty T ERET DG, HDOWIE, 1 DOEIEL BT _E A N2 MK LT UFT 2
BEOAT v T HLEFELIZY, AT v 7 EE T RETRNE TR LEZY T8
&b d v EJ, Java Add-in Extensibility ZEHT 2L, Uy R 354X MORED
AR ML TCRET DT AL - AT v TEEFTTEET,
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ST - ARAB L - a0 bO—LIZHT ZIBERTFED UFT 7R— k
& Extensibility 72 3 > O

WORNE, Java Add-in Extensibility ] L CUFT O AX A2 ha—LOHKR— b
EUETLIHEERLET,

KIZ7~9 AllLights = > h = — L%, UFT WCEAE DY R— N WTF—h TS r—
var Ty,

{8 Applet Viewer: org boutique_toolki._. [B[=] 3

Applet started.

ZOT TV =g E, ROLIICEMEL £,

> 7y FEENEZ 2 Uy T 25&, WEOL—/L - &y MIEDSNT, SEIFERT
A b A Y (EiEA7) 12720, LightOn i 72 % L LightOff 7 7 2 NE#H S h
iﬁ‘o

» [RESTART] Rh& > %7 Vv rF5L, §_XTOTA MR A 7270 £9, LightOn
h oL LightOff 1o Zixzhnildbd CEFSNET,

> ZOMOMEEE 7 Y v 7 LTHMHEZY £HA,

> ZOX—L2DOBEMITITRTDIA b2 A icdT52 LT, §_XTDTA MR AUIT
RAHLEBHERD A vE—URFRENET,



% 1 E « UFT Java Add-in Extensibility D#E

T2l b AL BFERAL IOy fa—LERASL Y b AL, UFTIZZh%E
AllLights (B AZ L+ 7 5 ZAO4HT) LD Z&HATOIN JavaApplet &7k L E7, £
NDT A 2 NFTHEHED JavaApplet 7 7 ADT A 242720 £9,

2% Object Spy @
[ FEE G
Ohiject hierarchy:

Propetties | Operations |

@ Mative ) |dentification
Properties Yalues -
Ty Clags Mame JavaApplet
Ty abs 1030
Ty abs 171
Ty attached text
Ty hackground white
Ty class description window
Ty class path sun. applet Appletyiewer jave
T developer name frarne0 LI
Selection;
Clazs Mame
Drescription:

Degcriptions are available only for test object operations.

LCloze

AllLights = > b B —/LZxt3 20 R— b & HESFICRHSE FIT775 L, ¥—U—F-
Ea—3kD X 512720 £7,

Item Operation |Yalue Documentation
v £ Actionl
+ [ AllLights
LF Alllights iClick 142,144, "LEFT"iClick the "allLights" applet with the "LEFT" mouse button,
=i alllights:iClick 16,188,"LEFT" :Click the "allLights" applet with the "LEFT" mouse button,

i AllLights Click 211, Click the "allLights" applet with the "LEFT" mouse buition.
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TF 4 Z T, BEENET A MIKRO L IICHERENE T,

Javaspplet("AllLights".Click 59,60, "LEF T
Javasppleti"AllLights").Click 76,31,"LEFT"
Javappleti"AllLights").Click 147,20,"LEFT"

PUA® Click 27 v 7 OH0, ARV ~VLVTLEOFEM 2 £ T 515 (x FBAR & y BBIRB LU0
Vo2 &FTLIev A - REY) LEbICRBINET, Z0ORT v FiTbrvic
<, BHEEEGEHLI R T,
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Java Add-in Extensibility Zf# /] L C AllLights = > b —/L &P R—FF25 &, TV brb
LT WEERBE LN ET, UFTIE, = hr—/L% Lights &\ 9 4RiD AllLights 7 A

b e A7V FELTREL, WRAEARSNTTA a2 EHLET,

oy A=

X7 41Z1%, oncount X onlist & W ZBEERNEENET, T biE, HDHEEET

FNZI o TWDBTA FOREE, 7Y R

NONARFALE 2R L E T,

o Ohject Spy

(& SEE

Qbject hierarchy:

-7l

Fropetties | Operations|
() Mative @) |dentification
Properties Yalues -
fry ;
E-?;: I:abe.l Lights 1
Ur list_item _name
T~ logical_location
T~ logical_name Lights
T~ objects count
T~ oncount 9
T~ onlist 151012131618 2122 |
YT opague 0 1
Selection:

351012131618 21 22

Dezcription:

Descriptions are available only for test object operations.

Cloze

25



%5 1 E « UFT Java Add-in Extensibility D#IZE

ay b —WZT 57 A M E{ERT D HEfRANTE 5 &, ClickLight £~ » K & Restart
Ay RV AR—FENET, ZNHDAY v NI, kT 22¢d, ¥F—U—F-
Ea—n [24%] 17 L2TFHTBRIRT I TEET, £/2, Fzv /RS M
ER LT, gameover (T _XTDTA MNRAUNIRHSTWENE I, DFEY F—AIC
MoTenEDERT) eI e T A DEET v 7 THIELTEET,

F—U—R-Ea—7TiL TAMIKDOLIIZETRINET,

Item Operation | Yalue Caomment | Documentation
w @ Action]
Q Lights ClickLight ;4" "4" Click the light in rove 4" column 4",
Q Lights ClickLight :"1"."2" Click the light in o "1" column 2",
Q Lightz Check. CheckPoint]' Lights"] Check whether the "Lights" object has the proper walue
Q Lightz Restart Click the RESTART button,

TF 4 XTI, TAMIKOLIICERENET,

AllLights("Lights"

( ClickLight "4" "4"
AllLights'Lights"

(

(

ClickLight "1","2"
.Check CheckPoint"Lights")
Festart

AllLights("Lights"
AllLights("Lights"

A

ZOTARMIONIRLTL, TANOEREELED IR T,
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Varay 2 —_r=
HP UFT Java Add-in Extensibility Software
Development Kit D1 > X k—IJL

ARETIE, 4 A b—/LORFHESM: & HP UFT Java Add-in Extensibility SDK DA > A h—
NFEZOWTERHA L £,

AEORE

» HP UFT Java Add-in Extensibility SDK @1 > A h—/ LI DWW T (274—)
> A A BV DRSS (29—)

» HP UFT Java Add-in Extensibility SDK @1 > A h—/L (30~<—73)

» HP UFT Java Add-in Extensibility SDK @7 > A > A h—)L (33X—)

> NI TNy a—T 47 LHIBREIR - Java Add-in Extensibility Eclipse 77 7 1 (34
=)

HP UFT Java Add-in Extensibility SDK @41 > X F—)LIZDLVT

HP UFT Java Add-in Extensibility SDK Ci%, 7 A4 A Java 2> b e —/L® UFT - — b
EREFICEET, TDOSDK DA A M—/UE, ROBDONEENTWVET,

> HAHZ L Java 22 b — )L DOYR— ~OVERICEAT 5 API
> ROBEEE % 2 7= Java BI%EH @ Eclipse IDE R ABIRERED) W77 7 A~
> BAZK Y —Fy b PE— b by FERERT 00T 4 P—F

Eclipse @ Java Add-in Extensibility 7 « — R CTI%, LERT 7 AV, 7T A, A
Voo RRFTRTERINET, £z, V4 F—RFTERSNDA Y vy R A2 T %
FHLT, AV Yy FEEEFTLHZLHTEET,
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28

> BRI 7 ANV ERET DD a~v R

> TN TN r—varvl, TV = a O R— NEIEET DS, SERLE
Java Add-in Extensibility 72 =7 h®D¥ > b (BTN - T7FV r—va vt zne
nNoYR— k¥ M, <Java Add-in Extensibility SDK 4 > X b—JL = 7+ JL 5>\
samples 7 + VX124 VA M= ENRET),

UFT Java Add-in Extensibility > FILDO &

Java Add-in Extensibility SDK ®—ii & L TSN TV D TV EHEHT 5 &, Java
Add-in Extensibility 78— b « & v FOFRRFHIOWCREMICEE CE £,

Y TVTHE, SDKA 32 By MRANL—T 7« VAT LD
C:\Program Files\HP\Unified Functional Testing 7 + /L X214 VA h— /L ETW 2%
L EAHEE LTWET,

SN OLE, UFT TY > AT 280, Aoy — ¥ v b« R — k-
v hTCTROFEEZITOMERDY 7,

SDK 7% C:\Program Files\HP\Unified Functional Testing |2 >* A b —/L I LT 720
B

1 &% 7 nizonC, Configuration 7 /L% (<Java Add-in Extensibility SDK
VA b—IL = THIIF >\samples\<H > FILE >Support 7 + L EHN) 1THDH Y —v
v h#E XML 77 AT, BIfED UFT A A b=/« XZA&EHEH LT
SupportClassPath 7' v /35 ¢ 25 L £ 4,

2 ZH T NZHONT, .classpath 7 7 1 /L (<Java Add-in Extensibility SDK 4 > X
k—JL = Z#4 L4 >\samples\< B> FILE >Support 7 + V4 N) T, BLED UFT A
VAL s RS THET 2T XTOT 7 A/« NAZHEH LET,

SDK 7% 64 B NMEASNL—F 4 v J « VAT KA VA R— L ENTWDLHEAEIE, &7
YT ONWTELIZIROERZITVE T, .classpath 7 7 1 /L' C, mic.jar 7 7 A /L~
D /X2 % C:/Program Files/HP/Unified Functional Testing/bin/java/classes/mic.jar 7>
5 <Java Add-in Extensibility SDK 4 > & k—JL * 7 & JL 4 >/bin/java/classes64/
micjar IZEE LE T,
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4R F—ILDRIHREH

UFT Java Add-in Extensibility SDK O > A b — L% BRtAT 2 HIZ, IROFMFE57- LT
L EEHERL TSN,

» Java Add-in Extensibility Eclipse 7F 7' A 2T 25 FENH 2BEIE, HiH+ 5=
V¥ 2 —HIZ Java BAFEH D Eclipse IDE 23 A V' A b — /L SN TWNWDHZ & Z#fERLET,
Eclipse IDE %, http://www.eclipse.org/downloads 7 H 4K CH# v o — R TE £,
PR — kxR D Eclipse 73— 5 {22 T, [HP Unified Functional Testing {3 F AT AE
B~ M) 7R 2B T 23V, ZHUE, Unified Functional Testing ~/L 7127
27 ¥ A4 % 7>, Unified Functional Testing DVD D/L— b « 7 3 L Z 2R SN T ET,

Eclipse IDE %A A h—/L 5L X2, 2 Ea—F EDOA VA=A EEATLT
BWTL 72 &V, Java Add-in Extensibility SDK % 4 > A h— /L 52, ZOFEH%E
AT HUERHY 77,

3% : Java Add-in Extensibility Eclipse 7°7 7' A 0%, B UHE [Fo2— U TIb : Java I
AL L= Fy b BR— FOERTEDOTFE] OF 2a— NV TAVEFEITT D
AICMBEEZ2R 0 FF, £z, el by —nF v b PR — hOEAREEDOHREFC
X, ZOFI A EENTL L eBEDLET,

» (A7 a) UFT & Java Add-in AR I B a—Z |l VA h—LENTWNSH I &
R LET, ZAUT LY, Java Add-in Extensibility Eclipse 7°F 7' > & UFT % il
SHT, WAZL - Y—NFy ks FR=FDT Ry IFRT A NEHRNIT) Z &
MNCTEET, 2&xlE, UFT ® 22 ¥ =2 —# kT Java Add-in Extensibility Eclipse ~7° 7
TAvEERTDE, RF a7 ) v 7T AHRETTHRBEILY— L%y b - PR— %
UFTIZT 7 rA LCT NNy T E(TH ZENTEET,

3¥ : UFT Java Add-in Extensibility SDK % 1 > A b —/L ¢ 5 HIIZ UFT & Java Add-in % A
YA M= LTEDNRVNE, UFT & OMEEAVE 7R Java Add-in Extensibility Eclipse @
HERBITfEH C&E <2 £,
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HP UFT Java Add-in Extensibility SDK 1 > X k—)L

HP UFT Java Add-in Extensibility SDK @ - > A | —/L{Z|%, Unified Functional Testing
By Ny T TSI AEHEALET,

30

UFT Java Add-in Extensibility SDK 4 YR b—ILT BIZIE, ROFIEERTLET,

1
2

Eclipse & UFT D3 _RCOA LV AZ U A%ALET,

CD-ROM/DVD R 7 A 7'|Z Unified Functional Testing DVD %ffi A L £, [Unified
Functional Testing D&~ b7 v 7] U 4V RUNBREET (V4 v KUV
&%, DVDD/L— |k - 74V FIZH D setup.exe =X 7 /V7 U v 7 LET),

[P FA Iz &k HEHRRE & Web Y—IL¥y k] %2 U » 7 L £, [Unified Functional
Testing Add-in Extensibility & Web 2.0 Toolkit D% R — ~] HE23HH = £ 7,

[HP UFT Java Add-in Extensibility SDK Setup] #7 V v 7 L%,

HP UFT Java Add-in Extensibility SDK Setup ™7 - ' — K Welcome BEE 23 FR S E T,

[Next] %27 Y v 27 L%9, [End-User License Agreement] [Hm23HH X £,

3¥ : [Modify, Repair, or Remove Installation] H[[HAF R IN5EE, SDK L2 B2 —
HEZTTIZA VA=V ENTHET, ZOHE, HFLINA—Ta i VA F—
T BRI, BEONR—Va v a2 T oA VA=V TERERHY £ 33 -
THP UFT Java Add-in Extensibility SDK D7 > > A h—/b| LML T Z&E W),

License Agreement (i JHFF#RK)) OWNE LML LT, [laccept the terms in the
License Agreement] %% L £7°,
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6 [Next] #7 YV v 2 L7, [Custom Setup] BFAHHE E7,

15} HP UFT Java Add-in Extensibility SDK =] @ =3

Custom Setup

s to be installed.

SDK

Eclipse Plug-ins

Dacumentation

Samples
This Feature requires 223KE on your
hard drive.

Location: Ci\Program Files (xg6)HPUnified Functional Testing', Brawse. ..
[ Reset I [ Disk Usage I [ Back. ” Tk | I Cancel J

> By N7 R4TH &, [Custom Setup] BIAEIZET I DT TOMRED HEIRY
ZA VA R—=LENET,

> Z OEHIZIE, UFT Java Add-in Extensibility SDK D1 A b —/VERRARIINET,

UFT A v A b —/L &N T35 2> B 2 —#|Z UFT Java Add-in Extensibility SDK
EA VA N=AT L85G, UFTOA A =)L« 74 VI PEETERIRENET,

BODOA A =L EBINT 5120%, [Browse] Z27 U v 7 LTT 4 /LX &38R
L, #\WT [OK] 27 V v 27 LET,

> [DiskUsagel %7 U v/ +%L, a bt a—F LOWBETFT 4 ZAIFEBEA VA F—
WVICHBERRBEEZTRT U 4 RURFEREINET, £ VA M= VIHEREREIC
1%, UFT Java Add-in Extensibility SDK 7 7 A /L & 7 4 N FICHBIRRE (Z DA
VAM—VAICEIR LT 4 A7 OFE) &, A VA M VRHZOARERT 5 A
TheTARAT (ARXV—=T 4T« VAT EANA VA R=LENTNET £ A
7)) LORENEENET,
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32

7 [Next] 27V v 27 L%7, [Ready toInstall] BEHENFRINET,

8 [Install] #7 Y » 7 L¥79, UFT Java Add-in Extensibility SDK 231 > A h—/L X1,

B a—# LD Eclipse DA VA M=)+ T NVEEIRETDHEA TR Ry 7 A
PWERRENET,

HP UFT Java Add-in Extensibility SDK

If ou want ko waork with the Java Add-in Extensibility Eclipse plug-in, enter the Folder where
Eclipse is installed.

Eclipse installation folder:

Browse. ..

If vou click Cancel, the plug-in will not be installed.

‘ Cancel |

FEIE L7 Eclipse DA > A b —/L+ 7 )L Z 2T, Eclipse {Z Java Add-in Extensibility
Eclipse 77 7 A VIR A VA b= INET,

3% : UFT Java Add-in Extensibility SDK MDA > A b — /L R5E T L721#% T, Hll® Eclipse A
> A h—/VIZ Java Add-in Extensibility Eclipse 777 7' A & A ' A h—/L§ 5 Z L BT
EET, TNEITHITIE, A A=%D <UFT Java Add-in Extensibility SDK
AR =)L - TH IS >\eclipse 7+ /L7 B LT, deploysdkplugins.exe % 3
ITLET, FRENDLAT RS Ry 7 AT Eclipse A b—JL « 74L& % ANF]
LT, [OK] #27 YU v 7 LET,

DT ITAUEERT LI TEN WAL, [Cancel] 27V v 7 LTFIE 9 12
HET, TNLSOYATE, [Browse] %27 U > 7 LT Eclipse f » A h—/L « 7 %)L
B E L, V— kD eclipse 7 4V X ERIRLTC, [OK] 27V v 7 LET,
T, [OK] #27 VU > 27 LT, Eclipse f A =L+ 7 VEZEHELET,
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9 % OEE T [Show Readme] F = v 7Ry 7 A% %R LT [Finish] 227V v 7
9% &, UFT Java Add-in Extensibility ® Readme 7 7 4 V3B & 97, Readme 7 7 A
ST, BEEHRE ST T a—T 4 VI T AR RS TR I N TV ET,
#%TReadme 7 7 A VEBRICIE, [RE—F] > [FRTOTAST L] >
[HP Software] > [HP Unified Functional Testing] > [Extensibility] >
[Documentation] > [Java Add-in Extensibility Readme] % 3R L 7,

[Finish] #27 V v 27 32L, ¥y h T o7« U4 F—FBKTLET,

EY b:A A N—)VF, Belipse IZ UFT D A = 2 —0Y — L X—REIR SN2 WA,
AV a—4 ETavwl K- 74 <Eclipse £ ¥R k—JL « 7+ L& >\eclipse -clean %
FITL T Eclipse 77 /A L OREEY 7L v 2 LTHhD, Eclipse ZHERWTL
AN

HP UFT Java Add-in Extensibility SDK 7 >4 > X k—JL

HP UFT Java Add-in Extensibility SDK D7 > A > A h—/UE, 1Z D7 a 7T A LRk,
[(FAYSLnEMEHEIRR] TfTvE9, F72i1%, Unified Functional Testing D& > 7 v
T Tu I AT TEET,

SDKDT7 VA VAR F—)VIZET 5 TEEE

» HP UFT Java Add-in Extensibility SDK O 7 > A ' A h—/L %475 &, $T® Eclipse
A A k=)L 5 Java Add-in Extensibility Eclipse 7°7 7’1 > D3I S £ 9,

T A A b=V, Bclipse 12 UFT D A =2 —0Y — W= & KRS b
A, av¥a—#% ETavr R+ J4 2 <Eclipse £ R b—JL = 7+ L5 >\eclipse
-clean %34T L T Eclipse 7’7 7 A Y O EE VY 7 L v ¥ 2 LTHh 5, Eclipse % FHER
NWTLZE0,

> vy N Ty T T u I AEHEHALTCSDK 7 A A M= T BB, DA
VARN=AECHERALEZO LRI A=V ar 0y N Ty T s I u s T AEEHATS
MERH D FT,

» UFT Java Add-in Extensibility SDK % 7 > > A h—/L¢ 5121%, EEEHERTr 7' A
VT HMERB Y 1,
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HP UFT Java Add-in Extensibility SDK #7 >/ X k—IL 9 BIC(F, ROFIATITL
Y,

1
2

5

6

Eclipse & UFT ® 3 _XTCOA LV AZ U 2%ALCET,

CD-ROM/DVD K Z A 7T Unified Functional Testing DVD %4 A L %9, [Unified
Functional Testing O > b7 v 7] 74 v RUBKHEET (U4 FUBENRNE
AL, DVD D/L— b « 73V ZIZH D setup.exe X7V U w7 LET),

[7 FA VI &k BHeEHERE Web Y—)L¥Xwy k] %2 U » 27 L E 7, [Unified Functional
Testing Add-in Extensibility & Web 2.0 Toolkit O %7 — ~] HEE2BH & £ 7,

[HP UFT Java Add-in Extensibility SDK Setup] %#2 U v 27 L$9, HP UFT Java
Add-in Extensibility SDK Setup 7 « #'— K0 Welcome B 23R SV E T,

¥ LETONR—=Y 3 0D SDK 231 VA b=/ ENTWAEA 1, HP QuickTest
Professional Java Add-in Extensibility SDK O% > v 7 v 7« 7 ¢ % — R EE) L £ 7,
O A —REFEHLT, ROFBERICHES>THWAA—=T 20D SDK 2T VA v A
r—nLET,

[Next] 27 U » 7 L %9, [Modify, Repair, or Remove Installation] B 23 F R SIVE T,

7 4 W — RO$ERIZHE> T, HP UFT Java Add-in Extensibility SDK Z Bk L %9,

FSITNLa—T 41 24 EHIBREIE - Java Add-in Extensibility Eclipse

7594

34

ATECIE, UFT Java Add-in Extensibility OfE B2 N T T a—F ¢ 7 LHIRE
HIZHOW T LET,

> Eclipse 3.3 |Z Java Add-in Extensibility 77 27 1 L & A A b —/L L7234, Eclipse ~/V

TTY TN =T ATV a UBRRIHTELROARER S Y 7,

[El8#3K : eclipse\features\com.mercury.qtjext.PluginFeature_1.0.0\feature.xml
7 7 A Vi ANSI A TIEZ2 < UTF-8 IR TIRIF L £ 7,



F3IE

HREL Y=Ly FOYHR— FDOEE

Java Add-in Extensibility % 33 2121%, R — F 3 25% Java Yy —/LF v MZX LT, A
ARBL - Y—=Fy b -YR—b -ty FEERLET, VRAZL Y —LFy bV
AR—hty ML JavaZ T AL XMLEEY 7 A VTHEBRINET, 2—FIMERT D
Java 7 7 A%, AV Y ROF—=N"—=F 1 RRFHA Y v FOERZITH> Z & T, BEFD
Java Add-in 7 7 A L 2N O DRRMET DR — M EJER L E T,

AETIE, AL L - V—=nFy MHT 20 R— FOERFEZHIILES, BEH
Wik, BARZ LY —=NFy b YR—b -ty NAIERT 277100, ZhbD7 7
ANDOREELENE, ZhoDT 7 A VOGOV T LET,

AEOHNE

> DAL L« Y —)bxy hOFFR— MMZONT (36-3—)

Java Add-in Extensibility O JFEOE (372—)

HAL I e =) xy hOYR— N OVEROHEE (38-3—)

HAZ I« D —=NFy ke PR— 1 -y bOER 393—2)

Y—LFy ke PR—b - 7T RZONT (433—)

Vb F oy hRRET 7 A T ONT (443—2)

TAN ATVl NEET 7 A MIONT (4578—Y)

AAB L+ FHR— K« 7T RZDONT (5554—)

HAR L Y —)LFy k- FR— b DT 7L LFET (783—)

HABL «HR—F 757200 LF NNy 7 (883—)

Y Y Y Y Y Y Y Y Y'Y

Java Add-in Extensibility DEHED T —7 7 a— (90—7)
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EI3E.HRAL - Y—)LFy DY R— FOFRE

HRBEL - Y—=ILFxy FOYR— FZDINT
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HAL I —)vF >y FO UFT 48— F Z2EET 285618, BEfF® UFT Java Add-in %
NR—=2 L7425 AP Z/ER L CTEMLET, ZDOAPI (WAZ LV —LFy k- FiR—
ko) IX JavaZ TRAE XML EET 7 A VIO SIVET, APLIX UFT &7
A NKGD Java T TV r—a L EDBDA X T =AM HZ L2k Y, UFT
TT 7V r—varyNDJava a2y br— V&3 L, Znboay ba—/UIx L TE
UL BEREITTED Lo LET,

ABETIE, WAZL Y= Xy b e PR—b By MNIRBERIESERT AL, 7
TR, Ay R, BRICOWTHMA L E T, 3522V T, [UFT Java Add-in Extensibility
API Reference] ([Tava Add-in Extensibility SDK ~/L 7] CTHIFAAHE)ZZMR L TL 72 &0,

HAL L =%y b« PR — b By FEERTDHERCIE, FERTISHE 2238 2 1E
B MR H Y T, FICOWTIE, 91— [HRZ L Y—LFy |« FR—
FOFHE ] ZZBL T I,

UFT Java Add-in Extensibility SDK (21X, Eclipse Java BARERIEH DO 77 7 A4  SHE I
TWET, ZOFTTA T, DAL L Y —Fy b PBR—k -ty FEIEERT
L2000 4 F—RBHHATEET, £, 20T T T 0L, EREO T 7 AN E
WETH-DOavr R ARSI THWET,

Java Add-in Extensibility 7 4 ¥ — R&EFH L TH AL A« Y —LF v | - R — M EERK
THE, MERT 7 AN, 7TA, RN A Y v RBRT_XTER S ET, £72, 7o
P—RTERENDAY v R+ AXTEFHALT, BIMOAY v KEFETLHZLEHT
xE7,

ERRICEFZMODANIH AL b - Y — ¥y b« $R— k- £y hORFHIOWTD
AR DI, FUE TFa—hU T Java WAK L« —)LF v b« PR— b
DOIERFEOFEE) OV A EFERLTLIEEN, TRHD L vy AT, Eclipse T
Java Add-in Extensibility 7 4 ' — R&FH LT, o7 BAZ L -3 ba—LDh
AL I R — R EERLET,

Java YV 7 b7 = 7 OBFEIZ Eclipse &1 H L“Cl/\foﬁl/‘i/%/u\f% Fa— Y TIEETT
BHBRIZ1X, Java Add-in Extensibility D72 812 Eclipse i3T5 Z L2 B8O L ET, —
#%1Z, Java Add-in Extensibility 7 % — K %ﬁﬁﬁ LCHAHFL «Y—)bFy b« FR—Fk
DEAMEE R T 20708, FEITERT 2 L0 bfiE T, v F—REFERALTh
AB L= Fy b PR FOEAEEELER L T D, TAENEIR U IFAR
RECTY =%y b« BR— FORFERT L ENTEET,
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Eclipse & UFT Java Add-in Extensibility Eclipse 7°7 7' A VDR E, BXOT T 74 L ff
HIZDWTIE, 27 ~— THP UFT Java Add-in Extensibility Software Development Kit ® -1
YA M=) ZBRLUTLIEE N,

Eclipse C Java Add-in Extensibility 7 « ¥'— FZ& i L2 WHFETH, REOFEH % 6
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> FxyZBAL M EHINETHERTE DT 2T 1,

> Fx v 7RA L MUBHETRIRSINIFB#H T2 T ¢ (UFTD [Fxv KRS bD
TanT ] FATRT Ry R),

FAaA-T7ANL

TDTAN ATVl bV TRMEHT DT A2« T7ANDNRR (FT Va3,
EFXLARWGAIL, BRI T2AOT A arBERHINET), IBERRER 7 7 A4 /Wi, Jdil,
.exe, .ico DWT T,

ALNT-TFALNL

F—T— R Pa—FHFoT X TTAL ATVl MK LTFl =2 &Nz
LXIERENDIVTEFAN A~V T s NE YT, BRET7ANLTIE, ~VT - T 7
ANLTHD.chm D2 LE~LTID ZEFHLET,

FETAN ATV FRET 7 AT HETIL, UFT OFEREIRICHENICRY
iTo

HLWT AR TV F e VTR BT ENENDAL L - ay ba— LD
R— FDIERLIE, Fa—RUTAD241 _—2 MR ay Fa—L OV R— FHFED
] CHET L ENTEET,
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Y—LF Yy bOYR— FDRE

TAN ATVl NRET 7 ANE, ROT 7 ANVTRIETE ET,
<UFT 4 YR k=)L * 7 # L& >\bin\java\sdk\eclipse\plugins\
com.mercury.qtjext.plugin.QTJavaExt_1.0.0\ClassesDefintions.xsd

TAR ATVl MRET 7 A VO ER IO SLOFEMIZ OV T, [UFT Test Object
Schema ~/L 7 ]| ([Java Add-in Extensibility SDK ~/L 7" TRIHATRE) 2B MM L T 72 &0,

TARN ATVl NRET 7 A NVOKEGBITIZOWTIE, 78 X—V [HAX LV —
¥y b PR=FDTFF A LEIT] #BRLTLIIEE N,



EIE AL -Y—ILFyY DY R— FDEE

TFAF ATz FERET7AILOH

WwoFliE, javaboutique B X & A+ Y — L% v FAIC Calculator 7 A k- ATV 2
b 7T ADERERET DT AN ATV NRET 7 ANO—EERLTVET,

<Typelnformation Load="true" PackageName="javaboutique"
AddinName="Java">
<ClassInfo BaseClassInfoName="JavaApplet"
DefaultOperationName="Calculate" Name="Calculator">
<lconlInfo
IconFile="C:\Program Files\HP\Unified Functional Testing\samples\
Javaboutique\Calculator_3D.ico"/>
<Typelnfo>
<Operation ExposureLevel="CommonUsed" Name="Calculate"
Property Type="Method">
<Description>Builds the whole calculation process</Description>
<Documentation><![CDATA[Perform %a1 operation with %a2 and
%a3 numbers]]></Documentation>
<Argument Direction="In" IsMandatory="true" Name="operator">
<Type VariantType="Variant"/>
</Argument>
<Argument Direction="In" IsMandatory="true" Name="num1">
<Type VariantType="Variant"/>
</Argument>
<Argument Direction="In" IsMandatory="true" Name="num2">
<Type VariantType="Variant"/>
</Argument>
</Operation>

</Typelnfo>
<ldentificationProperties>
<ldentificationProperty ForVerification="true"
ForDefaultVerification="true "Name="value"/>
<ldentificationProperty ForVerification="true" Name="objects count"/>
<ldentificationProperty Name="width"/>
<ldentificationProperty ForDescription="true" Name="toolkit class"/>

</ldentificationProperties>

</ClassInfo>
</Typelnformation>
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ZOfIC, Calculator 7 A k « A7 Y7 b« 7 F A% JavaApplet 7 A k- T V=
J bV FARPERLET, T4 3 - 77 A1 Caleulator_3D.ico ZfEH L £ 9,
T, BEEREDT AN AT/ b AV v RidCalculate T3 (ZD X YV v KT
%, Variant . 3 DOMIED AT)/ST A —% operator, num1, num2 3%V £9),

Typelnformation X% N® PackageName J&£:/%, Calculator 7 A k «+ A7 Y= 7 | -
7 7 A% javaboutique ¥ —/L % v b - BAR— NRI/ERT DI EERLTOET,

Calculator 7 A bk « A7 V=7 b« 7 7 RAIX LT, ROBHET 0T 4 DEHRINT
W7,

» value: F v 7 RA L NTHMATEET, UFT D [F=v 7 RA L bOTFaF 1] &
AT7al Ry 7 ATHEETERSNET,

> objects count : F= v 7 KA N THHFRETT A, FEETITEIRSNAETA,

» toolkitclass : 7 Ak « A7 V=7 bR THHAINE TR, FoyvZRA 2 FTiE
FIHCEEEA,

UFT TTR b -FT2) FRE XML 20— F3 %A%

UFT #E174 5L, TR_RTHOT AL - AT V=27 bRET 7 ANDPHERAEN, S
if£77/l)ll/@721\ FT 2T R I TAOERN, 1 ODT AL AT V=T b
7 I ADEBICHEESNET, FEMCHOVWTIE, 53— [UFT TOT A+ - A7 V=
I MNRET 7 A NVOFREEFIEIZONT) 2L TN,

TA L ATV 2T MRIET 7 A L O IdentificationProperty 233 (213, UFT T ([4
TV NORM] FAT T Ry 7 AERBHLC) EREINDATREENRS HIERE
BETLREMEND Y 3, D EME &1L, AssistivePropertyValue, ForAssistive,
ForBaseSmartID, ForDescription, ForOptionalSmartiD,
OptionalSmartIDPropertyValue T7, Z ®JEMIZH-SV\ T, UFT THEHEITHEH
LT NRT A DY A SBREY EF,

Lffﬁxoﬂ“’fﬁ XETIE, UFT I3EEEE XML 7 7 A Vinb 1 ERTFAAALET, 2
kY, (A7 V=7 b0 £A4 707 « Ry AT2—YIMToEHFRNEN
£ énézézcifm 720, UFT CiE, ZOXHCLT, a—PEZEDO T T ¢ -V
ANPEEINRNEIIZLTWET, GElICONTH, 85 X—Y [TA L - A7V
JMRETFANTHESN R T 03T 4 BHEOEF] 2B LT IEEW,



EIE AL -Y—ILFyY DY R— FDEE

UFTTODTRA - F IOz FRET7AINDFEESHEIZONT

UFT [ZEB D= TNZ, <UFT 4 R b—JL = 7 # L& >\dat\Extensibility\

UFT 7 RA V&> 74V HICHDT AL ATVl FRET 7 A VT X CaidiA
FT, RIS, TAN ATV MRETZ 7 A NVDENENOBEEIIIGLT, &7 74
NDTAN - FTVx2 b I TADERE 1 OOT AL ATVl b+ 7T AERER
v —Y LET,

WIZHELT 285G, TAR AT V=27 bRETZ 7 A NVNOERITEHINET,
> Typelnformation 53 @ Load &7 false IZ58 & STV DA

> TAD ATV T MRIET 7 AVICHET DBREEL [T P ~3x—=V v ] A7
BY e Ry J RAZEREINTODEA, UFT 2—PMRBEEZ v — FLARVRREIT- T
WH 58,

TAN ATV T NRET 7 A NVOELEL, Typelnformation %55 @ Priority &%
TEHRLET,

TAN ATVl NRET 7 A NVOELRENEGFD Y 7 AERXLY bEWEE, BEF
DTAN FTTVxr b7 T7ADEHR FHHIAHO UFT FHREET) T4 ——TF A
FENET, L7ER-T, AL - FT V27 FRET 7 A NVOERELZLEET LIS
WZ1E, MAARBIEN A — =T 4 RENDAREMENH 2 RIZHER L T E &N,

TANFTV=T b I TADERDERFIET D58, BeTOERITIUFTICE -
THE XN Ed, ROIETIE, Classinfo, ListOfValues, Operation O % EHE N T X
ATV FEET 7 ANVNTEEER SN TV D HEOLBIZ OV TR LET,
ETAN A7 Tx=7 k- 7 Z AD ldentificationProperty 2|33 XT 1 D2OT A |+
FTV 2l NRETFANTERTLINERDH Y £77,

Classinfo &%

» ClassInfo BERENT AL - ATV x7 FRET7 7 ANTERIN TN, BEFEOES
L0 BEREEREWGEES, ZoERIEBEFOERICEBMINES, O 7 7 AL T
EFEN TV Classinfo M THANRKAE LIZEES, BEEOEHWT 7 A /LDEHT
BWT 7 A VDERNRF—NR—F A F (B SNET,

» Classinfo ZENRT A K « A7 V27 MRETZ 7 AV TEHEINTWT, EIRENRE
TFOEREFUNELIHENGES, ZO0REFOERICEBNEINET, K07 71
IVTEFRZESIN TS Classinfo B THEA N LG, BREORWERITERS
nWET,
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ListOfValues 3%

> B DT 7 AL TERZEN TV ListOfValues [E TEi A 23 54E L8, BEEOS
W7 7 ANVDEZTIRNT 7 A IVDEBNT—N—F A F (BH) ShET (w—
INFEHA),

> ListOfValues DEFHE THAAD Y A M RA— =T 4 FENDZHE, HrLWIU X ML,
TDTFAN ATV NRET7ANMIEENDS T FTAORIETERINLTNS
Enumeration % f OS5 T X TR KM I LET,

> ListOfValues 2R ET7 7 AV TERINTNT, HERENBEFOERE LV IKWEGE,
BREORNVERITEHESNET,

Operation 3%

» Operation EH(X, 7A b - A7 V=7 NRET 7 A VOB EIZESNTEM,
B, A—R—=F 4 s ET,

> Operation EENT AL « ATV MRET 7 ANV TERINTNT, BEFOER
L0 BERENFEVGS, 7 T AOBFEOERICZOBRIENBINENET B0 7 7
A NVTEZR I TV 5 Operation B THANBAE LGS, BREOHENT 7 A LD
ERTENT 7 A NVOERBA— =T 4 F (EH#) ShET (v—VEIhEHA),

FEANIZ DU T, TUFT Test Object Schema ~/L =7 ] ([Tava Add-in Extensibility SDK /17" ]
THEATRE) 22 L TEEN,



EIE AL -Y—ILFyY DY R— FDEE

HRBL YR —F - H9FX[2DNT

HABEL T —NLFy b e PR—hK By bCTIE, VR—FPINDBIALL T TFTRAT
EWCHARLZ L « PR —F « FTANFHELET, DAX L - FR—F - 7T RF, BA
BT TADAY v Re UFT OMEEE ORIOFEEDOA 2 7 = — AR LET, Z
D X 912 LT, UFT Java Add-in Extensibility 23 &t S v E 3,

1 DODOHAZ L« HR—=F 7T 2REFHLT, BEOI AL L7 TR L THE—
MR T A Z N TEET, PR—b T RL, V= F Y FRET 7 AL (44 ~L—
CESH) T, BEOWAZL - TRy BT TEES, TOHRE, TOYR—
ke Z7TR%, TRy ESTENTWDIHAL L -7 TARE, TRHOTHRIZKL
THR— FERME L E T,

YR—=b 7T ADIERTIE, &ONZ, 7T ADOMAMBERELET, X, &
A LY== Fy NNO T T AT 2V R — N2 ERT 2IEFORE L, HrLny
R—b « 7T ARWET IHEFEOYR—b - 77 ADOWELEENE T, FEMICONT
%, 56 X— [HR— bk« 7T 2AOMABEOWRE] 2L T IZEW,

WIZ, WAZL - ar b=l T TETAN ATV b 7T ARBRE
LET, SOV TIE, 61— [HRF L -arybha—LDT A+ FT V=7 b -
T ITANDY BT | BHRL T EIN,

LREOBEET AN - ATV =T N - 7 TABRE LT D, UFT Java Add-in Extensibility
DALY e N= L THDIHAZ L« FR—b « 7 TRAEERTEET,

BHAAZ L« PR—=F « 7TATE, TRNENDYR—FTLHVAZ L ar bu—L
W~y BT EINDT AN ATV b7 T8, BT eRXTABLOT A -
FTV2 T N AV FOFEEFEEZRE L ET,

HAZ L s FR— |k« 752, FNFNDRA—N—2FZADR Y v REMPKLET, &
T LT, A== TRADOREZHEHLTZY, AV v Kt —R_R—F 4 KL=V, #
LWAYy FEBIMLEVTDZZENTEET, YAR—bF 7T ATHE, ROBEED A
Yy REFEHLET,

> BETONRT 4 - YR—b - AV F BT 0T 4 2P HA— T 20MENLE
T, FEHICOVWTIE, 62— [T m T s O R— ] 2BRLTLIEEN,

>»BEAVYF TR ATV=T b AV PR =T 20IEMLES, 3F
HZONWTIE, 65—V [T - FT7 V=2 b+ AV y FOYR—F] 2L T
<&,
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> ARVFNVYES - AYYR HAF L 3y ha— L TORREYR— 550
(2 L E 9, Extensibility O Z OFRSIEAT L 3 T, BEAOYR— M 2ELEL
RWNEAETYH, HAZ L3y ha—/TO UFT OREKERE (7Y =2 Mo,
FT V= NMIETBT A NDOFEIT, a7 4 LEOT = v 7 72 E) IZmEIC Y R —
rENET,

TIALZ L 7T AN SWT ZHLikT 5554, UFT OFEEEED YR — M 2{ERT 5 2
LI TEEHA, FMIZONTIE, 68—V R4 T v a o R— ) 2SR L
TLIEEW,

> A—T 4T 1« XYy K Extensibility ZHfHlT2DIEHLET, ZhHDA Yy
Kk, UFT E RS LT SV r—va LA 27 2—A&HfEHT5HDT
HAL LT T ADMEAGOHEIZYR—F L TWETAL ARG TERL D 2—T ¢
V7 g« AV FEFEHLET,

FERMRERZ—T A UT 4« AV v NIE, YR—F 7 TF7A2ADY~<Y (773—) T
RTEXET, TRHDAY v RIZHOWTIE, 68 2= AT arofr—
B, TI_=Y TRy T LU - AT P2 hOPH— b, T1_—=Y [Ty 8— - =
Yho—= DY R—=b] OFETHELIRPLET,

INBEDAY Yy RN AL L FR—b - 77 ZATEETHEICIE, MicAPI TiRftsh
AKFERAY v R TEES, ZEMITHONTIE, 78 2— MicAPI D A Y v ROfE
JHJ % X% [UFT Java Add-in Extensibility API Reference] ([Java Add-in Extensibility SDK
~L7 ] TRIAFRE) 2SR L T E &V,

HAL L 7 TRTEEND A Y v ROEEOMEIZOWTE, 77 X—Y [HFR—F -
JITAOQY =Y ] #RRLTIEEN,

HR—bk - 9SAOBERBEBORE

UFT Y R— F BT HHAZ L« Y —LF v b T, RONBEZRETHILENHY

351;_‘0

> HTDYR—F - JTARMERDAZ L < JTRE, TNENDA—IR—F T R
DYR—=K + FTTATHYR—=FTEDIHAL L« T TR,

> HLWHR— b « 7 T ANERETIEFOVFR—F « 7T A,
(Zhicky, ¥y BR—=1F - 77 2DIEFRIEF bIRED £3,)



EIE AL -Y—ILFyY DY R— FDEE

HR—F - H9SADERBIZDULNT
YR—=b « 7T AOWEEIX, HAF L 7T AOEEZ KT DLERHY £97,
WwOBL, TextField 7 7 ADH KR — FOMEfEE R L TWET, ZMOFNE, TextField D

HAR— b7 TR (TextFieldCS) D@ A FK L CWET, HAHDFNIE, AWT ) —/L%
F T TextField 7 5 2DEE 523K L TWET,

com.mercury fjadin.gtsupport.awt.cs TextFieldCS Java.awt TextField
com.mercury ftjadin.gtsu ppoTr‘[ awt.cs TextComponentCs java. awt .TexftCompon ent
com.mercury fijadin.gtsu pLort. awt cs.ComponentCS Java.awt. (Iompon ent
com . mercury fijadin rm‘ra abstr ObjectCS java. Iang.Obj ect

ZOBITE, BAZL 7 TATLICYR— R - 7 TARFELTOETR, ZHids
HTHY £,

UFT Tl, 77 V=2 FE¥ETHEIS, 77927 hDU T A B HITHAITE £7,
UFT %, 7 7 RIZHENTZ DT 7 ADOMAREZIRELET, ST, UFTIX, Y—
Xy MEEZT7ANT, TOV TRy TEINTWAYR—F « 7T AEMBEL
ET, PAR—b - ZITANREONERNES, UFTIZZEDOHR—h - 772012 LD
A= R TRy E T ENTWEYR—b - 7T AEZRBELET, TR THRD
MHRWEGEEE, EHIC1IDEDA— NN~ TRy BT IR TWVEYR—F - 7
TFAEREL, e —HTH5VR—bF - 7 TARRONDIETITVWET, $R—b -
7 7 A%, HP REDMON U Znbitiid 22 L6 TEET, EZ0OFR—F 7T X
DROMNBRNES, AWT 7Y =7 % ComponentCS 7 7 A2k > THHR—F &
N, SWT 47 =7 X WidgetCS 7 7 Al k> THR—bhENET,
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WOEE, ImageButton 7 7 2D — F OREE 2R L TWETAEMIOFIIE, ImageButton
DY HR— 1k - 77X (ImageButtonCS) DB ZEK L CTWET, HRAIDFIL, AWT ¥ —
L% v hTO ImageButton 7 7 ADEE & F L TV ET,

com.mercury ftjadin.gtsupport.custom.cs.ImageButtonCs com.demo. mageButton

}

com.demo lmageControl

}

com.mercury fjadin gtsupport. awt cs CanvasCS java.awt Canvas
com.mercury fijadin.gtsupport.ast.cs. ComponentCs java.awt. Component
com . mercury ffjadin infra abstr ObjectCs java lang. Object

ImageButton D A —/—727 7 2T 5 ImageControl |Z{X, AR — K« 7 7R iT~v v
rahTnEtA, TD7=H, ImageButton OV R— bk « 7 T AL, BT T ATHD
CanvasCS (L~ >y B 7 ElzYAR— b « 7 FAZPRLET,

T B YR—F - VS ADRE

YR—=b 7 TREMBEBETDNAZL - 7T ARRET DL, WAZL TR
DOHREL EZZET 2 0ERH Y 7,

HAZ LT TFTADA=N—7 F AR L TRESNDYR—FTHDICZOIAH L -
I TG AEYR—FTELERE (DFV, DAEL 7 TR R— NP LEREA O
TEWIRWER), HAB L« 7T AT HYR—=F « 7T ZAEMERTHILETIHY %
A,

FNLUNDEEITIE, A= R—=T FZADYR—F + 7 FRAEHETIH LD R— -
T AEERL, V—AFy NRET 7 AN @4 X—V%5H) T, BDAZ LT TR
vy B 7T 0ERBYET, FILAMERT DY AR—F - 7T ATlE, A—s—7
FADYR— b« 7T AOYFR— N TEHAVTGRY R — NOEEDO LA RET DML
HYFET,

BEDHAZ L« 7 TANRR L A—R—F T 2AEPEL, TROHIZREACYR— N ELHE
T BRI ONRTART AN T TV b AV FRHIEEE, oY R—k
KT TAOYR— bk « 7T ATHIZIREETIZ, A==V FADHFR—K 775
ATCHRBELET,



EIE AL -Y—ILFyY DY R— FDEE

HFLOWGR—F - 9SAHEET B9 S ADRE

HLWYR—b « 7T A THEETIEFEOYVR—K « 7 T REZRETHITNE, DAX L -
T ADEBEFNT, FORA—NRN—I TRy L TENTWVWEYFR—F 75X
THERLET,

Java Add-in Extensibility 7 4 ' — REFEH L THAZ A« Y —)LF% v |« FR— b EER
9 54561, New Custom Support Class 7 '— KT, 1Ek3 5K —h - 7 F7RAT L2
PRS2 7 FANRESNET, 2OV F—RTIE, BRZL 77 2AOBE@EHRER
SN, HLOWYR—=F « 7 TADN=R (R—=/"=F T R) LRDIMFEOYR—TF 7
TADBMENET, FEMIZOWTIE, 117 ~2— [[Custom Class Selection] | %%
LTS,

Java Add-in Extensibility 7 4 ¥'— F##REFICHR—F - Y SRAOBEREFRET S
IZ1E, ROFIEEZEFTLET,

1 WAZ L 7T ZAOMAMEEZRELET,

2V NFy "RETTANVTHALL « JTADA—=IR—=F T AT Ty BT
SNTWDHR—F - 7T RERIELET,

Unified Functional Testing Java Add-in & EN DY =¥y hRET 7 1 /L &,
Extensibility D A H# 2« — /L%y h « PR — MIFENDY—LFy MRET 7 A
NERBTHLENDY 4, ZhHDO7 7 A VEZNEN, <UFT 4 VR k=)L +
7 # JLA> bin\java\classes\builtin & <UFT 4 > X k—JL = 7 # JL &> bin\java\
classes\extension |[ZH Y £,

3 RHLITWVWA—NR—=I TR I~ BT EINTWDLYR—b « F T RAEHELT, A
B 7 TADYR—bk « 7T AEERLET,

R bIILWY AR — R+ 7 2 Unified Functional Testing Java Add-in I & £ T\ 55
&, TOY¥R— | 27 F AX com.mercury.ftjadin.support /X 7 —TYNIZH Y £3, T
DG, TOVR— k-7 T 2 EEEILRT 2V 12, com.mercury.ftjadin.qtsupport
Ny =V TRUEINDE CARID 7 7 A ZPEET DUENDH D 7,

W®OBFITIL, ImageButton 7 AKX L a2 bu— L EEHLT, R—F 7T ADRK
BEPRET LT rE ACOWNTHRALET,

59



EI3E.HRAL - Y—)LFy DY R— FOFRE

60

ImageButton 7 7 2ADMfEIX, RDEBY TT,

java lang. Object
I—ja\-*a.Eﬂf\rt.Component
Ljava.awt.Canvas
L com demo ImageControl
I—(:r::m.demrzu.lma(_:;eButton

ImageButton O biEV A —/3—2 5 2 Th %5 com.demo.lmageControl (&, ¥7"— | -
TRy BT ENTWERA, IROA—/—2 T X CTh 5 java.awt.Canvas |3,
com.mercury.ftjadin.support.awt.cs.CanvasCS |2~ v B> 7 S TWE T, ZHiE
Unified Functional Testing Java Add-in (25 £ E 7, € D72, ImageButtonCS |3 qtsupport
N lr— N O CanvasCS 7 7 A (com.mercury.ftjadin.qtsupport.awt.cs.CanvasCS)
Z¥iE L¥9, ImageButtonCS DEFIL, KD X Hihv £7,

package com.mercury.ftjadin.qtsupport.imagecontrols.cs;
import com.mercury.ftjadin.qtsupport.awt.cs.CanvasCS;

public class ImageButtonCS extends CanvasCS {};

FF3»roYy—nAFy b R—b-y FOVFR—F - 7 T RAEPET DL HR—b -
7T RAERF LIEA, 200 — %y b YR — K-ty NORICKTFREENE L E
T, HEERLTCWAHFDOY— L%y ke FR—F -y & UFTOT KAV « v F—T %
e — RTA5481F, HEINRLGFOY—LFy kR —K -y hbr— RT3k
IR T AMERH Y F7,




EIE AL -Y—ILFyY DY R— FDEE

AREL A FA—=ILDTRAM - FTSzH - H9FRAD
IvEVY

UFT W HAZ L ar ba— LV THEHTIRE T a T 4 ET AN AT V=2 b+ A

Vo RiE, BAFA-ay b o=y BT ENDT AN FT V=T b VTR

WCESTREVET, ZNH6DOTrRXT LAYy FOEEEEL, BAZL 3|

2= OFR—h « JTATREINDIYFR—F - AV v FICk-oTHRED 77,

HAZ L ay ba— U, DAX L3y ha—VIBET L TRTORB T 237 4
ETAN ATV b AV REFEOBFEOT AL « A7V b« VTR
LU TEES, Fl, FILWT AN ATV N VT RADOERE (TAL TS
Vel MRET 7 ANVT) fER LT, WAX L a3 br—LEHFLWT AN 4TV
IR TRy ST THIELTEET,

FHLWT AR AT V=27 b 7 TR0F, BBFEOT AR 3T V=2V b 7T RA%—
AN, BT ORT 4T AN ATV b Ay FO®y bEIEELET, T
TOTAN ATy k-7 T RE, JavaObject 7 7 A%k LE 3, BEFOT A | -
FTV =T N TADERIL, ERRBTOXT AT AN ATV e Ay
RO—EIEINEENDIHENT, BEOT AN 727 b 7T AZWETIHL
WT AL ATV b 7T AEBERLET WEOT A ATV b I T A
IR T e NRT 4 ET AR AT V2T b AV y REBNTHHER, 07720
TRTOT AN AT V7 MIEETLD, BEDTEERA),

BMET 3T ARN ATV h 7 F3AOL4HEET LI, Y R—F-2F AT
to _class_attr £ Y v FEZERELT, TAN AT V2T bV TRATHAK L« v b
n—)LExw o7 LET, KIS/ to class attr XV v NIk - TREND T A
he ATV b P TANH AL L s a2y br—LIZE L TWAEANE, HrLnYR—
N+ 277 ATto_class_attr 2V v R&A4—"—F 4 RTHMLEITIH D ¥ A

to_class_attr X ' v KNi¥, Class Name i8i#% 7" = /"7 ¢ IZfEZ 28 L £ 3, UFT T,
ATVl NEFETHEE, ZOFAT V2 PTHEATAYR—F - 7T 2EBREL
F9 57T R—Y [HR— K+ 27 F2OEBIZHOWT ] 25MB), %IZ UFT IE, Class Name
B 7o T 4 2EALT, ZOa L ba— vy BT ENTVWAT A AT V=
IRV TRAERELET, UFT IFHWNWT, ZOT AL AT Vxs k- 7T AL %
ALTTARN - FT7Vx7 FOERERDITEST, AL - A7V 27 bOERIE, UFT
DEFDOT AN A7z b, FREFHLMERT DT AL - AT V=7 VRET 7
ANNPERETEET,

FENZOWTIE, 45—V [T A K« AT V=27 FRETZ 7 A MOV T] BB LT
<TZEW,

61


JavaExtAPIRef.chm::/com/mercury/ftjadin/infra/abstr/ObjectCS.html#to_class_attr(java.lang.Object)

EI3E.HRAL - Y—)LFy DY R— FOFRE

62

FHITONRToDHR—F

HAB L e a2y ba—)LORFHETaXT 41, TA ATV F b 7 TATESE
NET, UL, UFTOBEDT AL A7V b 752 ThHDD, £7-IET A -
ATVl NRET 7ANTERT DT AN ATV b IV TATT,

T BNT 4 DY R— &Y R— |k - 77 2ATRUET DL, BT T 0 T LI
WROBHEMALTAY v FEFELET,

public String <3254 7' A/ 3T 1 %>_attr(Object obj)

AV RZIIINLFORMEATEEST (FAN AT V27 FREZ 7 ANLDT R
T A BRI TFPMEH SN TV DHEEBRETYT), obj 51%kix, BAXL -3 br—
NERTATV s FTT,

Ay RNTIE, BAZ L7 T ADpublic A NEHEHRLTHLERT 3T ¢ OfE%
ELET (BAR—bF -7 TR, publick EFRIINLTNWDIHAZ L « 7T AD AL NID
BT 7 EATEET),

7= & 21E, o width_attr 2V ~ R width 5857 2 X7 OV R— b2 EELET,

public String width_attr(Object obj) {
return Integer.toString(((Component) obj).getBounds().width);
}

PFR—h « 7 TABBREOL-ar Fr— LDV R— | « 75 REIETIHE, HA
Hhearhba—UIZEERLTCHEHINDBE T2/ \T OV R— N2 LT 08
THD FHA, 2ExiE, Z<Dar ha—iZidlabel 73T 4 03 H Y £97, label
TaRT 4 DFEEFHDOFR—FTHPCHAZ L - a3y bu— L& R—hTE 58
G, BlOAY y Red—n_"—F4 RTIHLEH THA,

TANFT V27 b VTRADERBIZEENRVEHR T 0T 4 OFR—F - AV
RaffK (L723EK) T2560860 4, Tho0@B#7 /7 1%, UFT © [
T2 N ANRAL]) BATRT Ry I AR [Ty IR A NOTRRT 4] FAT
0y e Ry 7 AZFERINEEA, TUHORFET 0w T 42T 7B XT DI,
GetROProperty # ¥ v FZ i/l L £9°, GetROProperty % ¥ v FOFEMIZ OV TIT,
[HP Unified Functional Testing Object Model Reference] % &ML T 72& 0y,
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BOVR—F - 7 FATHR=FEINRVWHIRAZ L - o ba—LOR#ET a7 1 &

— hFBEAE, AT PR =R 7 TRACH LAY v REBEMLET, hR—
FENTWD LD LEAHTINFE L TREDRRLBHT 0T 4 2 H— 254613
BORXY y REF—N"—=F 4 FLET,

FRFADRETORT 4

UFT CiX, W TEEOR#E e T 4 2FH L TWET, NS0T e 37 11X
WO L INZEEESNTWDILERH D £7°,

» UFTIZTRTCOT A AT V=7 -7 5 A% LT, index (£ 721 class_index),
class (F7-1% class_name), to_class, toolkit_class Ok~ v /7 ¢ Z %K — |
LTRY, ZhooFueXT 4 2FHLTAT7 Y =7 MCEAOERE RS L ET,
V—LFy h e PR—F By T, INOOREE T T DFEEE F—R—TF
A RLRNWTLIZE0,

» JavaTree 7 A N « A7 V=7 b & Javalist 7 A ~ « A7 V=7 MNTE, EhEh
tree_content 35 X (N list_content &\ ) A FTOFER 7 o X7 4 BFEELET, Zhd
WX, F=v 7 RA 2 FTHEALET, UFT TiE, count @ik 1 37 ¢ L Getltem 7
AN ATV R A Yy RiIZESWTCINBDOT a7 ¢ ZFHE LET, UFT I3,
count ik 7 a T 4 #EAEL, YU —F72F U A FOEA Z L2 (05 count-1 &
T), Gettem T Ak « A7V 7 bk AV RENOHLET,

count_attr ¥ /=11 Getltem_replayMethod » 324 % 4 — " —F 1 R+ 58541%, UFT
THIREIND XA TORBREETVENDH Y £, 72& 21F, count_attr [Tl %K
L, Getltem_replayMethod % 0 7>5 count-1 DA > T v 7 ADIHE % KT LR
% D ij—o

HAL N ar ha—L% JavaTree £7-1d JavaList 7 A b« A7 V=7 b 7 TR~
L, BAS LY R— K2 T A7 count_attr AV v K& Getltem_replayMethod
AV Raeff& LaWEEaiE, UFT TR SN ERERT IO Inb 2 RIET S
WENRH Y 7,

63



EI3E.HRAL - Y—)LFy DY R— FOFRE

64

—RERETONRT s - R—F - AYYF

PR— b « 7T 2AOMERIFIZIE, WOBERZRFBHE T T 4 « PR —F - AV v IR
— IR SN ET, BUE (Fa—r U T Java W RAZ LY —)LFy b« BR—
M OVERITIEDFE | TlE, ZhBDA Y v ROMRAICOWTHE T Z N TEET,

> to class attr x Vv R (61 X—Y [ RAF L -aryba—DT A - F TPz
ke 7T A~D S| #5M) 1%, Class Name iRk 7 0 /87 1 &V R—h L
9, ZOAY Y R, B#ETET7AL - 4TV 27 b JTAOLRIERET Z LT
FoT, WAXL - ha—LDT AL FT VI b JTANDT L T %
FEHLFET, UFTIX, ZO7uaXT o 2HLT, IAZ L2 he—Llvy
VIENTWAET AN < AT V=27 b+ VT RAEBRELET,

> TAL ATV hOLENL, A7V hDtag F kT 4 TRED £, AWT
PR — k27 T AXF T ObjectCS Z L5k L F 3, ObjectCS 1%, 2 L TV % tag_attr
Ay REERALTCHEESNFIEFTC—HOT e T 1 2F =y 7 L, RohoT-8k
VOBENMEEERLET, AIMEITZECTRVMET, AX—22EAHFTHA,

ObjectCS 7 7 A D tag_attr X V' v R TIE, GRHEHSNEZIEFT) KOT 3T B
9’_1\‘/7 éhij—o

» label
> attached_text GGEMHIX, TizZR)
> FEMiH AL L - 7 TA (R —UBEEERNT T ADLH)

HARN e 2y ha—LDTF AL F 77 NOLTTELEES B2, BR— -
7 7 ATtag_attr 2 Y v K& —1_—F 4 FE7, BFEOFEELZMFH LT, label_attr
Ay REA—R"—F 14 FLET,

>itqO@mﬁ”immthﬂtmu%//F%% LET (AWT BR—+ - 7 5
1L XT ObjectCS LR LET), DAY v RiE, BAZX L 2 br—/LIlk
%f%%%?%xb-ﬁi?:&b%@%bf,%@%%xk%ﬂbifo:@%ﬁ
S AL, MEOBMHATI A NEHLZRWVWT UG EOZT v bRy 7 AU 2
he Ry 7 ADE S ary ha—LOGEAEICEIILHLET,

AR LT FA L« 2 ha— OV R— hEERT 5L, UFT TZO label 7
28T HBEET D2 hr—)L O attached text & L CHET 5 Z LN TEETLAE
FZDWTIE, 148 ~X— New UFT Custom Static-Text Support Class &7 « ' — K] %
ZRLTLIEEN,
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EIE AL -Y—ILFyY DY R— FDEE

> class_attr 2 Y v RiZ, AL - A7V FOPHEZ A 7045 (object, button,
edit, menu, static_text 72 &) KL E7T, ZHE, A7V MIvy BT EN
TREEDT AN ATV b e VTATRL, TAN AT V2T bV TAD—
RS A 7T, BT F AR 3 br— DY R— |k - 7 T 2AEERTHBE
1%, 54 static_text Zik9 X 9 1C class_attr # Y v RZ2FEIEFTHLERH Y £,
TNLS DB AT A— =T 4 RLARWVTL &N,

> value_attr # Y v NIISEATH Y AN, 2 bo—LOBEDRIELZFTDICL
<HEMEIND, value BFE T v/ T ¢ 2FAE L E¥, 72L& 21T, value_attr 2V v N
T, #7 - ary br— L TEERBRINTWD X T 04, ¥V —THERRIN
TWHHHAD/NRA, A=a—CHERRINTVWHHEAREZRT I ENTEET,
LT AL AT V=2 b 7T RA2ERLTOT, BEORESEET 5513,
value 7w T 4 OYR— 2 FELES, AT LYR—F -7 T 2R
value_attr X V' v REMAT 2551, TOERERYR—FEnNdar be—/LiliE
LTWAZEEEERLET,

FRAMFTSzH b AUy FOYR—

HALZL sy ha—=ADT AN F T2 b AV R, AN FT7V=7 k-
I IATERINET, 2L, UFTODMFEOT AR - F 7PV F - 75 ATHDHD,
FRIFIT AN ATVl FRET TANVTERT DT AR ATVl b7 T ATT,

TAKN ATV b AV ROYFR— &2V R—bF 7 7 ZATRETDICE, T2
heF T2 b AV RTELICROEBAZHEH L Creplay 2V v REEELET,

public Retval <7 X k - #7724 k - AYw F&>_replayMethod(Object obj, <... list of String
arguments>)

obj 5%, WAZ L arbr—NERTAT Vs FTT,

replay A Y v RIZXFHN OS5I HOHZIF AND 280, UFT 1T XTOH5 % SCFFIER
Treplay X Y v RIZELE T, 7 —/UEEITEMEOBI A ERT 55613,
MicAPl.string2int 2 H L £,
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replay A Y > RNTIE, BAK LT T AD public AV v REHEHT 5, MicAPI A >
REFBHALTURL SV AR NET A AN FFTLHZ LY, DAZ Lz br—
N BT B EEEIT LET (VAR — b - 7T AL, public L EESNTNEIAH
AT TARAXYy NIZORT 7EATEET) , FMIZ OV T, TUFT Java Add-in
Extensibility API Reference] ([Java Add-in Extensibility SDK ~/L 7] CHIHA[AE)Z S L
TLEEW,

7o & 21E, W X 512, (ImageButtonCS 27 7 A @) Click_replayMethod I3, ImageButton
HAH L a2 ba—)LETClick 7 AN ATVl b AV REVR—-FLET,

public Retval Click_replayMethod(Object obj) {
ImageButton button = (ImageButton) obj;
MicAPI.mouseClick((Object) button, button.getWidth() / 2,
button.getHeight() / 2);
Return Retval.OK;

}

replay A Y v FiZ9~T MicAPLRetval {62 &3 %E 3%V £, Retval fHIZI%, &%
YE =V a—RREENTEY, XFHORVEEZED DL TEET, UFT I,
VRE =2 e a—=RTTAL AT TVx7 b XYy RORIEITRBICET 2 EHRE
HRELET, ROMEAZES L TUFTGUL T A FOBFGED AT v S THATHZ LN TX
£,

7= & 2%, (SearchBox W A X A+ v b —/ L& H R — 3 5) SearchBoxCS 7 7 A D
Getltem_replayMethod 1%, UV #—Y + 2— FOKIZMA T, fEEINZHE O4HIZ K
LET,

public Retval Getltem_replayMethod(Object obj, String Index) {

SearchBox sb = (SearchBox) obj;

int indexint;

String item;

indexint = MicAPI.string2int(Index);

if (indexint == MicAPI.BAD_STRING) {
return Retval.ILLEGAL_PARAMETER,;

}

if (indexint < 0 || indexint > sb.getltemCount() - 1) {
return Retval. OUT_OF_RANGE;}

item = sb.getltem(indexint);

return new Retval(RError.E_OK, item);
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UFT C#E#% 3125 MicAPLRetval DO FEMIZ SV CTlid, [UFT Java Add-in Extensibility
API Reference] ([Java Add-in Extensibility SDK ~/L ] TRIHAIEE) # &ML T2 &0,

YR—h « 7T APEREDOE -2 ba— OV R—b « 7T RAEBIRT DG, A
Hhearybp—LWWIEBRLTHEHHASNDIT AN ATV T ke AV y ROV FR—
MERETIVNEIHY $HA, 2, Z<Dar be—Zid Click 7 A b - A
TV b AV RBREENTOVET, Click 7A L« A7 V=7 b« XYy K3k
BHDYVR—FTHHICHAT L a2 va— L E P R—FNTEDH5E, BOAY Y R
EA—n_"—J4 NTH0LEHY EHA,

BOVR—F « JITATHR—FEINBRWHIRF L ar br—LDOT AL 4T V=
J b AV REYR—-FTHITE, EATAEIHR—F - 7T RZH LAY v FEB
MLET, YR—=FENTWDL LD ELARNFEC TREDRERLT AN ATV =7 b
AV REVR—bMT2EE81L, BOAY Yy Kead—1R_"—F 4 KLET,

CheckProperty, FireEvent, GetRoProperty, GetTOProperty, SetTOProperty,
WaitProperty 72 X' @, UFT ORI A Y v ROFEE T A ——F 4 FLARNWTL
W,

F:JavaTree 7 A b« A7 V=2 b & Javalist 7 A b« A7 V=7 FaEVR— T 354
%, count_attr X / ~» K & Getltem_replayMethod # > v K UFT TSN D4 A4 7
DOEBREZET L HICTHHERD Y T, FEMICONTIE, 63 X— T FHIE DR
TanRT 4] BBRLTIES,
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RiEA T arvogR—Fk
ek T a @ UFT AR — M, AWT ZHE5ET 5 2> b e —iixt L CORIERT 5
ZENTEET,

AP R—FE2FELRLSTY, WAX L 22 b —L %425 UFT O Ofhd
TRTCOBIE 7 V=7 FOFE, 7707 MCEAT LT A MOET, T35 4
EHEOF = 77 E) FRECTFR—FENET,

HAL L - ary b —) LTtz AR — 35121, IPAFZL-PR—F 7 TATK
EIATTLNLENDY 7,

FERE N TTEAN_U DY ZAF 2 RETHIMENRH Y 7,

PERRFFICH AL I e 2 b — Uil Y AT BT HHERDH Y £7,

B2 N R AFEA LTZ & X UFT ISRk A XV h 2R T2 0ERH Y £,

F VMR BRELRET 2561, BL-REREe T — =4 FTO4ERHY F
¥, 2L 2, JavaEdit.Set #{E&4 iR 2 5T, O —R— FALORLEE
F—=R=F A RTHUEROVET, A=a—0F 7 a VERERLRHET IHEIT,
SIUA Iy DREREA—NN—=TF A FTDOLENDHY £,

Y VY VY Y

HEHE [Fa—RU T Java WAZ L Y —/LFy b« bR — FNOERFTIEDFE
TIE, HAFL - ay bo—)L EOFEOYR— hOERAZ#E T2 N TE £,

ARBL - YR—b - VSRZEBEOYR— FZBMTBICE, ROFIEERTLET,
1 4R —b 7 TADOFLHIZY AT ZEMLET, ROFITIL, ImageButton DY KR — | -
7 J A T&H % ImageButtonCS N7 7 v a « ARV EY v AL LET,

public class ImageButtonCS extends CanvasCS implements ActionListener {}

2 YR—F 7 TADALRA T I ZEEHLT, WAL L 3y ba—/VICBET 5
TRTCDY AT L, 26D ) AFTOBEMERIRIHERTLAY Yy Fegie) XA M

ZDEDIZE, KV AFICH L T=—7T 1 VT 1 « AV v K addSimpleListener % '
CHLET, 20X Yy RiL, SXFHRO 3 5088 (V2T O4HT, BEgEAY v R
D& EI, UAFTOHIRIZEEHRT 2 A Y v RO&HI) %300 £9,
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EIE AL -Y—ILFyY DY R— FDEE

WOFITIX, 77 > ar U AF % ImageButton 7 A X L2 b — L8 LET,

public ImageButtonCS() {
addSimpleListener("ActionListener", "addActionListener", "removeActionListener");

}

UFT XA AZ A« a2 bha— L EPDTRHLIZEXIZ, ZOWARZL - ar br—
NOYR—=h I TADA L AZ AR LET, ZOVHR—F - 7 TADAL R
RUAE, TOHAZL 7T ADLUEOTXTHOay ha—Li2YR— 5D
EHENET, WAX L - T TADA L AF AMEREIND &, VR —F 7T
ITHELEBREA Y v FEH LT TV MOKER ) 27288 LET,

R~ figked—_"—J 4 RLET (A7 a ),
T~ JL » v TR« AR NOEFREF—N—F 4 FT 2L

protected Object mouseRecordTarget(MouseEvent e) {
return null;

}
L~ - =R K« £ Ry FORRE A — =T FT 258

protected Object keyboardRecordTarget(KeyEvent e) {
return null;

}

MicAPlLrecord # Y v R&EH L T, ftdkA v —U% UFTISEET 572002, U A
F oA BT 2= ANLEETAHA R N RT Ay FEEELET,

MicAPl.record O ] 75125 T, [UFT Java Add-in Extensibility API Reference]
([Java Add-in Extensibility SDK ~/L 7" TR FRE)Z B L T 72 &0y,
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7= & Z21%, ImageButtonCS (ImageButton D% — k « 7 F R) NTIE, IRDA X2 b -
NURT e AV RRFEEINET,

public void actionPerformed(ActionEvent e) {

try {
if (lisinRecord())
return;
MicAPI.record(e.getSource(), "Click");
} catch(Throwable tr)
{ tr.printStackTrace();

}

ImageButton T7 2 2 a v« A X2 F233A$ % &, UFT |% ImageButton = Click #
EZfiék LET,

try ...catch 7 2 > 7%, UFT 7 A RVRRED & X1Z Java 77V & —3 a V& AT
LCZoa—RNIREELEERIC, REORWEVERETINRVEIICLET, R
X7« N L—Z73 Java Add-in Extensibility DIE/0ay « X b= EE LTS -
TrANMIHIIEND T2, ZOAY v KPR THERHENEZGEICZDOX A IV
T HERWERTAHZENTEET, FMTHONTIE, 88— [HRZL - YPR—F 7
FADu T ET Ry T BEBRL TSN,

T ys8— s AL FE= L TORRKCONTIE, 71R_—Y [Fy8— ar km—10
FH— ) FBRLTE S,

EUFT O7 77 ¢ 77piddikt v o 3 B ETE L 72 VW REE © MicAPLrecord % FUMH
LTH, bz v A, MicAPLrecord % FFOME BT FH R LA ZIBINTIT 9
AL, A islnRecord ZMENH L TRtk v > a VBT 77 4 T E D D E ik
BRI HMERHY 4, Ly a BT 7T 4 7 TROLEAE, BEORELRE
BT B LI LTLIEE N,
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EIE AL -Y—ILFyY DY R— FDEE

fy LRI -FTOH bOYER—+

UFT THAZ L - ary ha—A%ET AN A7V NERBOK EALO Java A7 V=
e LTRET AMERHLHAIE, D Javaar hu—ARN by FLUL« A7V x
J N ThDHZEHEUFT IR TOMERS Y T, 20D, YHR—F-7T7RT
2—7 4 U7 4 + AV K isWindow(Object obj) % 4 —/3—F 14 KL T true %K &
L ET, ROBIT, JavaApplet AllLights 1Z kv 7' L~L D Java A7 V=7 hTT,

El- [¥ Browser: FT_QA Partal
E|D Page : FT_L& Partal
&[0 Frame : MAIN
G

oy 7L e ATVl MITHIENTEDHDNE, a7 T - 47V POKRT
T, arTF - A7 V=2 M, java.awt.container (AWT X—ZDEA) £72i%
org.eclipse.swt.widgets.Composite (SWT X—ADIFH) ZHIETH4 7T V=7 b TT,

HDHRWTOHRay ba—LB by FLYb - A7V =7 MIRDIFARIE, TR T
true ZiX L, ZHLAOWRILTIT false 2K & 9 12 isWindow #* Y v K& 3445 =
ERTEFET, 2e2E, Ty MIAX U KTy « T r—2 a1l d52 ¢
bH, Web 7 7 UVNOAT V=7 MIT2Z L TEET,

ZvIR— -2 FA—LOYR—F

FysR—avbu—lE, FysA—-avir—ANOay br— Lk L—7kL
T, 1o0ay hr—LL LTET Ry TS 3y br—ATY, 2L 2, AwCale #
BRgo L ho—E, Fus8— e 3y hr—A T,

& Applet Viewer: org.boutique.... [l[=] [E3

| | ANT Calculatoxr

Applet started.

7



EI3E.HRAL - Y—)LFy DY R— FOFRE

72

UFT X, Fy/8— - ary bo—nVa2FET 5K, Fy—-aryhe—1rADar b
a—/LETFRE L TREINCEE LEYA, Ty /3— a2 hr— L TT A MEFHT D
Ba, ZyuRX—carie—NOay ha— )L TEETDHA NV MET v/~ o
ra— EOEEL LTSN ET,

S¥: UFT TlX, AWT X—RADay ha—)LOIh%2 T y/X—ar ra—)Le LTHR—
FCEET, SWIR—ZADHAZ L« a2y ha—LOPEIE, HTFEOTRTOFHRE
EBICFEMTONET,

728 Z20E, AwtCale #HEME DY b e —LiiE, BT EEHRE OV U VRRLZ URE TR
TWET, Zoary ba—L0iekt v g Tk, B2 Click #1E2 %o H % &
RHRMELE UTRIRT 2 2 L BRREIC R D560 B Y £, Java Add-in Extensibility % {5
45L&, UFT T¥FERZ D27 U v 7 % Calculator.SetValue 25~ 7 & L Ttk L,
WETRH D27 Y w27 % Calculator.SetOperator 25~ 7" & L Citékd % L 9 ICHE
THZERTEET,

UFT TO S v/A— - a2 FA—LOF/RLAIZDLT

FyNX—carbha—)LTE, Ty TELHEa e —LIZT yR— o fr—)L
ZDOHLDET o= LTRETDINENDHY T,

UFT TiE, 2 ha—L &7 e LTEETLHIIC, 20X A 7Dy br—/L I8k
INTNDET v —RHEETEINEIDEHRBLET, BEINTNWDE T v =R {FE
T5%E, UFTIZZ0ary e —ARNEENDL T v/ —2MmBE LET, UFTIE, ZOM
REATO DI, BEESNTNDE T v /3—>0 checkWrappedObject 2 ' v K& FEUNH
LET, ZYUT5T v —RNRONoT2E, UFT IETHROay br— L 2FH LEE
ho HETDT v =B AONL VS, UFTIZFHOay ha—L a8 LET,

EEDa ha—LE 7Y v LTC) ay ha—Lai@ANCEE T 554, UFTIZT v
N—DWEREITWVER A,

[FfkIZ, UFT TiX, 22 b —v LOBREZ ST DAIIC, 20X AT Dar ha—/
WICBFEENTVWE T v X—RFETENEINEERLET, BHERINTNDT v —
NIFET DA, UFTIZC Dy ha—ANEEND T v —2 MR LET, %4 T5
T R=RNRONS A, UFT T A MCAT v 72 BINTHHICT v /38—« a2 b
B VIR A v —VERBELET, ST D7 v =R RO0nLRWIGATE, BER
FOFEFTEFEINET,
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T oR=RNREEA =Y (TR EEINDITNOOL TV 2T FTEITENT
BEICI->THRITENTA v E—) TR X2, ROWTRNEEITT
xE9,

> A vE—UEWHELT, BEORENTONRWE I LET,

> Avt—UEHEEFLTC, BALEELTEELET,

> Avb—UEETOEFICLT, MAR LICEREZRHELET,

WOETIL, AwtCale 7 v 83— o ha—LOFZFEHA LT, ZOA =X LDFEE);
HEEHHLET, AwtCale 22> b —/LDOHPR— M2 FEE L% TIE, =2 b —1 T2
FEINTZT A MIKROL DI ET,

Operation | Yalue [locumentation

‘Reset the caloulator value

ai AwtCaloulator
- g AwutCalculator

2 walue into “duwtCalculator object

@ AuatCalculator +" operation to calculate
- g At alculator b2 walue into “dwtCalculator object
4 ETentField ick the "E TextField” object with the "LEFT" mouze button.

: ck the "AWT Calculator(st]" text label with the "LEFT" mouse button.
ECaIcuIate the incoriing data

[T &wT Calculatorst

----- i AtCaloulator Enter

Swik— 2y rA—LOYR— FOERE

T yN— - ary br—LEYR— 5551, MicAPI T
com.mercury.ftjadin.infra.abstr.RecordWrapper - % 7 = — XA % E3E5 5 LE N b
DET, ZOAUFTo—RATIE, ROAY v KREENTHET,

» public void registerWrapperinspector()
» public Object checkWrappedObject(Object obj)

» public RecordMessage wrapperRecordMessage(RecordMessage message,
Object wrapper)

» public boolean blockWrappedObjectRecord()

WOLIETIE, ZNHDAY v RIZOWTHHELLSFHALET,
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public void registerWrapperlnspector()

registerWrapperinspector 2 Vv Ri%, BET XA 7 Dar ha—il7 vX—& L
TRET DELEITHENLET,

WOBTIL, AwtCalecCS iR — b « 7 7 ANRNZNHE % Button D7 v/ 8— L L THEL
351;_‘0

public void registerWrapperlnspector() {
MicAPI.registerWrapperlnspector(Button.class, this);

}

AwtCalcCS /% Button = 2 — /L TOLT v/ 3—L L TERESINE T, FDO7-D, AWT
Calculator 7~V F 4w b« Ry 7 A L TOEEIZT v —DNTER LICE RSN
F7, £, AwtCale 2 b r— /L DEEFEL, TV ETT 4y bRy I ARa
fa—LDOFHELTEEINET,

public Object checkWrappedObject(Object obj)

UFT /%, checkWrappedObject X V> REZIM-OH LT, HEDOF 7TV =V MR A H
Loy b= UZEENLINEIDEMRLET, VAR — b 7T XTIE, obj H3 A
Ao ar =TTy TENTNDILEEICRHEDT /83— f VAF R ERT X
2, TOAYy REFELET, TNUANOHEIE, null BEITET,

7= & 1%, AwtCalcCS @ checkWrappedObject # ~ v Ri%, D X HIZEEINE T,

public Object checkWrappedObject(Object obj) {

Component comp = (Component)obj;

if (comp.getParent().getClass().getName().equals("org.boutique.toolkit. AwtCalc"))
return comp.getParent();

return null;

}
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public RecordMessage wrapperRecordMessage(RecordMessage
message, Object wrapper)

BTy v a VIRILT v T ENTEA TV 2 MRS A vV ERETH E, UFT X
wrapperRecordMessage # ¥ v REZM-ORH L ET, UFT X7 X MIAT v 7 & BMN3
DHENS, ZOFEEA v E—VE T v — e ar br— W ZELET,

DAYy RIE, ROWNTRNEIRLET,
>»null (ZOAYE—UHEELTC, AT v 7 E2TE LRV & E2RT)
> TDOA v E—TVORDOVICEFTIELEINZREHRA v —

> JSLOFLERA v E—

7= & 21X, AwtCalcCS @ wrapperRecordMessage * > v K Ti%, K& v L Ciifki 4
DEAERITONTZIHEIL, ZOA Yy RTHENSZOMHE Y 228 {E (Reset, Enter,
SetOperator, F72I% SetValue GEUTH /1T A—F%ETe) ) CESHWIET, 7L -
T4V RRTHF AL+ 74— FTREA v B — Y OHEIER T ON Y6, AwtCale 13
FLERICTH L EE A,

public RecordMessage wrapperRecordMessage(RecordMessage message,
Object wrapper) {
Object subject = message.getSubject();
if (subject instanceof Button) {
/I Get the label of the button
String value = ((Button) subject).getLabel().trim();
String operation;
Il Select what method will be recorded and with what parameters
if (value.equals("=")) {
return RecordMessage.getRecordMessagelnstance(wrapper,"Enter");
}
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if (value.equals("C")) {
return RecordMessage.getRecordMessagelnstance(wrapper,"Reset");
} else {
if (value.equals("+") || value.equals("-") || value.equals("x")
|| value.equals("/") || value.equals("")
|| value.equals("sqrt"))
operation = "SetOperator";
else
operation = "SetValue";

}
String params[] = new String[1];
params[0] = value;
RecordMessage res =
RecordMessage.getRecordMessagelnstance(wrapper, operation,
params, AgentRecordMode.NORMAL_RECORD);
return res;

/I AwtCalc does not interfere if the message is not from a button
return message;

}

boolean blockWrappedObjectRecord()

blockWrappedObjectRecord # v K78 false K3 H4, 7 v/ \—IZ&ENnb=a b

a—/uE, ML L7ay br— AV O5A LR, 4 X2 MORE L TREdkA viE—Y
ZAERLET, £0O%, UFT I wrapperRecordMessage # 'O LT, 7 v 7 &h7-
ay b —AnbRITRLFEA v E—VET vy X IZELET, T0%, Ty /3—T
L, Ave—VEWIET L), Ave—VEERT LD, EFBEEZZOE ERET
HEHMT A ENTEET,

blockWrappedObjectRecord % ' v K73 true ZiK T4, 7 v/ 3—Il&FEN DT T
DAY bR—=LTTRXTOARY MREHINET, Ty TInifcar br— Lok
A w—T% UFT IZX(E 95 Z &3/ <, wrapperRecordMessage M IFONM S5 2
ELbhERA,

blockWrappedObjectRecord 7 null #ET4H45 T, 7 v/ X—IZHFENDL ATV =7 T
%ﬁé‘é‘)“7 AR N TORERLDLGAY, Ty \—BENT v TEINAT V=

MZEFTLWA XU b - URTFTERBETOIMLERDY 7, 20O%, Lkt aHf
&: (MicAPLrecord Z{£f L C) #YI/RT AN « AT v 7TEERTHLIITA NV b &
B D BN Y £,
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SDK ~/V7] THIHFIRR)Z 2R L T &0,

I TATHERT LAYy RORBEEE L DD TT,
FEAMIZ 2V CIE, [UFT Java Add-in Extensibility API Reference] ([Java Add-in Extensibility

AYy FOESE

L0 3°8 —BREAYY F

Ei A PLC
*Yy R

public String <523 7 A/ T 1 &> to_class_attr

_attr(Object obj) tag_attr

label_attr
attached_text_attr
class_attr

value_attr

FRAMFITTx
Ok AYYE

public Retval <7 X b = ATV xH k- £
Vv F£>_replayMethod(Object obj,
<... list of String arguments>)

ARVE-NVF | EETDHIVRAFICE-TRRY ET, ARV NNV RT e Ay

FAYYEF K 7> % MicAPl.record % IR
HLUET,

FRTH 1—FT« protected void addSimpleListener(String listenerName, String

VT4 *VYyE

addMethodName, String removeMethodName)

public static final boolean isInRecord()

F—nR"—354 FF
51—T411
TaAIYF

public boolean isWindow(Object obj)

protected Object mouseRecordTarget(MouseEvent e)
protected Object keyboardRecordTarget(KeyEvent e)
public boolean blockWrappedObjectRecord()

public void registerWrapperinspector()

public Object checkWrappedObject(Object obj)

public RecordMessage wrapperRecordMessage(RecordMessage
message, Object wrapper)
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Add-in Extensibility API Reference] ([Java Add-in Extensibility SDK ~/L "]l G| wfE) %
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& New UFT Java Add-in Extensibility Project

UFT Java Add-in Extensibility Project

Enter a project name.
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106

ROFNAZFTLET,

1 [Project name] R v 7 A2, 7Yu¥=7 bO&4RTIEZAL LET,

2 [Project Layout] € C, [Create separate folders for sources and class files] %
EIRLET CARTON— 3 @ Eclipse TlE, ZDOA 7 3 > DEKGLIL [Create
separate source and output folders] & 72> TW\E7),

3 [Next] #7 U v 27 LT [Custom Toolkit Details] [ (107— _X—) (TR FE T,

Z ® Eclipse DV % — FEmE TR TE 547> 3 220 T, [Eclipse ~V7] %
ZRL T EEN,
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[Custom Toolkit Details] EH

[Custom Toolkit Details] i TlX, XIS TDIHAX L <Y —LFy k- HPR—hr-Ev b
EUA4YP—FTHERTESLLIG WRAFL Y —AXy hOFMERTELET,
[Finish] #27YV v 734 %¢&, [Project Summary] [ (113-2— _—2) MNEX £,

& Mew UFT Java Add-in Extensibility Project

Custom Toolkit Details

Enter the details For the cuskom toollkdt yvou wank to support,
The suppart toolkit and its name are created based on these details,
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IOy 4 H— REE T, ROFMEREFELET.
> Unique custom toolkit name : V7R — F DIEH RO A X b« Y — L%y b —F

\CRT 4R, UFTOT RA Vo R— SN TWEIRES —ERRTLTXTOFA
TRy Ry I ATZOARPBERINET, —BEOY—/LFxy MERETDHZ &
T, 1 OO UFT TEHDOH AR L« V—LFy k- BR— K - &y N 2R R—
N5 Z EMNAREICR D £97,

AN T T v F—R2aT7 ORhEFEH L, BAIOTFIILT R FITT H0E

BHYET,

T A= RTIE, LY —LF v b PR —b vy FEERTIERIC, 040

PHERHLET, RICFEZRLET,

» V—LF% v b YR— bk 7T RZIL, <custom toolkit name>Support & V> D 4 Hif
DT HNET,

> V¥ v MERET 7 A /MZIE, <custom toolkit name>.xml &\ 9 ZRTAMTT &
NET (UFT D7 RA v« 93—V X REDOMD I A T/ - Ry 7 RATRRS
NBHAL L« T —=vFy NGIE, ZOT7ANENPEERTOHET),

» VAP —KRTTAR ATVl NRET 7 A VIMER SN D5E,
Typelnformation %5 ® PackageName B2 A X 2 - — L% v MR AT
ENFET, ZHICEY, UFT THLWT AL « A7 P27 b - 7 T AEHEY D
AL =Xy NIBEMIT S ENTEET,

TAR—= BT TICUFTIZT 78 A SNNTWDEHAK LY —)LF¥y NOLARTZEET
HZEETEERAL, VaP—REFERLTHLWY S 2 =7 FNEERL, 207
Vxl bEFEHLTHEOD AL L <V —LF v b« $R— 2B DB,
RANEAF DY A — 2 FETHIRT 24BN H Y £9, THEiT9120E, <UFT A
VR b—JL = 7+ LA > bin\java\classes\extension Z & L, YV —/L% v NRET 7
AV ZHIER L TH, 5, Reload Support Configuration =~ > K (155 X—T % &)
ERERALET,

Support toolkit description : V7R — b - Y —) L% v MIBT AL, Z OIS
XY —Fy FNRET 7 A MURFEINET,

Base toolkit: W A% L« YV —/LF v MIXoTHERENAY — Xy b, HAH L -
V—LFxy hOTRTOHAZ LTy ha— LN _R—R YV —)LFxy hDa ha—
IVEVERET HHE, V=X FETAZL <V —LFy hDON—R « V— L%y |k
LBt N TEET,

[Base toolkit] U 2 FZiZ, UFT R — b3 T TICHFEEL TWEY —LF v hD U R
FRFTRENET, MEOY =Xy NAOYR—FEER LT T uA425E, &
DY —1Fy bbb ZDY R MIERENET,
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T AP R TH LI AL L - V=X y k- FR—F - vy FZERTLEICIT
FLDY— ¥y ke FR—k - 7 TABERENEST, ZOHFLWWY—1F v b -
PR—F - Z7F5RF, BIRLTZR—Z - V—AFy hOY—LFy b FR—K -2
FAEWELET, TOED, FLWHT AL L« V—xy b« BR— T, HEAD
TREEE (T2 L 201E, AV FORBERT 4 ARy F 72 E) [T Ra—FT 4 VT 1 -
AV RER—=R «V—LF% v« $HR— FPOTRTREKL £,

Custom toolkit class locations: =72 =/ N THR— T HHTAZ LT TR
DYDY A K, Eclipse 7R Y= bk, Jjar 77 A/, JavaZ T ADT V¥ (a
PRANERD Java 7 T AT DT 7 A« VAT LD T 4 )VE) BIRETHZ L
MTEET,

7T L\ Java Add-in Extensibility 72 ¥ = 7 R EL REb &, ZNHOEFNRT 1
T2/ FOENL R - RABINENET,

ELR « NRIZE, DRAEL TV TADTRXTOBT FAOEMLEDLLENH Y
F9, SWT, AWT, FE7IXJFC (Swing) MOBEHEIRE LIRS L« 7T ARRL,
Bl TANHAE L 7 T ALFEUHINCHFEELRWEAE, 7ay=2 hOEL K-
NI OEF A FECEMLET,

b

» New UFT Custom Support Class 7  #'— K ® [Custom Class Selection] M (117 ~2—
TESR) 1T, ZORY I RZFIZELIGFION AL L - I T ANRKRINE
To TDD, AR L < HHR— | 7 T AOVERRFICL BTN AL I e 7T A%
BIRT D Z &N TEE T (B LV Java Add-in Extensibility 72 =27 h& EL R L
B THAT L - YR—b - 7T 2EEKRLET),

> Java Add-in Extensibility 7’02 = 7 FOIERZIZ, TRY =27 NOIARAZ L - 75
A DT & BINE 7213 EIBR 4 5121, UFT Java Add-in Extensibility 70 2= 27 +®
[Properties] A 707 « Ry 7 AZFEALET (115 2=V %ESH),
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ARBL -Y—=)LFy b - VSAOEHRE) X MIBMT SIS, ROFIEEETL
*7,
DTFOAFarvzl DU ERLT, BAZL - Y—1LFy b 7520858
LET,

> [Add project] 227 U » 7 LC, Eclipse 712 ¥ =7 kN &&IR L E£ 7, [Select Project]
A Tas Ry ANREE, BIED Eclipse V—27 AX—2D 70Vl NRIR
RINET,

& Select Project

O= ImageControls

B 270yl FOFzv 7 Ry 7 2A%RRL, [OK] 27U v 7 LT
[Custom toolkit class locations] v 7 A |ZEMLET,
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> [AddJar]l #27 VU v 27 LT, Java7—Hh A7 (jar) 7 7 A /LZ&BMLET, [Open]
A TaT « Ry 7 ARFREET,

=3 ImageB utton |

BET S Java 7T —H A7 - 77 A NESBLGRIRL, [OK] 227U v 7 LT
[Custom toolkit class locations] R~ 7 2B L £,

» [AddClassFolder] %7 1V v 27 LC, 7 T A7 5 /VX%1BINL £7, [Select Folder]
XA TaT Ry 7 ANRHEET,

Select Folder

@ Iy Carnputer
* SFE My Metwork Places
{:I Docurentation Feferences

I— ek ’7 4

M
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MET 57+ A 2L TEIRL, [OK] %227 VU v 7 LT [Custom toolkit class
locations] R v 7 AIZEMLET,

E U RANEBDT TR Ny =T EEV— |k T VX ERIRLET,
7= & 2%, 7 7 /L ImageButton.java Ti¥, 7 7 A com.demo.lmageButton 73
ERINLTWET, ZD7 T RAZa AL LU THRE bin 7 + VX IR(E LTS
&, 7 7 A+« 771/ ImageButton.class D% bin\com\demo\
ImageButton.class (272 ) £7, [Custom toolkit class locations] TZ D7 7
A DT EIRINT 2551%, bin 7 4 VX &R L £,

ARBL - I=Fy b - VS5ADGHE X O GHEIBRT BICIE, ROFIRERTL

[Custom toolkit class locations] "~ 7 A THIRT 58128 L, [Remove] % 7
Vo7 LET,
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[Project Summary] EH&

HAB I« —/LFy b FR—bF -« 77 A UPMEREINDENS, V4P — KD [Project
Summary] H[iIZ Java Add-in Extensibility OF 7 1> = 7 MHIZIEE LTEARO <
DERRINFET,

& MHew UFT Java Add-in Extensibility Project

Project Summary

Review and confirm the project properties.

Project Information

Project name: ImageControlsSuppoart

Laocation: C:MlavaBExdensibilityiorkspace_final

Project JRE Compliance: Default Compiler Compliance (1.4)
Source roat folder: src

Clazss root folder: hin

Toolkit Information

Custom toolkit name: ImageControls

Support toolkit description: ImageControls toolkit suppaort.
Base toalkit Mame: 82T

FRINT-NEEHRLET, EREPMERT —X 036 585451%, [Cancel] 227V v 7
LT [Custom Toolkit Details] i (107 X—T % &M) ([ZREYD £9, [Back] H™¥ &
[Next] A& ZFEALT, BMETIMmEZHE, NELREHEZITWVET,
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SET LS, [OK] 227V v 7 LEd, IROIEH %5 T UFT Java Add-in Extensibility (%7
H7ur s MIMERESNET,

> V—/L¥xy hD/— by —: com.mercury.ftjadin.gtsupport.<A X & Ly -V —
WFy FE> ZHITE, RONEDREENET,
> V=¥ y hOL—b - Ny =DV —LFy ke FR—F TR <HRE
L= Y—)LF v F&>Support.java
ZDITADHNEFILONWTIE, 43 3= [YV—bFy k- FR—F - 7T RO
WT) 2ZRLTIZENY,
> YAR—F 7T 2OH% Ty /r— : commercury.ftjadin.qtsupport.<1 X 4 L -
Y—ILFxy hE>.cs
» Configuration & WO ZFIOHRET 7 A AVHD T 314, ZHIZiE, RONENEGE
nET,
> VU Fy MRETZ 7 AN KARRAL  IY—=)LEXy FE>xml, D7 7 A ILDOWH
KIZONWTE, 4= [YV—Fy MRET 7 A MO T) LT
YN

> TAN ATV xs FERET 7 A O TestObjects 7 + /1 4,

T BV B 2 — X IZf4 D Java Runtime Environment (JRE) 734 A h—/L &1
TWC, FEELIE 1 DLUEDOIAZ L« Y —LF v b« 7T ADOEFIN Eclipse 71 =
JRTHDIEAITIE, WAXL-Y— %y h-Tr = b EH LV Java Add-in
Extensibility 7’2 =7 MB3[ECIJRE ZfEH L CWD Z L 2R T HALERH D 3, [A
CJRE ZHL TWARWESIE, +T_XTo7ay=2 AR U JRE 2EH42 L9512,
7Y/ FOJRE #EHE L TLEE,
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UFT Java Add-in Extensibility 7Oz O FTONRT 1 DERE

Eclipse ® A = =2 — « /3—T, [Project] > [Properties] %R L £7, [Properties] #
ATRT Ry 7 ANRMEET, LZMORTHT, Ta T X4 TDY X M6 UFT
Support Z#IR L ET (ZD Y X MO EIE, EHT 5 Eclipse D/3—V 3 NI Lo THR
ROGEZENH Y ET), HDFEARFIT UFT Support D7 137 ¢ BNFERENET,

& Properties for ImageControlsSupport

|evpe Filter text |

- RESOUrCE

-~ Builders eV e g e e
- Java Build Path
ImageControls boalkit suppart,

[H- Java Code Style
- Java Compiler
[#- Java Editor

- Javadoc Location

Il
(3 g £ S )

== ImageContrals

- RunfDebug Settings

IDEATOT ARy T ADKE T 3 oW TIE, 107 ~4— [[Custom Toolkit Details ]
W Z#ZBL T EEN,

Java Add-in Extensibility 7’72 ¥ = 7 F O{E#%(Z, [Unique custom toolkit name] *7-
i3 [Base toolkit] A HJ 5 Z LIXTEERA,

[Support toolkit description] Z A% 42 Z L X A[HE T, F 7z, [Custom toolkit class
locations] U X h THFTOBEMLHIBREITO) 2 &b TEET, ZOIJ R MEEET LB
IZiE, ZHUZEHLbETT ey FOENR « SREEETHXLENH D £,

[Restore] R %27 Vw4 hE, ZOXATOT « Ry J ADREERBIRTFL
FEICRET N TEET,
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New UFT Custom Support Class 7 1 — F

Java Add-in Extensibility 7’02 ¥ = 7 NN THR— b « 7 7 2EERT 554513, New UFT
Custom Support Class 7 4 ¥'— REEHLET, V4 F—RTHAX L - 7 TR LNER
UFT YA — FOFEMZIEET 2 &, ZRUICEDLETYAR—F « 7 7 R EMTERTXTO
Ay RIMERENET, £72, VAP —RFTEREND A Y v K- 22T %FIHLT,
BIMORAY y REFEETDHZLHTEET,

Eclipse T New UFT Custom Support Class 7 1 ¥'— FZ2E1 T 512X, ROFIEE=
fTILET,

1 [Eclipse Package Explorer] % 7 C, UFT Java Add-in Extensibility 7' &2 = 7 R &38R L
%7, [File] > [New] > [Other] Z&RL £, [New] ¥ A7 0 Ry 7 A3
fEET,

Select a wizard

€V Interface
(2% Java Project
s Java Project From Existing Ant Buildfile
----- 12 Plug-in Project
ﬁ Product Configuration
He[ OS5
H- [ Java
t- = Plug-in Development
=% Unified Functional Testing
éﬂﬂ UFT Test Custom Static-Text Support Class
BT UFT Custom Suppart Class
UFT Java Add-in Extensibility Project
H- [~ Simple

2 Unified Functional Testing 7 + /L % % J£ff L, UFT Custom Support Class % %R
L/\i—g—O
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3 [Next] #7 YV v 27 L%7, [Custom Class Selection] [Hi»3pd & £,

E > b : Eclipse % A% <4 XL T UFT Custom Support Class = [New] A ==2—0
FTvailThHl, TOFEEEMT D ENTEET, ZNEIT I, [Window]
> [Customize Perspective] #ZIR L 9, RRENHFAT T Ry AD
[Shortcuts] % 7 ¢, [Unified Functional Testing] & [UFT Custom Support Class] ®
Frxvl Ry 2EERLES, [OK] 27V v 7 LET,

[Custom Class Selection] EmE

[Custom Class Selection] Hiifii%, New UFT Custom Support Class 7 - % — K O I 4J) 0 [ i
TY, ZOBE T, PR—FTHEHAZL - 7T AEZRRL, BET LAV a %
HELET, VAP —RIX, DAL 7T ZAOMWEBERIZESNT, HrLnPR—| -
I FATYRT ZMEOH LA OYAR— b - 77 2% BEIIITHBI L E T,

[Next] #2 V v 79 2% &, [Test Object Class Selection] M (122-3—3 2 &) 23BH &
e

F IR —FT227 7 2A08RRL, WAZL - YR—F - 7T ZAOERDON—ALTRY
£, BREOBER CEE 2T 7RIS, ZOBEICR> THOZ 7 2A2@RLTCGE, #%
Fe OB TIT > e AR S L ET,
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& Mew UFT Custom Support Class
Custom Class Selection

Select the custam class you want to support, and set the relevant options For the 'gi
corresponding support class,

B4 com.demo B java.lang.Object
o[ Bl java. awt. Companent
[J]  1mageContral B java.awt. Canvas
m Imagelabel Iél--com.demo.lmage(:ontrol
1 com.sample cam.demo. ImageButton

Gt 5 o b e B R prEs e b

[

ZOEED A A UHERICIE, ROFT T arnbb E9,

» Custom toolkit tree : V' "/R— N DEH ERD B AKX L« YV —LF vy NNOTRTDY
T ANERENFET (New UFT Java Add-in Extensibility Project 7 4 ' — K THIZE L 7=
HAB LY —)LFy 7 TAOEHMPLBEINET), BHRLE (H) L#Hok
Tehits () 2EHTLE, YU —0ORRALHY Z7eH BT, Ny r—UE T TR
ERRTDHZENTEET,

WO EW =T 7 T ADHRRRTREINET,
> java.awt.Component % 7= |3 org.eclipse.swt.widgets.Widget #4195 7 7 X,

» UFT OV R— bR EFIEEEIN TV WT TR, BAX L« 7T ADYHR— FR
FTTIZUFTIZT 7 A SN TWAYE, £7IEBIED Bclipse 72 =2 N TH A
Hhe I TADYR—NEER L TWDEEE, DAZL T TRAZIZOY Y —IZFK
RENER A,

118



& 5 E « UFT Java Add-in Extensibility Eclipse 75 7 4 > O {E A

F O EROFEHOTAATHIZLTWDICLELLT, YU —IZRRINBNT T AN
54 1%, Reload Support Configuration =~ > N (155 X—Y%5M) ZH L
TEREZEHF LTI,

7= & 21X, Eclipse @ Java Add-in Extensibility 7' &2 = 7 N CH AKX &« H R — K& Hl
BRLT, RILAAZ L - 2y ha— VA0 R— s EFRIERT 2581%, A—
FOREEHE— FTLO2MLERDY £, ZhIZkY, BAX L 75 2% Custom
toolkit tree |[CHK T H 2 ENTE LT,

Custom class inheritance hierarchy : Custom toolkit tree Ti#&R L 7= 7 7 2 Dfkk
BEAFRRINET, JL—FRD/ — R, ZOY—1LFy MIEENRNT T A
ERLTWET, BLEREND /=L, IAZL - Y—Fy NIEENDZ T
AR LTHET,

[Custom toolkit tree] % 7-i% [Custom class inheritance hierarchy] Tix, #LiEd
DAARL L 7T AERINTE EF ([Custom class inheritance hierarchy] T/
BAEFREND /—RE, UFT R — M ERTZRVWT FADHREBRNCTEET),

Base supportclass : FILWVAR—F «+ 7 7R K> TUTIES N DY HR—F - 7
TR, TOHBRELERESTLZLITTEERA, V4 — FTIE, UFT HR— F&2&ie
WEW®%%E“%@@%? Fe 7 TAMBIRENET (DAZ L7 T ADYHR—
FRFTICUFT IZT 7R A SN TWDHE, EIEBIED Belipse 7R Y2 R TH
AL LN . &7%@#% MEERR L TWAHE, VAP —REIZODRZ L7 TR
ZUFTYA—h280b0 L@ LET),

UFT MFEDH R — K« 7 TR v BT ENTW e Wlavad 7 V=7 h i L
28%a, ZOFT7 V2l FORLIEWEHRIIY Yy EY 7 ENTHWAEYR—F - 772X
MEREINET, 207D, X=X« BR—bF « 7 TR 1L, BFEOVHR—F 7T A
W~ v BT ENTORWERICI AR L« ay ba— Uz R— a5 7

WZRVET, LI RZ L - FR—F « JTATIE, "—=R - HPR—}F- -7 TR
THolictiEn vt R — hoAhzFE (3 —"—F 4 K) TIHILERHY
7,
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120

[Custom class inheritance hierarchy] 5 £ U [Base support class] [Z&£ R34 5
HHREEHT 2L, OO PBEEOLALD) DRZ L 7T ZADYR— K Ziiik
TRENEIDEHWT D LN TEES, T 2L, ROFZEELTE
&,

> UFT VAR — bRl W N BB O A X L« 7T ANFEETDLINE DD,

> FHETDHE, TOHARE L7 T ATEEOTHRIZH L TR U FETYHR— T
HMBED I D BRNFIET D0 E 90,

FROEZN THET D] THHIHAIL, By 720V R — L ZIRINSERT S
TEERFLTLIEEN, ZOBE, OV AR— k-7 Z 2% [Base support class]
ELTHEMHT2ZENRFEICRY T, 7 7 ADBBERATRIERINDEGAITIT,
COMEmTERRNL, ZOU AP —FR--Eya s THNTLIHFR— FNEERTLZ L
BTEET, ZIFIARTV—RRENDLDHEITIE, ZOY—Fy MIEERRNE
©, HFED UFT Java Add-in Extensibility 77 &= 7 FNTHR— FEERT 5 Z &1
TEEHA,

Er 7 T ARBEDOYR—F 70V d hOR—=R «V—)L¥x v F&IEETIHE,
INEHAZ L Y —)bXy MIBMT2ZLI2E-TC, 207V =27 hORAI—
FIEBMTHZENTEET, R—R -V —L %y MIOWTIE, 107 ~2— [[Custom
Toolkit Details] M) #ZML T 723V, BEFOYHR—F - T rdcs MIxtd 2
HAL L 7T ZADEMIOWTIE, 115 ~4— TUFT Java Add-in Extensibility 7" &
Tl NOTENRT A OER] ESRLUTIIEEN,

FNLSOGE (RN N T ADYHR—FEERLTHLE, TOVR—K- -7
AH_R—R PR —F - 772 LTHEHTHE) 1, RIXN—JICRFEINTWNS
FIEZFZITTHLERHY 3,

[Custom Class Selection] Wi ® FDEH 321X, ROFTF L arBdH 0 £7,

» Controls of this class represent top-level objects : UFT T=> fa— /L3 7 & | -

FTV 2l MEBOR MDD Java A7 V=7 hELTEBINS EHFETESL LD
WHRETAHZENTEET, SOV TIE, 71— T hy L e F T =7
FOYR—1] 2L TIIZEN,

IDOFzv T ARy I AEERTLE, VAP —REIH LI AT L - FR—F -7
Z A ZisWindow A Vv FEFE-E LT, ZOAY v Ridtrue ZIKLET,
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ZOFTad, YR—=PFTDECRR LI FANALTF 7T ATHD (0
% v, java.awt.container ¥ 7- |3 org.eclipse.swt.widgets.Composite % $L3E 3 %)
LR oORMEATEES, HTLOIHR—F « 77 25 ShellCS (SWT) , WindowCS
(AWT) , AppletCS (AWT) OWFNANDHYR—hk « 7 T RAEIETIHHE, 0
Frxv 7 - Ry 7 AFEETERRINET,

» Change custom support class name : L EIZJE U T, YR — b« 7T AD T 1 HF—
RIZ K DIEEREDARTE AL T HZ LN TEET,

EHERE T, VAR —bF « 7 T RAOARNE <HRBL -V FTRE>CS T2V F9, 1L
N EDLGE, BEREOLRIEERTHINETHY A, 2150, DAX LY —
%y MCERBZEBONRNy r—VD 0 FANEGEENTWAES, RUARIONAZ
Lo I TANEEGET HAREERH D T3, ZOEAEE, 1 20Oy —JITEM
TELEICH AR DL « R— |k « 7T A EBR 40 A ETHVERHY £9°,

HAZ P R—k 7T 24 %KET 5121, [Change custom support class
name] = v 7 « Ry 7 ZERIRLTHE, FHLWARTIZADLET,

¥ : [Custom Class Selection] [ D4~ 3 = > i, New UFT Custom Static-Text Support Class
v 4 #— K @ [Custom Static-Text Class Selection] Wi CFIAT&X 547> a v LRLT
T (148 =T M),

CDARBL - I—)Lxy MEFEALEOEEY SRIZHT B HR— FE2ERL, D
YR—FER—R - YR— b - HSRELTHERATSIZE, ROFIEEETLET.

1 51® UFT Java Add-in Extensibility 7’0 V=2 T EM2 7 A2kt 28R — F & 1ERk
LET,

2 ER L7V R =& UFTICT 7 A LET,

3 5t® UFT Java Add-in Extensibility 7”2 ¥ =7 & HERE £3, [UFT] > [Reload
Support Configuration] %3R3 %2>, [Reload Support Configuration] R % > %
70y 7 LET,

4 New UFT Custom Support Class ¥ 1 #— R (116 X—Y%&MW) #& 9., ZhT,
T4 P = RCTHLLAER LR —b « 7T ARR=R = HR—p - H5R L LT
WEINd Lo ET,
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122

[Test Object Class Selection] [ElfH

[Test Object Class Selection] HEH TiX, WAX L+ IV TRETAKN ATV b+ V7
A= B 7 LET, UFTGUI DT ARNT, BAX LT T A« ayba—)LL,
WLETAKN ATVl b VTADT AN ATV MkoTRENET, B
AL L HR— b - 7 TATE, TOBE@MCTRIRTHTAN AT V=27 b 7T R%
BT L OICEESN- to_class_attr 7137 1 « XV y RB3BEMENET, Zhick
O, PR—hK I FAT, DAZL + JTRAI Yy ELVTEINTNWET AN AT V=
7 k7T A% UFT ([Tl@AT 5 Z EAREIC2 D 9,

[Next] %27 UV v 2925 &, [Custom Support Test Object Identification Properties] M (125
N—=Y 2ZMR) PHEEET,

FOASL VTR E U TTETAN ATVl b 7T AOBRE, HA
B LY R—F 7 TADERDOR—R L0 £9, SO HE R CER 1T 7121%12, Z
OEMEICRS THDOT AR « ATV b« 77 AR LGS, BEOHEHR C{T-o
TEERITWEINET,

& Mew UFT Custom Support Class

Test Object Class Selection

Map the custom class to & UFT kest object class,

Javatbiect R

DU 4 P— FEFETIE, WOWTNILDOFT L g U E2BIRLET,

» Same as base support class : X— & - R — |}« 7 T 2D to_class_attr 7' = /37 ¢ -
AV RIZESTEENDBT AN AT V2T h e JTRIHAT L~ I TR~y
U LET (ZOFT v a VEBIRLEESA, (EBRESNAH LW HR—K -7 T2
IZ to_class_attr 2 Vv FIZBIMENEEA, LI R—h « 7T AFT_X—RZ «
R—h I F2ADRAY v FEMPEALET),
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[Custom Class Selection] i (117 X—T & &) TIL, LY HR—F - 7 F R
Lo TRERENDYHR—F IV TATHDIRXR—A P HR—F -7 TRERDE LTz, X—
AP R—F - I TRACLoTHR—FINDIIAZ L - 7T AL, BEDT A b -
FTx I N VTR T EINET, TOTAN ATV b JTANR
HAR L 7T AHT DT AL - A7 V27 b THLHDHEAICIL, [Same as
base supportclass] 47 2 VEBIRL 7,

Lo k5 725412 [Same as base support class] 47> 3 U EBRT 250250\ T
1%, ROFIEZRLTIEZ,

> N—=Z +HR—F -V FRATHR—FINDIHDIZELU LTI AZ L - ar br—
NEYR—bT 556, 2 ba—APRECRBET T 4 ETAL - F TV
Fe AV y RERL, ZTNODOT BT 4 LAYy RIRRRDFETEEINLTVD
e, Ihooay ha—WI3EHUTH DL L7 snEd, Zo%HE, HFR— Mkt
BOHAHF L« 2y ba—/LZiE, X—R -« PR—§F 772D to_class_attr 7
ORXT 4 Ay RILEoTRENDT AN ATV b7 TABELTNET,

> EREoar bu—LEHR— T 5720 TE2RL, EFDOVR—b -7 F ATHEE
THVR—F - 77 2A%ERTDHE, ZOHA, EOTAL ATV k-2
FABEHNAL LT TRy B T TENIEETRNZD, ZOF v a
BINTHZENTEET, ZDOXIRFNTONTIE, 229 ~— ImageControl 71
AL T TADOYR— bOMERK] BB L TIIZEN,

Existing test object class : UFT T4 TIZ¥ AR — h SN TWABEFOT A h AT V=
I eI TALHARAE L I TR~y BT THIENTEET, 20V R MU,
UFT TYHR— RSN TNDETRTCD Javad 7 V= b« XA TREENTHET, &
AB LY R—=NMIXHTDHLNWT AN ATV b -V TREERTDHE, 2O
TFTARN ATVl b7 T7AH YA MGBMSNET,

Eclipse DBAED T —J AXR—ATH LWT AN AT V=V F + VT RAEER LY
&, TOURMIELIZRRINET, TNLSNOEE, FILWT AR ATV
FeZZ21F, UFTIZ7T 7oA LTRELZHR— FLERICY XA MIERENET
FEAMIZ DWW T, 155 ~2— [Reload Support Configuration| % Z[f),

70Vl PNTERSNTWRWT AN AT V=7 b7 7 AEERTIHHEIT,
BR— FBEEUNHERET B LI, EDOTAK - F T2 r b 7 FADEFES UFT
T 7uATHLERHY 7,
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Z @ [Existing test object class] 473 3 v 2RI HFXIE, BEUIRBEFEDT A
heF 72l b 77XV RADLERTILERDD £7°,

EVh:ZOFTvaid, TOTAR F TP b VT TRIHAL L a2 b
0=V T aNRT 4T AN AT b AV RRTRTCEEN TV 58
BRILOABER LTI, Ta T 4 R0A Y vy ROBMBLERGET, [New test
object class] Z &N L F 7,

New test object class : {Ei T 2H LWVT A b « AT PxT b« 7T RITHAZ D -
ay hR— L ESy U TTAIENTEET, ZOF T a i, BAZL - av
=L DT RTORBBTENRT 4 LT AL - ATV T b AV v REEGREHED
TAN ATV b T TABFIELRWVGEARIGERL L ESY, 2047 Ve
VEBIRLEBAIE, ILWTF AL - ATV e T AL EANLET, T
AR FTVxT b ITABIEFEETET X —RAaT OHREHEAL, RO
FIIMTELFICTHLERH Y 5,

ZOX T arwEIRT 5 L, [Extends existing test object] 47 = VANENIC
Y ET,

Extends existing test object : HTLW\T A | « A7V =2 b« 75 A%, BFEDOT A
N e ATVl b IV TRER=RZ, BT ORT 4T AN F TV b R
Vy ROy FEEELET, T_XTOT AL - 47 V=2 b+ 7T AL, JavaObject
7T AEYRLET, ZITE, BEOBHFDOT AL ATV b I TRAEY R
FB@EIRTHZ N TEET, 2DV R M, [Existing test object class] 47
TaryTCRBIRCXAMGEDT AN e AT V27 b« 7T ADY A MERLTY,

[New test object class] 7> 3 v %8R 2 3551%, [New Test Object Class Details]
EiE (144 XR—=Y%ZH) THLWTF AL - A7 Vx7 b - 77 ACET 5% B
MTERLET, HLWT AN ATV N VTADERIIT AN ATV x/
FREZ 7 A NMIBIMENET, 207 7 A LOREE L AKITOWVWTIE, TUFT Test
Object Schema ~/L 7] ([Java Add-in Extensibility SDK ~/v 7] CTHIFHFHE) ZZH L
TLIEEN,
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[Custom Support Test Object Identification Properties] EMH

[Custom Support Test Object Identification Properties] BEIZIE, AR L L H & LT HN—
A s PR—=h 7 FATHR=F éh’(b\éwuﬁﬁj’\ﬂ/\T% L, BRLEET AN - AT
V7 b JITATERSNTNT, EEHFR—F SN TORVIBINIT 037 4 B3R
SNFET, 2T, YAR— FEFEEE T LVERETAE— =T 4 RT57 X7«
ERIRTAZENTEET, £/, LT aXr s 2 BMT52 L TEET,

[Next] #7 V> 79 %&, [Custom Support Test Object Methods] M (129 <— %%
M) MBREET,

& New UFT Custom Support Class

Custom Support Test Object Identification Properties

Determine the set of test object identification properties that vou want to suppart For vour custom control,

atladﬂed |_text
background

displayable

enabled

foreground
handle

Oz
O
&
&
Oz
oz
D@dlsplayed
oz
Oz
Oz
Oz
oz
0O Efhei
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R—X -HR—F - HSAOSBEEINZTONT«

FERIOFRFRITIE, N—R PR —F « 75 R Lo TEESNDZTRTO S 18
FTANFETRENET, NOORKE T2 T 1%, ERTPOYR—F - 75 RI2k-T
A INE T, AEEORRIE T v X7 4 &238INL, TNENOYR— &8558 CHh—
NR—=F 4 RTHZENTEET,

F: RSO T e T o OHIIE, TAN ATV b FTADERIZEEN
RObLONRHY ET, TOD, ZhbiE, UFTO (A7 V=2 h AL FA4Ta s -
Ry I AR [FouvIHRA L bOTanxT 4] X477 - Ry 7 AFERINEHR
Mo TNEDRFHET 0T 41T 78 AT 5HI21%, GetROProperty 2 V> F&H L E
9", GetROProperty A ~ v F®OFEMIIZ D TiX, [HP Unified Functional Testing Object
Model Reference] #Z ML T 7Z&E0,

O 4P —RTHE, YR —b 7 TR 757 A VOLERIFIZ, BINT D585k 7 1 37 4
LI <BETONRT B> _attr LIS LAFTOVER— AV R 2 TRBINENE
Ty PR—F - AV Y R+ ZZ7F, R—=ZX+H R —h+ ZF2DYFR—F+ AV
ERCEEZERLEYT, WAZ L arybo—LO=—XZE5bET, HLWIHR— -
Ay REERETDHZENTEET,

TANFATOxH b VSRITRHEZEMD TA/IRT 1

FRIOFRRPUIL, BIRLTZT A AT VP27 b« JTATERINLTVDNR, X—
A e PR —bh 7 TATEIR—FEINTORWVER T 0T s NERENET, 20
U 2 M, [Add], [Remove], [Modify] "¥ v &AL TEFT LI ENTEET,

CORPBEOBH T RT 4 T, V4P = FTERENDI VR — b7 TR FR—
e XYy R« ZRZTHREBNMENETT, WAX L2 ba—LO=—X|ZHELETE
LI HFETOM, NHEOYER—h« AV R« 2XZ 7 Enull KL 9,
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DY RMIEET 0T 4 2B8MTDHE, TAL ATV PRET7ANDT A
F oA TVl b IV TADERIZINODORH T 0T 4 NBMShET, 2077
A VO & NI DT, [UFT Test Object Schema ~/L =7 ] (FJava Add-in Extensibility
SDK ~/v 7] THIHAHE) 2Z ML T 720,

3 : [Test Object Class Selection] Wi (122 ~<X— %% M) T [Same as base support
class] 7 a v ERIRLIEGS, VAP —REIEDTAL ATVl b+ 7 T7AN
HAB L s ay ha—UIvy B 7SN THHE0ERi#ELETA, %@F%,m&7
mﬂ?ﬁﬁﬁw@iﬁﬂﬁﬁﬂéﬂi%homﬁ7mA74%Em¢6k 74—
TIERESNDYHR— b « 7 FRZ@EY Y R—1« AV y K- 22T BEMENET, 7”_
7L, ZORMTm AT 4] ,wfﬂ@?xh-ffvm&h-&ﬁxwﬁit%ﬁm
SNFEFA,

TRRT 4 DEMELIFHIRETSROEZEER

> ZOVRANMIBMULERE#R T T 41X, TAN AT V=7 b« 7T ADERITIEB
MENET, 2T, ZDOZFTADFTRTOT AL « 77 MIxtL, UFT DR
T RT 4 DY A NMTHLWT BT s NBEND T EEEWRLET,

FOiD, TunNT 4 EZBMLEY EEZTWDIEARE, BMEOT AL A7 V=7
ke 75 2FFERTAIRDVIC, BEOTA N - F 72l b 75 R5_R—RCH
LWT AL e ATV b e JTREBERTHZEE2BEOLET,

> VA D BRFET v T 4 ZHIBR LT2GE, HIBR L8R T m ST A IXZ DN AL I
A LT R— SRV ET, 2L, AN A7V - T FR
DEZBIZEIEEN-EFICRVET, 207D, ZOFTa T L ZUFT A7 V22
b« ARANZERENBFEHET 0T 4 DY A NI EFEFRINETR, i
HYFEHEA,

> T e RNT A BEETDLI L, R e T o BHIBRL TH LWV T v T
ZEBBMTL0LHERTTT,
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EEITORTAOUR MOEE

TROFNETIE, AL AT TVxT b I TRIMERBMT 0T 4 DU AT, &
W a T 0B, HIBR, EEEITO HFIEICONTHILET,

B TO/NRT 1 ZBMNTBICE, ROFIEEZEGTLET.

1 [Additional properties required for test object class] F7~#:C, [Add] #27 V v
2 L% ¥, [Identification Property] A 717 « R 7 ANRPHEET,

& Identification Property

2 LWV T s 04FT AL, [OK] 227 Y v 7 LET, @7 v T 14
CIEBF LT o H—2aT7 OB EHML, BHOLFTLTHLFICT HLERDH
DET),

R TO/RT 1+ ZHIBRT B121E, ROFIEERTLET .

1 [Additional properties required for test object class] F =T, HIfT 57 m <
T4 EBIRLET,

2 [Remove] #27 Vw27 L, [Yes] #27 VU v 7 LTHEELET,
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RETONRTAEEETDICIE, ROFIELERFTLET,

1 [Additional properties required for test object class] £/~ T, 42 LE T 57
aRT 4 BRI ET,

2 [Modifyl %7 U v 7 L%, [Identification Property] & 7 1 7'« R v 7 A& £,

& Identification Property

3 BT m AT A OAFELEL, [OK] 2270 v 7 LET,

Evhk: ¥ FR—b -7 TAPERINZE TRBE T 237 4 28T 28541, [Add
Identification Property] % . % {9 %2>, Eclipse T [UFT] > [Add Identification
Property] R L £,

[Custom Support Test Object Methods] Eiff

[Custom Support Test Object Methods] BIZIX, WAZ L -2y hr—LIvy 7L
TeTARN AT V=27 b 7T RAHLTERLET AL ATV b XYy RR
KrRINET, ZOBETIE, VR —-F2EEEEEIHLOEETET— =51 FT5
TFTAR ATV R AV ROER, BIOHLWT AL ATV b AV
ROBIMEITVET,

[Next] 27U v 7 42%&, WOWTNNOBIHEHE ET,

> AWT R—ZDH AKX L+ 2 b a—LOHFR— h&fEk LTV A841E, [Custom
Control Recording Support] M (138~— #&H) BHAEE T,

> SWT R—ADA AL L ar ba—LOPR— b EERLTNT, BAXL a2 |k
B— U WIZHLWT AR TV b IV TR~y 7 LIEEIL, [New Test
Object Class Details] B (144~5— #5H) NEXET,
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> BIROWT ORI H E TTE 57204 1E, [Custom Control Support Class
Summary] B (146X— 22 M) MHHEET,

& New UFT Custom Support Class

Custom Support Test Object Methods

Determine the set of test object methads that vou want to support For wour custarn cantral,

DEI Dblclick {Object argd, String argl, String arge, String arg3) EI Click {Object obj, String butkan)
DEI MouseDrag (Object argl, String argl, String arg2, String arg3,
DE‘ Type {Object argd, String argl)

R=ZX Y R—b - IFAMBEINDIAV Y

EAORFRIZIL, BIRLTZT AN ATV b JFATEREIN, X—R - PFR—
b e 7R TERESNDTRTDT AL AT V=7 b XAV y RPRERINE
Fo INHDT AR AT V=2 b AV N, BRFOFR—F - 7T RA2L-T
MEKENEST, EBEDOT AL AT V=7 b - AV Y REBRL, ZAZNAOYHR—
ERBRDFEETAH—N=TA RTHLENTEET,

DT 4P —FTIE, YR—F 7T« 77 A VOIERKIRC, BIRLET A - AT
VI h e AV RTLIZKTFAM-FTSY b - AYy F£&>_replayMethod &)
BRIOPFR—T « AV o R 22 TRBEMENET, FHR—h- 2V v K- 2AXTIF,
NR—A e PR—=F e 7 FT2AOYFE—h « AV FEFUEZRLET, DAX L3
=L D=—=XZHEDLET, LWV AR—b - XYy NEFETHZENTEET,
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3 : [Test Object Class Selection] M (122 ~<X— %% M) T [Same as base support
class] A7 a VERIRLIEGS, VAP —REIEDTAL ATV b« 7 TN
HAZL a2y ba— LIy BT EINTWANEE#ELETA, FORE, Lo
FTRREIZT AR ATVl b AV RFFERESNETA, HILLWYFER—FK -T2
PERESNTE T, X—=R « PR —F « FTADNGHEKTEIHEAY v REF—1R—F
A RTHICE, ZhbEx 7 TRAZFERTEMLET,

TAM XTSI b YSRRERGEBMDAY Y F

FROFTRHICIE, BIRLET AL - AT V= b - 7 FATERSATNT, R—A -
YR= R« 7 FATEIR—FENTOARDT AR AT V22 b+ A Yy RPRRE
hET,

ZoRFMEOY A M, [Add], [Remove], [Modify] A% ZH L TEESTLHZ &
MTEET,

Ay ROLMIEERTHI L1E, AV y REHIBRLTHLWA Y v REBINT 0L
FUTHDLZ LICERE LT EEWN, FERIZ OV TIE, 133 ~4— [[Test Object Method]
HATBT Ry 7 AZHONT] ZERLTIEIND,

EVbh VAR - T TARERSINTHETT AL - AT V=7 b AV y REBINT
5%61%, [Add Test Object Method] 7~ % > %9 % %>, Eclipse T [UFT] > [Add
Test Object Method] %R L £,

ZORBHEDT AN ATV b AV RTEIL, TP — FTERESND T HR—
he 7T RZYHR—=h+ AV R AFZTREMENET, DRAFL - ba—1LD
==X ALY TEETLETOM, Zho6DFKR—h AV Y R AXT[FxT—E
Retval.NOT_IMPLEMENTED #%3& L £,
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ZOUANNITAN ATV b AV Yy REBMTHE, V4P —KNITA R - F
TV MREZ7ANDT AN « AT V=22 b+ JTADERIZINGDT A b - &
TV ke Ay REBIMLET, 207 7 A /VOREENEICOW T, [UFT Test
Object Schema ~/L "] ([Java Add-in Extensibility SDK ~/L7°] THIHFEE) =S LT
STEEWY,

3 : [Test Object Class Selection] i (122 X— % & M) T [Same as base support
class] 7 a v ERIRLIEGS, VAV —REEDTAL ATVl b+ 7 TAN
NAZ L2y bmg—WIwy B 7 ENTHH0ER#ELETA, ZO/RKE, Ao
FBRIZT AN« A7V b AV RFERENEFA, TAN - FT V=T b -
Ay REBITHE, BRSNS R—b 77 R CHERFEAY v K 22 TR
BMENET, 272L, ZOTAL ATV ke Ay RIE, WTROT AR - A
TVl b I T AOERICHBMINET A,

TAR ATz b AV FOBMELHBRZTSBROERESEE

» ZTOVANMIBINMLET AR ATV b AV R, BEOT AL - A7V
IR 7IRTBEBMENET, ZNIE, ZDIVFTADTXTDOTF AL « A7V k
WZxL, T4 T Vs PTHR—FENE00E 9 MTB%RAR <, UFTIZH LW
Ay KRB BEMENDZEE2BEMLET, UFTGUIOT A T, A7 V=7 Mokt
THTAN A7V b Ay REROHLT, Z2ORA Yy KBRYR—FENT
WRWGE, EITR I —0NRELET,

ZFDESH, WAL ary va—LEYR—FTIHEDICT AL - FT VT b A
Vo REBMLEY EBZTHWDBHAIE, BMFOT AN ATV b 7T A%
A+ 25800, BEOT AL ATV b 7T AZR=RZHLWT A -« F
Tz N VTARERTHI EHBEIOLET,

> COVRARMNLT AR ATVl b AYy REHIBRLESS, HIBRLIZT A B -
FTx2 I R A RIXZOB AL L7 T AR L THR—FEne< e Ed,
72720, TAN AT V2T b VTAOERIITEENTZETFICRVET, TR
W, UFTOT AL - ATVl F+ AV FOY R MIFFI&EEFRRINET,

UFTGUI DT A RN THAZ L « 2 ba— )V ETIDT AN - F TVl b AV
FEMHER LEEE, ETHo =084 L £, =& 21E, drop-down-list =2
o—/LiFList7 AN A7V b LTHFR— NI ETA, drop-down-list = >
Fe—/LZkt L Tselect_range 7 A K - A7V 7 AV y RERIRL, ZOT A
FeF TPzl b AV RPYFR— RSN TNV, BT —nRBAELET,
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[Test Object Method] #«4 787% » Ry Y XIZD\T

[Custom Support Test Object Methods] i (129 ~— % & M) T [Add] F721% [Modify]
7 Vw79 2%&, [TestObject Method] #4712 « Ry 7 ARMEET,

[Test Object Method] % 7 & 2« /K »» 7 A Ti%, [Custom Support Test Object Methods] [H
i @ [Additional methods required for test object class] £ HHIZFEREINDT A | -
FTV2 T N AV FOFHMERET D2 ZENTEET,

& Test Object Method
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[Test Object Method] # A 7R « Ry 7 ZIZi%, ROEBERH Y £7°,

FFva v

i

Method name

UFTGUI DT A h TRRENDLT AR ATV x 7 b+ AV v KOAHI,

TAN FTVxT b AV ROATINL, 2—PRAT v 7 - VX

L—2R0F—U— K- Ea—TRIRTEXHLIIL, TAL - FTVxs

ke Ay ROBERERDND X9 RARNZLTLIES VN, A Yy RO4

BHCHETFTLANDOLTEEDD Z L ILTEEEA, AV v RADEYIOX

FUIMTRILFICT DMLERDH Y EF, Flz, AXN—ZAPLROELETEE

OHZEIXTEERA

T@#S % N&*()+=[1\{}|;"",/<>?

b

» PAR—=F - 7 TANICT TIAFHELTVWDT A - AT =7 b - R
Yy ROARNIER LW T 7ZE v ( [Custom Support Test Object
Methods] BEGIZIE, YAR—b « 7 T ANIZT TITFELEL TN DT A
heF TVl b AV RBREREINET), BEOT AL - 47
Tl b AV ROFEEEF—N—F 4 RT5551%, (A C4H
DFHLWT AR ATz b AV y REERT 2O TIERL)
[Custom Support Test Object Methods] i O /4| D 7~ ¥ TEEAE DO 7
AR A TTVxT b AV RERIRL T EIN,

> Ay ROAFIEERTHZ LI, AV y REHIRLTHLNA Y ¥
RZEMT 5D LR LT TT,
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*F7a v

i

Arguments

TARN AT T b Ay ROBIEEZDODXATDIV AT,

VYA RNEERETIHAE, RORZ U EHFERALET,

> Add : 7 AL - AT Vs b Ay RIZBIEEBINTDZERT
TEF, FMIOVWTIE, TRO"TAN AT V=7 b AV YR
DFBOBMETITEE " 2SR T TEEN,

» Remove : BIRL7-515% Y X b HHIBRLET,

> Modify : 72k« A7 V22« Ay ROBMELEESZ = L3
TEET, fBMICOVWTIE, FRO"TAL ATV b Ay
ROBIEDBINE IIFER " E SR L T ZE 0,

> Up @ @IRL7281%% L hmicBeh LEd,

» Down : BIR L7251 %E NARICBE LET,

> EOTAN ATV b AV RTYH, KHIOHIHEIT
obj (Object) (272 v £, Z 051 LAk, A%, £E3BET5
ZEIFTEEREA,

» [Test Object Class Selection] M (122 X—T &2 ZHR) THEINL72BL
FEDOTAN AT V2 b JTRABTHT AN AT V=s k-
AV ROBHEERETHZ LI TEEEA (0FY, BHFEOT A
FeATT=s b AV RT, BIEOBINCHIER, 235180 #
ATOELTEITH ZLIXTEERTA),
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FTa v

B3

Method returns a
string value

CDTAN - FTVx2T b AV R, VH—r - a—RIMxT,

FFNEEZIR L ET RV A S LT UFT GUL 7 X hD#%ED AT v

TTHEHATHZENTEET,)

ZOF =y - Ry AERRULIEGE, ROX IRV ET,

> TAL ATV MNRETZ 7 ANMMERENDT AN ATV
b+ A Y v FOEFIZ, ReturnValueType ZE#NEMEE T,

> HLWYR—b - 7 F2ARHERESNDRA Y v R AZ T, VE—
vea—FOK & EOFSEETeA7 V=2 b Retval(™) %K L
£7,
CDTANFT V27 b Ay RICKLTHAERY v NEFET
LB, SESEARMEO Retval 2+ 52 LN TE £, A
Vo RS T 5L, OK L3487 2 UFFIEN RS NET, Z1L
SOGENE, BET 2T — - a— FOLBEINET, iBHlicON
1%, TUFT Java Add-in Extensibility APT Reference] ( [Java Add-in
Extensibility SDK ~/L 7] THIAARE)Z SR L T E &0,

Description

AT T VxR —ARF—TU— R+ Ea—TT AN AT V=V b
AV y RECAH—Y IV EBEWEE, BXOZT ¥ TAT— AV b
MR L WD L XICERENDY—LE V FTT,

Documentation

TAR - FTVxT b AV REGLAT v THREBRIIT S NEIZHE
THHPLTT, OB, AT v 7 Vexb—FD [RTFvT
I22OWVTDAAVER] Ry 7 ABLOF—T— K- ta—0 [FER] &
T AIERRENE T,

ﬂ 7 Vw7 LCEET 5514 % 87T 5 L&, [Documentation] 7 %

A MIBIBEHAT L2 ENTEES, 20Kk, SIEITHET 2MHICEH)
PICE SR HNET,
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TR FITSzH b AVY FOSIEDEME-ITER

[Test Object Method] %A 712 + K> 2 AT [Add] £7-1X [Modify] %2 1V v 2745
&, [Test Object Method Argument] #7127 « R 7 A& £§°, [Test Object Method
Argument] ¥ A 7 17 « R 7 AT, [Test Object Method] %A 7 12 « ARy 7 ATk
RENDEHIBOFFEMERETHZENTEET,

& Test Object Method Argument E

[

Iv|

F = 0| B[ =4

[Test Object Method Argument] %4 71727 « R 7 A%, WOBEARH Y £,

*Fvay

i

Name

UFT GUI O7 A h TCERIND 5 B4, 5IBOLFNIIE, &
DX RAEEANTITHBERD DDA D4R AT T
L&V, BIEOARNIITERTORMEHTE T, 514 0K
PIOLFIIMN TR LFICT DISLERH Y £9, T2, A=
ROFEFEEDDZ LIXTEERTA

P@#S %N N&*(O)+=[1\{}];":",/<>?
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*Fvay

Bl

Type

UFT TIROWTNDEITD X OITRELET,

> IDTAN ATV b AV REGLT AN AT v
T, ZoO3%icx LT String BB A TR LE T,

» Variant Bl Oz 77 LE7,

[Type] % Variant (ZEFK LA TH, TXTOFHENHA A

Vo RIZXFHELTCESNDIDITTEDY FHA, T2, T2

b A7y TEEET DHE, SIBITEICCTS L LTRSS H

3 N

SIS AERRRAREO Y A N EERT H5EE, Tl

TREXTOLERDHYVET, TAL AT V=7 FNEET 7 A

VT, EDO Y A NEEFRL, 510X 1 7% ListOfValues (24

LT,

FEAIZ DWW TIE, TUFT Test Object Schema ~/L 7)) ([Java Add-in
Extensibility SDK ~/L 7] THEHAEE) 22 L T EE0,

Mandatory argument

UFT T7 A F DL & 5 B DEDIEE 2 WR S 20 L 5 hradk
ELET,

SO AT, BHBIEORIZAT v a B ERT D LI
TEEEA,

Default value

BN AT a v DBE, ENOENRERINTVRWVWEAIC
UFT T I IR EMAIRET 52 LN TEET,

ZOF T a0, UEBETIHEATEEEA,

[Custom Control Recording Support] Ei#

FEISWT R—=ZADH AL L+ 7 T AT DY R— b - 7T ZA%AEpT %58, [Custom
Control Recording Support] [Eifi % X F£H A,

HAL L s ay b=V ETREEYR— M 5120%, PR—F 7 T2 TREE ~Y
AT DARX DY A FHEIETHINERH ) 7,

[ Custom Control Recording Support] E[iEZ(, JEEAICER LIz R — K- 7T 22k -
THEREINDANRV N NV KT - XAV RRRREINET,
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[Custom Control Recording Support] Hiifi Tid, ROBEEITO 2N TEET,

> HTLWVBRE CHREL A — =T 1 FT5 4V v FOZEIR

> FEETLH LA b - U 2T OB

> BB DA T v g L ORE

ZOBEETHET MR ED L IICEEINDINICONTUL, 142 X—Y [y F—F
WX THR=b « 77 RTBMESNDREFICZONT] 2L TIEEN,
FLERICBIE T 2R — MERORENET L2 b, ROBIEEZITVET,

> HLWT AR - ATVl e JTRAEANARAF L avba—llvy B 7 Lz
&1%, [Next] #2 VU v 2 LT [New Test Object Class Details] [ (144 2—3 %%
M) IR E T,

> Fh LS D54A1X, [Finish] 22 U > 2 LT [Custom Control Support Class Summary ]
W (1465— 22 M) ([CERET,

& Mew UFT Custom Support Class

Custom Control Recording Support
Determine the set of events that trigger recording. F?

DgfocusGained (FocusEvent argl)
Dgfocusmst (FocusEvent argl)
DEk&yPressed (KeyEwvent argd)
ngeype\eased (KeyEwvent argl)
DEkeyTyped (KeyEvent argl)
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R=R -HR=—F - HSAHLBEINBZIAYYF

A OFPEIE, _X—=R « PR—F « 7 TR Lo TEEINDEZARX e NV KT -

Ay RRFRRENET, A= R_—=F 4 FTEA Yy NE®RTHZENTEET,

FAR ATz b= YSRITHEZEBMDAY Y K

FRIOFRFETIE, FTLOWYR—F - 75 RGENTAY A FE2EELET, BIRLE

BV ATNL, FEETEAHAARU N AV RT AV FDOEY hEFGATHET,

YR MZYRFEBNTBICIE ROFIEERTLET,

1 [Add] 227V v 7 L, &b [Listener] XA 707 « Ry 7 ALyl A
FEERLET,

& Listener

HegistratEn metien |_’

ZOU AN, AAZ L ay b=V ETBEETE D) AFRNFRENET, Vg
P—RIL, BDAF L+ T TREZDA—IR=T T AD Y AFHEEA Y v REHFHNT D
ZLIZEST, TOVARAMEERLET, Vo F—RTEEAY v & LTHIISN
% DX, HWIDBI%7 java.util.EventListener % J57E 7% add<XXX>Listener &\ 9
AFIDRA Y ROHTT,

HAB L - JTANZ DERERIRDEEA Y v NEHERTHE, v — &
AL THIETAY AFTE2BMTEZLIFTEETAL, VAPV —FTHLLVIRF L -
PR—b - 7 T ABRERENT-HT, RERYFR— b 2FETHEETLIZLNTE
9,

2 BRIV RFICEBEOREA Y v R H45121%, [Registration method] U =

FiRBAY y a1 O@BRL £,

3 [0K] 227V v 7 LET, BRLIZYRT L, ZIUTEENLTXTOA N b o

YRT e AV RRY R MOBNERET,
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YRS YRS ZEIRTBICIE, ROFIEEETLET,
YAFERFWNTNNDOA RN N RT - XYy RE®RLT, [Removel %7

Vv 7 LET,

Evbk: VA= b7 TRAPMEREINTHR TS, XU b T 2BINT 585461, [Add
Event Handler] "% > %9 575>, Eclipse T [UFT] > [Add Event Handler] %%

RLET,

[Custom Control Recording Support] EIE®OA 73>
[Custom Control Recording Support] B, ROA T a3 »BdH 0 E7,

*Fvay

A

Treat controls of this class as wrapper
controls

FLNWYFR—K 7T RXT
com.mercury.ftjadin.infra.abstr.RecordW
rapper f > ¥ 7 = —RAEFEETDHLIITHREL
ESe

J AL L - 3 hr—/L7 java.awt.container
EPSET DA, ZOF = vV Ry 7 AT
TERShTWET, ThlSofE, 2o
Fzv 7 Ry 7 AIMEATEEEA,
ROV TE, 143 %=V [HR—F 7T
TOT vy =03 Z2ZRLTIES0,

Override low-level mouse event
recording

FLWHAR—bk -7 F2Cnull 28T X9
mouseRecordTarget » ¥ v F&32 L %5,
oA T a rERIRLEZEA, UFT TR
Ve TR e AR (EEEAS—ZDORE) 15
BENARNWED, Ama—OF Ty g VERR Y
D, LOBEHERBER ST DN TEET,
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*Fvay L]
Override low-level keyboard event LW R—hr-7F72Tcnull 24+ Xk 5
recording keyboardRecordTarget # v~ F&F2EL £,

oA Tva v ERIRLEESA, UFT TR LN
Ve F—AR— R« X2 MNIRRER S RN 29,
TF 4y bRy ATOEORERED, LV
BHETRA XV N ERERT D ENTEET,

FRoOFROFT v a i, v — R TOMEATEET (ERBEICTR—F -7 T2
ZHmEET 272D Eclipse ® UFT 2~ RCIIEHTE ERA), ¥R — b - 7 T RA%(E
KT DB ZN G DA T v a VERIRET, B0 INbEEETDHILENRD LHEIT
%, FEITHREZITOLELH Y £7°,

VAP —FIZE2>THR—F - VS RITEBMELEIARIZONT
W DK TIL, [Custom Control Recording Support] Hjii CTOFENFIZEWNT, KR —
ke 7 Z2TEMESNDAY v FIZOWTEH LET,

YR—bF - VSXATOYRTDORE
VA= FTHERENLIIR—b 7T T7AVTE, FBELL) AT LA T Vs
B, RO K ITHEESET,

> BEEINZVRTFTOAL L H T 2—ARNYR—bF « 7T 2AOEBLHITEMENET,

> AVANTIERFR— K - 7 TRTEMEN, DAX L a3 ha—)L ETEGEN
MR RTOY AFNFNESNET, £72, VA TOBEMEHIBRICHERT LAY v
RLFEINET, 207D, %Y A FI2% LT addSimpleListener 23O X 1
7,

> AV R ZZ TNERORRETERIRLEZEA R RNV RT 2y ROV FR—
f s 7T RZEBMENET, ZORAY Yy R+ AZT|E, X—R + PR —F -7 FAD
KIETDAR N e NV RT AV REMRHLEST, IAXL - br—LO
== RZADET, HILWAXR N e NV RT e XYy RERETAZENTEET,


JavaExtAPIRef.chm::/com/mercury/ftjadin/infra/abstr/ObjectCS.html#addSimpleListener (java.lang.String, java.lang.String, java.lang.String)
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—HEBDOA N N RT e A Yy N, BEFEOY A=+ 7T ANT final A Y v R
ELTHEEINET, final A Yy NZA—"—F 4 RTHZLNTEETA, EAOD
KPFRETINOLDAY vy FROWTUNERIRT D L, fFSNLDAY v R« AZTD
Ay REDORIEICT v F—A2AaT7REMEhET, 7z & 2%, focusGained,
focusLost, keyTyped, keyPressed, I 7-(3 keyReleased % i®&{R7J 5% &, %
i, _focusGained, _focusLost, _keyTyped, _keyPressed, ¥ 7-/3 _keyReleased
DYER SN ET, 4~ D final 2V v RiE, ZNENOIEARIILEEED EITHIC _< A
VY F&> 2O T X9 ICFEEENET, 207D, <AVY RE> AV vy Rat—
NR=TFA RTHEL, TNHODfinal AV v RICHEREEZBMTLZENTEET,

> AV R« 22 TREMOFRTICERINDEARX R NV RTOYR—F - 7
T A ZBIMEET, MicAPLrecord ZIFONHH T L OICA XU K« N RT « AV
RERETANENRH D FT (KA v K AXTIZE, FERLETHDZ L &R
FTary e, RSN A Yy FOERBEERGENTOET) , sEIZ OV T,
68 X— @A 7Y a0V R—F 2BRL TS0,

YR— bk - HSATDS v/ \—DEE
avFFe-aryrog—LHNOaryhe— L 2w L—F L THEH—~Oa fa—Lt LT
wKTarrF-arhe— LoV R— NEEKRT 5841, [Treat controls of this class

as wrappercontrols] Fx v 7 - Ry 7 AZBRIRLET, ZOF v 7 - Ry 7 A%HE
WEDL, $R—F 7T RZROAY v RRBMENET,

> blockWrappedObjectRecord (False #iX L $£7,)

> registerWrapperinspector (Z D7 7 AEHRFED T ha—)v « AT DT vy/3—&
LCBERT 2ITIE, ZOAYy FEFETOIRLENRDH D I Lamdaiy MBS
nET,)

» checkWrappedObject (null ZiX L £7,)
> wrapperRecordMessage (M A%1795 Z &72<, Ty E&Nlar ba—nitL-»T
EE SN A v E—VERIRLET,)

INBDORAY y RERETDE, RERT vV IEREEFEBRAT L ENTEET, &
HZHOWTIE, 71— TS5 9 R—car he—LOHdR—h ZHRLTLEEIN,
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[New Test Object Class Details] EIME

HLWT AR ATV b VTRAENRAL L a2y hr— LI~y BT L2 E
I%, [New Test Object Class Details] BF CTH LWT Ak« A7 =7 b+ 7 FRAZHTDH
A ERLET,

[Finish] #27 Y v 79 % &, [Custom Control Support Class Summary] Hif (146 ~—3
L) BEEET,

& Mew UFT Custom Support Class

New Test Object Class Details
Spedfy the details for the new test object dass Allights.

[m} g]aﬂadﬂed_hext
O £ backaround
[m} @dass _path
[m} g]displayable
O £ displayed
@enab\ed
O £ focusable
) focused
[m} @ﬂ:reground
O &Y handie

O & height

[m]
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[New Test Object Class Details] BF 21X, ROF T a o BdH £7,

*Fvay E%BA

Test object icon ZOTAN ATV bV TADF—T— K+ Ea—T
HRTET7AaL « T ANDNRATT, 74 av - T74
JXIRIERMGE D LiCO TER TR TR £H A,

ZIUFAMARETT, T A3y « 77 A NVEER LRWVES
%, JavaObject D7 A 2 BMEM SN FET,

Identification property for (toolkit_class 7' = /X7 ¢ & index 7' 1 /N7 (12N % C)
unique description UFT Tayv b — L& —BICHRRT 272007 v 8
TAREELET,

VA NPT m T ¢ 2 BINT 50, R E CRIS
N7 nRT 1 2 ETOEEHHLET,

Default test object method DI TADF TV 2l MITHTBAT v IR ER SR
LT, F—U—R P a—tRxATv 7« V2R —HFITE
TRENDIEHEDT A« FT V=l b« AV y REHEEL
E3x

VARNST AR ATz b Ay FERRLET,

Default checkpoint properties | =D/ S 2D ATV =7 MIKTEF = v VR A 2 NEAE
BT DRI, EECEBREINIRE T e T s ZHBELET,
METHTRT A OTF =y r - Ry 7 AZRRLET, T
RCOF v « Ry 7 A BREZILRINERT 2855
1%, [SelectAll] 721 [ClearAll] 27V v 7 L%,

VAP =T, LY R—= R 7 T Z2ERT DS, LT AN ATV
Fe BATWT AR < ATV 27 NREZ 7 A /VITBIMEVET, [New Test Object Class
Details] Biifi CIRET 247 v a 1L, ZO7 7 A VAICRESNLET, ZOT7 7 A LD
38122\ TIE, [UFT Test Object Schema ~/L =7’ ]] ([Java Add-in Extensibility SDK /L 7"]
THIBHHE) 2L T 7EZE W,

UFT CT A b A7 V=7 Pl T v T 4 BN 25681, TA M4 7 V=
JMNRETZ7ANVTINETHTHRETLAIVENOYVET, TAL AT V=T b7
TADERIIT AN ATVl MREZ 7 AMIEBMENET, TA L - ATV
RSB T 27 a7 0 Z8iL, TO7a 7 1B LRI L7 7 A4 VNDTT
ZHrE L¥9, Property & Name D)2, ForDescription="true" %8 L £,
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FAR ATV FRENORE ST DY A NME, (A7 V=2 FORRE] A
TRy Ry 7 AR LTCUFT CERTAZENTEET, 207D, EHERETIX
UFT Ca—¥PMTHIEFNFE FEX LWL 9IS, UFTIET A b - ﬁ7y:&%&ﬁ
TrANNL—ERET ZoOEREHAIY £, UFT T ForDescription JEEIZ%f L T1T
I EE A MEFITGTAE D TFIEIZONWTIL, 85— [T A ATV "RET7 74
JVTHRE ENTCRBR T 0 T ¢ BIEOEE | 2R TLIZE,

[Custom Control Support Class Summary] &

HAZ L R—F7 T A7 7 A NVHPHERE AL S HIIZ, [Custom Support Class Summary]
EEICH LW AR — R - 7 7 AR ELENEO~ I BRRRSINET,

& Mew UFT Custom Support Class

Custom Support Class Summary
Review and confirm the structure of the cusktom support dlass, E?

General

Cuzstom class: com.demo ImageButton

Support class: mageButtonCs

Baze support class: commercury fiiadin gtsupport awt cs CanvasCs

Test Object Identification Properties to Override
label

Additional Test Object Identification Properties to Implement
Test Object Methods to Override

Additional Test Object Methods to Implement
Click (Ohject obj, String button)

Event Handler Methods to Override

Additional Event Handler Methods to Implement
java awt event ActionListener

EENMEIRT =208 DBAE1E, [Cancell 227V v 7 LTU 4 ¥ — RORIOBEEIZR
D E+, [Back] "% & [Next] R¥ &M LT, BETHWMmERHE, LERZE
FEITVET,
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SET LD, [OK] 227 0y LET, BEARICHKEST, RERTXTOAY v R
EOH LN A= - 7 7 2AREREINET,

F72, WOWTINOOFMEZMI-TIHAINEL, TAF AT V2T b« 7T ADTEEN
TAN F T b E774W_EMéhi?

> HLWT A e F T2y bV TRENAZ L O ba— Ll vy B 7 LEEEE,

> FEDT AR - ATVl b VTR T e RXT 4RT AN ATV b A
Vv R&EBILEZEA,

FTAN ATV FERET T ANABEELRVERIE, ZOMRRTT AR - 47
Vxl MRET T ANPMERINET, TARN AT V=Y MRET 7 A VOB
WU, TUFT Test Object Schema ~/L 7] ([Java Add-in Extensibility SDK ~/v "] TH|H
HRE) ML TSN,

ARBL -V S5R - HR— DT
(New UFT Custom Support Class ¥ 4 ' — R&FEHLT) BAZ L HFFKR—F 7 T72AD
TEREASSET LT s, OBMFIREZ ETT20ERH Y 7,

> VT AERFELET,

Eclipse Tld, HROFERKEDZ TITH LW TR « 77 A ABHOTERRENET,
I IGAERPELTNRNE, BR—K 75« T7 A NELDOFEDZ TNZT AZ Y
7 (*) DEREINET, V4P — R TITONIETIIHEIETT 5720, HTE8FT
ERFELTA—ERNEL 2N LS ICTAHERHY £1°,
> VAP =R THLOHI AL L - FR—=b « 7 FANIER SN AY v R« AX T %
ELUFET, FMICONWTIE, 43— [V—Fy b BB =K« 75220
R T EEN,
TARN ATV b e JTAZHLWT AL ATV b Ay RROEH T 0

RTF4BBMLESRE, AL 7027 bRETFANNDT AL « A7)
ke 7 TADERICINLRBNSINET,
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W4% CEoTHAR—b « 7T ANIERENTZ AR — b - AV > REHIBRT S
L (% Liﬁb\&), TARN ATV T b AV ROBHTaXT BT A - F
TV N VTADERICEENT-FTFICRVET, ZhblE, TAMNEHET D
BRICUFT AT LI TEETA, 2OHAZ L7 FTATIIHR—FENEE A,

> FAR— MBERAAEEIC D XD, Y—Fy b - FHR—FE UFT 1277821 LZE
T, FEICOWTIE, 18—V [ RFL Y —NFy b« BR—FDFF A LFE
171 ZZRRLTZS 0,

New UFT Custom Static-Text Support Class 7 1 #— K

148

Java Add-in Extensibility 7’2 V= 7 NNTHAX LFHTFA N « 7 FZADYR—K - 7
F A& ERRT 2841, New UFT Custom Static-Text Support Class &7 « ' — R & L £
T, BT X AR - 77 A&V AR—bF 5L, UFT TZO label 7' 1 /37 ¢ Z BT 5
a he— VOB TFRA ML LTHERTLIZENTEET,

O A —FTHRETDIVLERLDLDIL, T IFAN 772 LTHR—FT5
HAZ L7 TAEFTT 4T 2585613, [Controls of this class represent top-
level objects] ZBEIRTHLMLERH Y £9), OV 4 F— KTIHE, H#HTFA L - F7
Tl FOVR— MIRFERA Yy REFHLT, HrILWR—k - 77 ABRERIN
FT, INHDOAY v RIZOWTIE, 151 “X— T [Custom Static-Text Support Class
Summary] B ZZRLTI7ZI0,

LW R—h « 7 I 2ARERENTZD, 152 —Y (D RZ LT FAR « 7T AD
PR— FOFERK] OFNEICHE - THERELZFZER L ET,

FEALDEE, BT XA ay ba—/ LIk L CGEINORH T 0 3F 0T A | -
ATVl b Ay REVR= I TDIMEEHY FHA, 2720, VP —FTHL
WHR— bk « 7T RABER LRI, 7T RCAY v REBIMLT, BINO§E#E7 73
TART AN ATVl b AV R, EREREHOYFR— N ERMET L2 LA
RETY, ZNHDRA Yy NiE, FEITEMT S0, £720F 153 ~— [Eclipse TP UFT
g RO ICEHEsnN TS o~y REFHLTEBNT S 2 ENTEX E4,
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Eclipse T New UFT Custom Static-Text Support Class ™ 4 ¥*— FZE&8 ¥ 521X, &
DFIRERITLET,

1 [Eclipse Package Explorer] # 7 C, UFT Java Add-in Extensibility 7'/2 = 27 h &38R L
%9, [File] > [New] > [Other] ZEIRL E¥, [New] ¥ AT 7 « Ky 7 A3
PAE £

2 Unified Functional Testing 7 + /L % % & L, UFT Custom Static-Text Support
Class Z# IR L E 7,

3 [Next] #7VY 2 L%9, [Custom Static-Text Class Selection] [H[fi A3 & F9°,

E > b : Eclipse % 71 A % <A XL T UFT Custom Static-Text Support Class % [New]
Ama—DA T alTHe, TOFREZEMRT LI LATEET, ZhaiToIad,
[Window] > [Customize Perspective] Z 3R L £, R-INdX A 70T - Ry
27 2@ [Shortcuts] % 7 ¢, [Unified Functional Testing] & [UFT Custom Static-Text
SupportClass] OF =7 - Ry 7 AE®RLET, [OK] 227V v LET,
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[Custom Static-Text Class Selection] [HH

[Custom Static-Text Class Selection] & ¢ 4 7" = > 1%, [Custom Class Selection] [ [
(117 R_X=V % B o4 7 vz LELTT, [Finish] 2279V v 273 2% &, [Custom
Static-Text Support Class Summary] [ (1512— Z&/) MRHE £,

& Mew UFT Custom Static-Text Support Class

Custom Static-Text Class Selection

Select the custom class wou want QuickTest ko recognize as a Java Static-Text lz-T
class, and set the relevant options For the corresponding suppart class.,

El H} com,dermao B java.lang. Ohject
m ImageContral Bl java, awt, Component

ImageLabel B java.awt. Carvas

I 1 com.sample E--cnm.demn.ImageControl

L can. derno, Imagel abel

= Eontrals
|

UFT CEIT XA M LRSS EA I AZ L « 7T RAEFRIRLC, BH#ETI S a %
HELET,

BFET A L s v be— 2, @, UFT GUL 0T A MIBEHET 53887 087 ¢
RTFAN F TV b Ay RIS ERA, FORED, 2O 4 F— FTEMD
BEEITHOMETH Y FHA,
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[Custom Static-Text Support Class Summary] [EfH

HAB L e FR—b « 7T T 7 A PHER I DHENZ, [Custom Static-Text Support
Class Summary] BEEIZH LWV AR— bk « 7 7 R L TRE LZAFOY < U BRERR S
WET,

& New UFT Custom Static-Text Support Class

Custom Static-Text Support Class Summary
Review and confirm the struckure of the custom support class, ’g‘?

General

Cuztom class: com.demao ImageLabel

Support class: Inagelabells

Baze support class: commercury fisdin.gtsupport awt cs CanvasCs

EENNELRT =201 HHEE1%, [Cancel]l 27V v 7 LT LEF® [Custom Static-Text
Class Selection] HE[HIZRE YD £,

FETLEG, OK] 227 Vv 27 LET, 2O 4P —FRKTIE, BT A7
I ROV R— MIBBERROAY v REMHEHALT, FriLWIHR—F « 7 7 ARER S
7,

> class_attr : 3055 static_text iR L EJ, UFT T, ZDJ FADAT V= M &
M7 XA N3 ha— b LTRERT D Z ENAERICR Y £7°,

> label_attr : A—/X—27 Z 2D label 71 /37 ¢ ZiK L E T,

Java = f o —/L® label 7135 ¢ NZEDBREA, UFT IZBEETIHT 2 - =
Yhe—EBLT, TDlabel 7u T 4 T AN ATV NAITHEHALET,
O, WHRLE GHOTFA b s ar bu—Ll Lo TERENDLFHR L)
ZIRT LI label_attr X ¥ v REFEEFT L LN TEET,
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> tag_attr : (label 7' X7 fHZIKT) A== FAD tag THAT YT 1 v
7 A (st) AT T LET, label_attr X Y v RiZH#EdT 520 ba—LCHEMATS
AR LETN, 20X Yy REIBHNT XA - ar be—ALZEOHLODT A b -
FTTV=l NEEREELET,

7= & 21X, label_attr X ¥ > K% 324 1 C MyButton %9354, tag_attr X ¥ » N
MyButton(st) z & L %3,

FERICONTIE, 64 =Y [—fRIRERHE T m T ¢ « FAR—F - AV v ] 22
LTLIEEW,

> value_attr : label 7 o /%7 ¢ #IE L £,

value 737 (1%, 2 b — DT AL« F 7V bORIEEZELET, 1Y
THRRA L3y ba—LOEAL, label 73T 4 N OREEZFK L ET,

HAE LHHTF AL« ar be—LOYR— FOERIE, Fa—F) 70211 2—
CIHRAZLET XA s ay ha— L0V R— N FEOFEE | CHEST LI LRT
TE9,

AR LBHTHXR b - V5 RADYR— FDOER

(New UFT Custom Static-Text Support Class 7 « ' — K& H L T) H A ¥ LAFEHT $ A
ke 72T DAL L s FR= |k« 7T ZAOERDBET LTeb, ROBIMFIEZE
FITTHOLENRDH Y 3,

> 7T AERFELET,

Eclipse TlX, FRIOERBEOZ TIZH LW TA « 77 A ARV TERREINET,
I IZAERFELTWRNE, PR—F 7 TR« T7 A VLDRBEDE TIZT AH Y R
7 (*) DERINET, VP — RTITONIETIIHAEIEKGTT 5720, T8
ERELTA—ERELRNLIICTHHERDH Y 77,

> VEIZGUTC, label_attr X Y v R&32E L £9,

> FR— FBMERABEICARA LI, Y—AFy h R —F % UFT 25721 LE
T, FECOWTIE, 18— [HRZ L V—AFy b FR—= DT T L%
71 #BRLTLIEEN,
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Eclipse T?D UFT a< Y FOEH

Java Add-in Extensibility Eclipse 77 7 1 % 1 ¢¢ UFT Java Add-in Extensibility SDK % A
VARN=ATDHE, RORF L EAEZ T2V — /3= Eclipse \ZIBII XL E T,

7 b=t - i b=t -

E V=¥ vy ko PR— O s PR T v T 4 OB

J F7uaA =
= PR— FREOTHr— K = FAR ATV he Ay
& =l NGBV

HAH L HiR— SO AR b Ny KT8

Fm, NGB ERLa~y REETH LW UFT A == — Eclipse IZBMENET, =
NoHDa~y FZHONTE, KOFHETHLIGHLET,

Deploy Toolkit Support

Deploy Toolkit Support =~ > K%, [Eclipse Package Explorer] % 7 C UFT Java Add-in
Extensibility 70 =7 b (F720%, TOFOER) RN L7 L EITHEHTEET,

3 : UFT & Java Add-in & A > 2 b— L 5 #ilZ UFT Java Add-in Extensibility SDK % A >~
A N =V L7234, Deploy Toolkit Support =~ NI T& 8 A, Z DOREZF
9% 121X, UFT Java Add-in Extensibility SDK % 7 A > A h— /L L T L FHEA A
M= LET, FEMIZDWTIE, 27 ~X— < THP UFT Java Add-in Extensibility Software
Development Kit DA A b—/ | ZZHL T EE0,

Deploy Toolkit Support =~ Fi%, BAREECTY—LFxy N« YR — &7 7n A7
DHEBIMHERLET, Zoa~r REEHT 2I21E, UFT & UFT Java Add-in Extensibility
Eclipse 77 7 A U NEIL 2 Ea—& EIZA VA =L EINTHDIRLERH Y £,
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Zoawr RE, YA Xy NRET 7 ANET AN ATV NRET 74 /L% UFT
DR 7 A NFICat—LET, ZOV—1LFy NRET7ANT, a4 L7
PAR— b - 7T RZX LTHE S LD 5T Eclipse V— 2 AX—ZT9, K[\l Java 77
Vor—aruF T L &I ER LY R — %2 UFT ECERT A Z LN TE £,
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MEEA TN, BANEMFITEE L TWAERICOHRRET 7 ANNT T oA SNET
(BEfRICH# A L RoR S g T%,T7ﬁ4¢éi9;? LicHEiETr 7 aA
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Add-in Extensibility SDK ~/L 7] THIHFIEE) #SH L T 7Z &0,

YRy MRET 7 A ML, RDOT 7 A ATk L TRRESILE T,
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» [Custom Class Selection] H[[f (117 X—T % BH) OH AL L Y —)LFy kY —
WCFRRENDHAZL 7 TFTADY X b,

» [Custom Class Selection] i (117 X—T%2&M) O 4 P — RIZLDHX—R « iR—
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7] TRHIHTEE) 2SR TIEE N,
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Eclipse @ UFT Y —/L 3—T [Add Test Object Method] "% > %27V v/ LE7,
[Test Object Method] # A 7B « Ry 7 ANERINET,

BMTETARN ATV k- 2y ROFEMEERLT, [OK] 27V v 7 LE
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FHLWT AL ATV b Ay RFYR—F - 7 T RBMENDETTRL
HR—FENTVAEIL PE— I BT EINFETARN ATl ke 7 TR
DERIZCHBEMINDE Z L ERTHRR Y 7 ARERINET . ZOT A M FT V=
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Add Event Handler

Add Event Handler ==~ >~ K%, [Eclipse Package Explorer] % 7 C AWT ~X— X ® UFT
Java Add-in Extensibility 7 A% A « R —h « 7 TG RAEBRR L2 & S ITHEHTEET,
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» Treat controls of this class as wrapper controls

» Override low-level mouse event recording

» Override low-level keyboard event recording

PR— b« 7 TADERFFC N EZBIRL 2o 1256, ZThbaRET DI, F
TRELATIOLERDH Y £7T, ThETIFIHICOWTL, 68— IREkA T 3
YOYR—F] EBRLTIZS N,

ARVE NV FZ - AYy FEEMTBIZE, ROFIEEETLET .

1 Eclipse ® UFT ¥ —/L 3—"C [Add Event Handler] "% > % 7 Y > 7 L ¥, [Listener]
AT T « Ry 7 ARHEET,
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2 VAMPBY AT RBEINLET,

BIR U7 U R FICEEOBREA Y > R3d 5845121%, [Registration method] U %
FpoAY Yy RE 1 OIRLET,
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BN L 7= U 2 FI2%F L T addSimpleListener Z /P UM 472, a2 A NTF 7 Z 34
A=k 7 ZRCBMENET (TTICHFETIHEITETINET), Z4uc kv,
HAZ L e Ay ha—/b ETRENPLER Y AT Y A FRBEMEh, Bk X
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Z DLy A TiX, UFT Java Add-in Extensibility Eclipse 77 74 > CTigflt sz 2 o0
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MRFEEIN TV N a B a—XIL, UTFTEA VA MV LTEBISERHY £, T
R— IR TTIZEHEENTOWAEAIE, 78— [HRAZL Y —LFy bk« FR— |
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HAH e a2y ha— U5 UFT iR — F 23RS 2E0S, DLTOMEZHRELTE
SWERHY FT,

> L ha— LT A TIAT IV EANARETH D Z L 2R LET,
> 2L ha—/LOBEHEL T A ML EREEEEZER L £,
» 2 b= LVEFRRLCEET D007 ) r—var2HlELET,

> I N —NEEEFTAISRACT IV BATEXAZILEHERLET (I AF LY R—
FOVERBHCH A Z L e o ha—)b « JTAEEETHZ LEHY AN, o
NAN LT F2AEBRLT, Y=+ Z7ANADNLEREGTE A EREEHALET),

WO TFNE%EFEIT L C, ImageControls 7 AKX I+ YV —)L& v bk « 7T A% & Eclipse 7' 12
Ve b, AAZLavbu—LEGhY T T T = a CERERLET,

FooVb e 7Y r— 3 i, %o <UFT Java Add-in Extensibility SDK
A4 VR b—J)L>\samples 7 4+ /L X0 BEITTH L IR SN TWET, SDK %30
FHIA VA =L T BEE81E, ZOLy AL ZBOLENCY T T T r—g 0
ZETEFETHISLEND D 9, FMTOWNWTIE, 172 3= [BIOBRFHN ST+ 5 &
WY TN e T TV = a B ERTSH) 2L TIIEEN,

Eclipse T ImageControls 4> F)LEERALTHF LN Java TR =) FEERT SIS
¥, ROFIEERITLET,

1 Eclipse #317L, [File] > [New] > [Project] %R L £7, [New Project] &1
TRy Ry I ANREEET,

2 [Java Project] %R L, [Next] %7 VU v 2 LE¥7, [New Java Project] ¥4 7 1
7Ry 7 AREEET,

3 [Project name] 7~ 2 A(Z ImageControls & AJJ L E,
4 [Create project from existing source] 47> =3 VR LT,

5 [Browse] "¥ > %7V v 7 LT, <UFT Java Add-in Extensibility SDK 4 >~ X k—
JU = 71 L5 >\samples\imageControls\src 7 + /L ¥ &L £9, [OK] 227V v
27 LT, [NewlJavaProject] A 7107 « Ry 7 AR £7°,
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6 [Finish] #27 U v 2 L%, ImageControls D> 7/« V) —R « 77 A VEMBHLT,
LD Java 7 v ¥ = 7 FHBMERR X4 E T, [Package Explorer] % 7’12, ImageControls
EWIREIOFR T v s FRERRENET,

£ : Belipse TH LW r Y =7 NEERT 2 FIEIL, AT 5 Eclipse D/3—Y 3 I
FoTHRRZZENRHY ET,

ImageControls 7' ¥ = 7 M &R L THWE % £~ L £7, ImageControls\src /~
= T AEITIE, RO 2ODNRy r—VRNEENTOET,

» com.sample /Xy 7 —ZiE, Yo7 T U r— 3 (SampleApp) ME Eh
TWET,

» com.demo /N> 7 — 2, 3 ODH AL A - a2 hr—/L (ImageButton,
ImageControl, ImageLabel) 3 &E T ET,

wDOEKIE, com.demo /Xy r—IND 7 T ADHRAREE 2K L TV ET,

java. awt Canvas

F

com.demolmageControl

¥ )
| |

com.demo ImageButton com. demo lmagelabel
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Oy —=VAD Y T ATREES N DHEEEIL, ROLBY TT,

> ImageControl : Z» 2 7 XX Canvas 7 7 A& fLiEL, 2> hr—/L LICEB %R
LET,

> ImageLabel : = ® 7 Z 2|3 ImageControl 7 7 A ZJLiEL, 2> hr—/LIZEKR I
LEBEOEICT XA N EFRLET,

» ImageButton : = ® 2~ 7 Z|% ImageControl 7 7 A% ¥LEL, = hr—/LDJH D IZ
REROEFHEHE LET, 207 TR Far he— L EOKRL~L - X2 |k
VO RLT, REUNIZ U w7 &N &I Action A X h&2 R U AT LET,

ADBRDORFTTEILIICH LTIV -FTIVr—S a3V EEETH
UFT Java Add-in Extensibility SDK 7% C:/Program Files/HP/Unified Functional Testing
LSO T H N FNZA VA F—= L SN TW DAL, 2OV v A &R0 DN 7L -
TV = a v B ERETOMNERSY T,

YOI -FIUr—2a 2 EBTBIZE, ROFIEERTLET,

1 ImageControls ¥ —A = 7 7 A /L% Eclipse (22— L721% T, Eclipse Ty o7 —
ImageControls\src\com.sample =% L T, SampleApp.java 7 7 A V& B & £,

2 ROWEBE T 7 A NVDORAEEea— REELET,

C:/Program Files/HP/Unified Functional Testing/samples/ImageControls/images/
mercury.gif

C:/Program Files/HP/Unified Functional Testing/samples/ImageControls/images/
JavaExt1.gif

3 Zhno/ AP C:/Program Files/HP/Unified Functional Testing ZEERD 1 A h—
o TANFICEBEHRZT, Yo T T FY r—va URIELEET 5L 91CL
\ij—o
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ImageButton 3 > F O—)LDYHR— FDEE

Z ZClE, ImageButton =¥ k@ —/LOHIED UFT A — b &5 L, 95— [H R
B TR HR—=DFEHEOFzy 7 URRMIONT] OEMIZEZXT, 177 X—Y
(AL 7 TR YR—=FFHEOF =y 7Y R IZRALET,

ZOEOITIE, DAZL-ary b a—LVEGLRT T r—ya EETL, ATV
ke A, F—=U—FK:Ea—, ekt 7> a2 H L TUFT OBLENS ST 21T
D DA TI,

1 SampleApp 7 75— a v ERITLT, UFT ZBZEE7,

a [Eclipse Package Explorer] %7 C, SampleApp #47 V v 7 L¥7., [RunAs]
> [Java Application] Z3&{R L E9, SampleApp 7 7'V 7 — a A& £,

=T

GlickTest Java

MERCURY' (=

b UFT #BVC, JavaAdd-in #2— F L £,

2 FTVxH k- RIAL EHEAL T ImageButton D F0/8F7 4 ERRKLET,

a UFT T, GUI TR FA2BIE, [W—I] > [FTVxH kb RiA] 2RI D0
[ATSTH P RIL] VR~  RE L E I Y I LT, [T V=7 kA
A1 FAaT7al Ry 2&M&E+, [FankF«] 472270 v7 LET,

|oh

b (#7027 24] FA4T70 7 Ry IAT, f§ELTA20%7 )7 1LT
/6, SampleApp 7V r—>a VINORLZ %27 U v LET,
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ImageButton = > k B — Ui, UFT CTRESNRWA AL L« 7 T R ZHEHESNTWH
9, "% 13 ImageButton &\ 5 A ETOIH D JavaObject & L CiEik s 5
7280, FRINDT A 2 IEAED JavaObject 7 7 ADT A 22720 £,

2 Object Spy @
(& | E

Ohiject hierarchy:
iEI---E JavaWindow : Sampledpp -
& JavaObject : JRootPare [
& Javalbject : JLaperedFane
=& JavaDbject : JPanel

Propesties | Dperations]

) Mative @ |dentification

Properties Yalues -
T Class Name Javalbject &
abs 104
abz_y 28
attached text
background cEEEEE
clagz description object
clagz_path com.demo. mageButton;co
T developer name

[k [a [aE [al [ak [a ke [a k- fa)
AT AT e

-

Selection;
Clazs Name

Descrphion:
Degcriptions are available only for test object operations.

Lloze

C TV AL EHALFET,
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3 ImageButton O > FO— /L CREZEELET,

a UFT T, [fB8R] > [FEREBTRERE] A8V LT, (kL FITHRERE] &
AT7as Ry 2M&EET, Uaval ¥ 7T, [BALTWDTRTD Java7 S
Jy—a Vv TTRMERBLTEITTS] 2R LET, Web 7 RA v br—
rFENDEHEIE, (Web]l #7 %2710 w27 LT [AWVTWRTRTOISHYFTT
A MERFELTRITTS] 28R LET, [OK] 27V v 7 LET,

b [fB&R] X% %220 >y735h, [BB&R] > (BB BN L E9, SampleApp 7
TV =2 arORE L E IV LET, =T 4y MRy 7 ADOH U ZER
1o ET,

HLWAT v T 2 MoBaimanEd,

Item Operation |Yalue Documentation
v & Actionl

~ Sampleapp

&y ImageButton Click — 30,26,"LEFT" Click the "ImageButton” ohject with the "LEFT" m

¢ [B] Az 22V vr4%70, (BB > UBLL] 2@RL ikt yva vz
HTLES,

ImageButton & V9 JavaObject Trigk S5 Click #EIZLH 2 U » 7 T, fKL~ULEd
FROFEMERTBIEREFF> TVET EEL yBEBL ORI Y v 7 23T LTI~y
A e WL ),

4 ImageButton I FA—ILABBTBHRAL - Y—ILF vy FERELET,

2 b= 5 UFT YR — b 24RRT 25613, 7Y -y boar7F
A RNTITWET, ZOF 22— Y 7T, FUEH (java.awt.Canvas) %> 3
DY T A% FE L DT, ImageControls & VWD) HAF LY —LFy NEFRELET
(ImageButton, ImageLabel, Z#L 5 MDA —/3—72 F Z D ImageControl) ,

Z DLy A TlE, ImageControls Y —/LF% v hOWR— b EEKR L ET, X
ImageButton 7 7 A D H% B R— b LET,
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5 WAL VSR -YR— I HEDFz I YR FEERSEET,

Z ZClE, UFT T ImageButton Z§fk7e R # & LT, FEITSNHBEL YR —
FBAMERHY £T, TDD, ZDa b —/Ll%d 5 Extensibility ik — k%
ERk L ET,

H AL L - 7T A ImageButton (IR D A X L« 75 AT % ImageControl & L3R L F
T, ZHUZX LTS, UFT IEHA— FZRME L TWERF A, ZORiR T, ImageButton
7% ImageControl Z L3R 3 B I1I0D Y T A L B/ T 5585172 UFT AR — h &L 8 L5
DIEENTFAET D LI IR A FR A, TD=®, ImageButton 7 7 A ZE#EH R — k
EYLRT T+ T,

ImageButton 7 7 ANFERIZH R — F &4 5 &, UFT iL ImageButton = > b o — /L%
JavaButton 7 A h « A7 V=7 FE LTHBLET, ZOZATDary ha—LiER
9 JavaButton 7 A k + A7 V=7 MIX, a2 ho— )L TERENDIEET 7 A4 LD
LHNCEC AR ZMIT 20D & LET,

TDOHAR L HR—NE, Y TNRERE L - 7 ) y TEIEOYR—FHED 5D
VENH Y F£9 (UFT TIX, > 7 V7% JavaButton @ Click #{Ei%, 7V v 7 #5147
LIevw R« RE U ERTA T a O ETRY £77), ImageButton 7 A X A+ 7
FRAFEL AL« v TR AR FEY R LT, REUVEMEL BEMEDE A N
v (ZOYATE, Action A XU M) ICEEHXET, FOD, YRV
ST DI, PR — 7 T 2T Action f X2 b EY v AT EMERHY T3,

RON—IIZ EFEDOIFRICIENTHER L2 T =y 7 VX M ERLET,
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ARBL SR - HBR—FEHEDOFZ VI YR F

[ | DREL-HVFR -HR—FHEOFz VI YR F
B | #3545 7 FACUFT DAL b PR— EBREEENTORNA == FARFET 50? DR
B | FET %G, BEAO o=y e — WS SR F AR ~E 2 ? HEGL
B | UFT A v A b —A SN TV a3y Ea—d L THAZ L - 3V bu—L&FTT2T7 7V r—a U3
T D027 (&L
A DAL« ay ha—)b 7T AD Y —ANFEET BB -
ImageControls & V5 Eclipse 7B x4 b+
B | 7255 =20b 0— VAT AEFED JavaT A b « A7 P2 MIEH)?  JavaButton
E TFIELRWIGAIHER T 2 L JavaT A b « A7 V=7 b« 7T 2 :&HHEL
> FHLWT AR AT V=7 b TR LoTHERSND D« (FEHE JavaObject)
> T AL - T ANDEFT (F T a )
> SHHORE T T 1
> BEREDT AR AT V=l b AV R
A | 73452y ba—E by 7Lb e A7 V=7 bip? WWR
B | 7 #4452y ba—id Ty =07 DX
M | AL A 7Y =7 OARIOEEZRIE : TR FTOzH FOEBRT7AILE
[ | P& N 2B 70 T 1 ZHEL, BEREOF =y 7 RA L bOT0NT 4 2~—0F 5
HCiL
B | VA= 9272 - AT7Vx7 b AV y REFPFET D (MEIISTT, ISRV IELRATD)
Click (K% )
B | sz FE— T 5002 (AWT N—=2D7) (L
B | ©o%6, fEE MY TN RS

ActionEvents
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UFT Java Add-in Extensibility 70> =49 ~D#EER

Z 2T, ImageControls V' —/L¥ > b « AR — hDI2dbDOTr v =7 b EFHHITIER L
F9, TNELTHIZIL, Eclipse T UFT Java Add-in Extensibility 7" 7’4 12 L - Tt
ENDZNTNDOY 4 F— FEHHLET,

1 New UFT Java Add-in Extensibility Project ©7 1 *— K£B& %9,

a Eclipse T, [File] > [New] > [Project] Z®iRL £9, [New Project] ZA 7
vz - ARy 7 A& £7, Unified Functional Testing 7 + /L% Z & L, UFT
Java Add-in Extensibility Project 3%k L %9,

& New Project

select a wizard

@ Java Project
B Java Project from Existing Ant Buildfile
- Plug-in Praject
B2 CVS
(= Java
[ Plug-in Develapment
== Unified Functional Testing
i UFT Java Add-in Extensibility Praject
= Simple

b [Next] #7 Y v 27 L%9, [UFT Java Add-in Extensibility Project] M 23BH & £9°,
Z OWEEOFEIE, BT 5 Eclipse D=2 a NI Lo TRARDZZERHD £,
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2 UFT Java Add-in Extensibility 7O x4 FOFHEZEAALET,

a [Project name] 7~ » 7 2|Z, ImageControlsSupport & AJj L &7, [Create separate
folders for sources and class files] &R L EJ (LLATD/S— 3 > D Eclipse
TIX, ZOA 7T a v DEFIE [Create separate source and output folders] &
BRoTWET), ZOXAL TS Ry 7 ADOFEMMTOWTIE, Eclipse D~V 7 %
ZIRLTIIESN,

& New UFT Java Add-in Extensibility Project

UFT Java Add-in Extensibility Project

Create a UFT Java Add-in Extensibility project in the workspace or in an external &
location.

ImageControlsSuppork

b [Next] #7 VU > 27 L£7, [Custom Toolkit Details] BT RIIET,

179



FTE-DUTLGEIY FO-LOYR— FHEDEE

3 WREL-Y—LFy FOFBEANLET,

COWE T, RETEIHAL L Y —Fy b Y HR—b kY FET4PF—FRT
R TE D X 51T, ImageControls Y — L% v OFEMAERELET,

& Mew UFT Java Add-in Extensibility Project

Custom Toolkit Details

Enter the details Far the custom toolkit you wank to suppart.,
The support toolkit and its name are created based on these details,
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a ROWEZERLET,

> [Unique custom toolkit name] R v 7 A2, YR — FOIERIIRDO I A Z A -
V= Fy e —RBICERTARIEANLET, LY — Xy bR — b
7 F AT, ZOLARTDOREIC Support &9 EEEIBN LA EIBNT5 S E
T, —BOY—LXy NMAERETHI LT, 120 UFT TEHDOHIAH A -
V=X vy bR =y NERIFFICHR— N5 ENAREICRD £7°,

YR—=FEERLTCUFTIZT 7uA35E, 7 R R0 R—FEINTWDHER
BOVARNEERTDUFT DT RTCDEAT AT « Ry 7 AIHASA b Y —
¥y NENFIREINET,

ImageControls &2 £4Fii&2 AT LET,

> [Support toolkit description] 7~ » 7 2|2, ImageControls toolkit support & A
jj L/i‘g—o

» [Base toolkit] U 2 hZiE, UFT ¥ AR— BT TIZHEEL TS Y —LF v |
DY A RFRENET, MEBDOY—LFy NHOYR— K 2EHRTE L, =
DY ANMIZEDY—LFy FHbFRENET,

ImageButton 7 A% A« 7 Z AL AWT 2 R —x > MEJRiET 5729, [Base
toolkit] |JEHERED AWT OFFIZLTEBEE9,

> ZDY— Xy hTYR—=FTEIHDAL L - 7T ADEFTEIRTET HLERH
» E£4, #H L\ Java Add-in Extensibility 7 2= 27 AL FEhDE, Zhb
DI TFTANTO Y27 FOEL R - RAZEBMENET, 7T 2D,
Jjar 7 7 A NVERIE T AN VAT ADT ANEEIRETDHIENTEET,
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[Custom toolkit class locations] &%k ¢ [Add project] =7 UV v 7 L T,
ImageControls 7 —/L% v DN A K b2 T A% E T Bclipse D Java 7’1 ¥ =
7 NERIR L £, [Select Project] 4 717 « AR > 7 AN, BIED Eclipse
U= AR—=2ADT 0z "RFRENET,

& Select Project

O= ImageControls

b [ImageControls] ¥~ v 7 - Ry 7 Z&FIRLE7, [OK] 27V v 27 LET,
ImageControls 7' 7 = 7 k%3 [Custom toolkit class locations] 7~ v 7 A |ZiBN
SNET,

¢ [Finish] %27V > 27 L¥3, [Project Summary] [ & £9°,
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4 [Project Summary] EIEZ&RLET,
FuYxs FNOFEMEMRELT [OK] 227V v 27 LET,

& Mew UFT Java Add-in Extensibility Project

Project Summary

Reviews and confirm the project properties,

Project Information

Project name: ImageCantralsSupport

Location: C:/MavaExdensibiltyivorkspace_final

Project JRE Compliance: Default Compiler Compliance (1.4)
Source root folder: src

Clazs roct folder: hin

Toolkit Information

Custom toolkit name: ImageContrals

Suppart toolkit description: ImageControls toolkit suppart.
Base toolkit Mame: 24T

ImageControlsSupport &\ 9 £ HTDHT LV Java Add-in Extensibility 7’7 3= 7 h 23MERRK X
NWET, ZhiiE, BAZ LY —Fy b BR— MIBBERIERNR T 7 A VRE
ESOE
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MLOWARAL - Y—)Lxy k- HR—F £y DT
#7 L\ Java Add-in Extensibility 7' 7 3= 27 KX, [Package Explorer] # 7IZFK RSN ET,

EovBa—% BIZHEEO IRE 31 VA h—L ENTW B AL, ImageControls 7' 1
Y= 7 b & ImageControlsSupport 727 N THRILIJREN—YV a U E2EHTH L 51
LTLZSWn, FAUIREANA—=Ya VEEA L TOWRVWESIE, Ebbhrormny=s b
DIJREAZEELT, WUEA—=Ya &2 FHTHL1CLTIEEN,

ImageControlsSupport 7 2 =7 MR L THRAEEZFRLET,

i Package Explorer X Hierarchy | — <}==f; =5

F-5= ImageControls
E|I;_—‘,Jp ImageCantrolsSuppork

- IRE System Library [2rel.4.2]
- src
E|EE| com.mercury. Frjadin, gtsuppart. imagecaontrals
; Em ImageContralsSupport. java

=RC) ImageCanttolsSuppork

----- @ ImageControlsSupport()

i b {_‘)c ImageControlsSupport]String)
e HH com.mercury. Friadin.qtsupport imagecontrols. cs
gl mic.jar - Cr\Program Files\Mercury Interactivel QuickTest Professionalibintjavalclasses
== Configuration
b= TestOhjects
e E| ImageContrals,xml

src 7 A A2, LLTFORy A —UREaENTWET,
» com.mercury.ftjadin.qtsupport.imagecontrols

IRy =V, HLWY—LFy b PR—F - 7T R
lmageControlsSupport] %/ E&7T 2, LY —AF vy b HFR—F 7T X -
7 74 /L [ImageControlsSupport.java] 3% I TWET,

public class ImageControlsSupport extends AwtSupport {
}
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PR — ~ DIERLRT S D ImageControls Y —/L% v ME AWT Z2IKE L E4, D790,
ImageControls ¥ —/L% > k « Y- — bk « 7 T XX, $AHIAFHD UFT AwtSupport % ik
BLET, 207 TRZE, BNMOFETIVNEDY EHA,

» com.mercury.ftjadin.qtsupport.imagecontrols.cs

TRy —DIFBAELE T, HROH AL L s ay ba—)L s BR— K e 7T %
ERRT2 &, ZORy =TI FEESNET,

Configuration 7 + L Z21%, LFONENFENTHET,

> TestObjects 7 + /L4 :

DT FNEITBRAELETE, V=¥ Yy N THAZ L - oy ba—LE2RKTHLNT
AR F T2 N VT AENERTDE, TAN ATV NRETFANNT
D7 FNVEIERENET, ZHIZHOWVWTIE, oLy 2 TIEHRWEE A,

> V—L¥% v FEIE T 7 A /v : ImageControls.xml

T ANEROCTHNEEZFRLET,

<Controls
class="com.mercury.ftjadin.qtsupport.imagecontrols.ImageControlsSupport"
SupportClasspath="C:\JavaExtensibility\Workspace_final\lmageControlsSupport\
bin"
description="ImageControls toolkit support.">
</Controls>

Z OIS T, XML 7 7 A /ViZiZ, class, SupportClasspath, description & D1 %
HELTY—Axy b HR—h+7 T 2% EZ7 2 Controls THEN 1 >EFFENE T,

ERIOH AL 2 3 b= s FR— | - 7 FREERT DL, TOYFE—k -2
TR TDEN AL L ay ha =Dy BV TNIORET 7 A MBS
gzj_‘o

BUE, YR— b « 7 5 ADBFNT Eclipse V—27 A_X—ARNICH D £4, WAZ LY
R— N OVERERETIX, ZOBHEFERTLOR/E L CWET, FAR— hDEELT
A RBTRTHEALS, Y R—b 275 2% UFT 2 ¥ a—% EOEABZRGATIC MR
FLT, V= Fy bEREZ 7 ANVOMEEEL L T ZIWN, FEMIZONTIE, 78
R=T [HAFL Y= NFy b P R—b-DT A LET) ZBRLTIEZN,
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ZDT 7 A INOEEDFEMI VT, [UFT Java Add-in Extensibility Toolkit
Configuration Schema ~/L' "] ([Java Add-in Extensibility SDK ~/L 7] TH|HTAHE) %

ZHRLTLIEEW,

UFT B RB L - HR—F - 9 S5SXOFHRER

186

Z ZTl%, ImageControls ¥ —/L3F v MIE £ D ImageButton = > h 12— /LD ALK L -
PAR—b 7 T RAEERLLET, THNEITIITIL, Eclipse T UFT Java Add-in Extensibility
T ko TR S IV T DT 4 P — PR LES, £V« ¥ — Nl
TiE, BAZ L VP R— FETEONFICEDE CHEMERE LET, fCETIE, Vg
P—FCE>TZDZ TANITERSND A Y v FOREZITNET,

FEROETIE, ZOLy AVCEET LY 4P — FREHEROL 7> 3 2O T DR
MILET, VP — FlETHETE 27X TOA 7Y 3 VOFIIE, 5 5 % TUFT Java
Add-in Extensibility Eclipse 77 7' A O] 2B L T 7230,
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1 New UFT Custom Support Class 9 4 ¥— FZ£BZE £,

a [Eclipse Package Explorer] # 7T, #i L\ UFT Java Add-in Extensibility 7' 7 3 = 7
I ImageControlsSupport % %R L £7°, [File] > [New] > [Other] % &R
LET, [New] A7 07 - Ry 7 ANRHEET,

b Unified Functional Testing 7 =+ /L % % & L, UFT Custom Support Class % i3
WLET,

Select a wizard

€V Interface
(2% Java Project
s Java Project From Existing Ant Buildfile
12 Plug-in Project
ﬁ Product Configuration
M= VS
FH-[= lava
[#

t- = Plug-in Development
== Unified Functional Testing
BC] |JFT Test Customn Stakic-Text Support Class
i UFT Custarm Suppart Class
UFT Java Add-in Extensibility Project
H- [~ Simple

¢ [Next] Z#7 Y v 27 L%9, [Custom Class Selection] M3 FE R I ET,
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2 Y R—+FFBHREL - VSRERBRL, Y R—F - V5ADFTL 3 VERE
LET,

a com.demo /¥ — U %R LT, ImageButton 7 7 2 &I L E7,

& New UFT Custom Support Class

Custom Class Selection

Select the custom class wou want ko suppart, and set the relevant options For the I?T
corresponding support dlass,

com, demo E-java.lang.Object

|I| IrnageButkan E| qua.awt.Component

3 ImageControl B java.awt, Canvas

[¥] ImageLabel (I com.demo. ImageContral
1 com.sample ‘. com.dema.ImageButton

I Eonitrals of Efiisiclass renresent bap;

|

[Custom toolkit tree] /<4 Ti¥, [UFT Java Add-in Extensibility 72 =27 ~®
FHER) OAT 7 3 (180 X—°) T, [Custom toolkit class locations]
IZ@®N L 72 ImageControls 72 ¥z hOHEERRTDHIENTEET,
com.demo /X v 7 — VT, HWAHX A+ 7 T A% E T ImageControls 77 A X A
Y—LFy R ENET (170 X—Y TZD L v ROl 250,

E TN T TV = a VEMBICIATTE S L H1Z, ImageControls Y
TeT a7 MIiE, comssample /Xy — U E E LTV E T, ImageControls
TaTl FOAL Y s arT VX, comdemo Xy —VIZEEN TN D
ImageControls 7 A & L « ¥ —/L% v b TF,

188



E7E.OUTLEIY FO—LOYR— FEEOEE

[Custom class inheritance hierarchy] & ~#: T, 18R L 7= ImageButton 7 7
ADWIEERARTHZENTEET, 207 TAFFEY—AFy MIEERD
ImageControl 7 7 A &L+ 5720, BTRRINET,

ImageControl 7 A % & - 7 7 A3 KR — F SN TWERAD, Canvas 7 7 AT
=T 50K —F 277 2A8HY £7 (com.mercury.ftjadin.support.awt.cs
Ny r—vTiRfitanEd) . €Oz, (BT O ImageButton Ak — | - 7 F
2 > Base support class (X CanvasCS (2720 4, 2, HrFLWPHR— k-7
TR RS> THIRIND 7 FATY,

ImageButton 7 7 A X =7 F - 7 7 A TlI/\\Wiz®, [Controls of this class
represent top-level objects] 7+ 7> o VB> TOET,

ImageButton #7R— K - 7 T AD4 0T, HYERE T ImageButtonCS 1272V £7,
R EDLRIETDEEMERT L L2BRDLET,

b [Next] #27V »7 L%7, [TestObject Class Selection] M ERINE T,
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3 AREL-AVFA—LERTTAE-FTOzHO - VSRERBRLET,

ZOBEETIE, DAXLary b a—ET AL ATV b J TR EY
JLET, UFTOTANTIE, WAX L TTA-aryia—/LiE, ZOTFTAL %
T2 NV TGADT AR ATV MZEkoTEEINET, 20T, DAX L
PR— b o 7T REAERT D L &ITIT D B O b BEEHW T4,

& MNew UFT Custom Suppont Class

Test Object Class Selection

Map the custom class ko a UFT test object class.

Javadbject ka2

BIOBEE TIE, HLWIR—=F « 7 7R X o THEEEND Y R—h « 7T AZIE
LEL, YR—REIBRT D7 JRACS v VT ENTT AN - ATV =7 MRS
AL L TAROHKET AL AT V2 FTHDHH AL, [Same as base
support class] %3&R L £, ImageButtonCS 7 7 A% CanvasCS % JE3E L £ 723,
CanvasCS DT A k « 7Y =2 b + 7 F A% ImageButton = > b B —/ /L& H)IcFK9

DT TIEDY FEA,
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BEED JavaButton 7 A b « A7 V=7 ML, HAHX L« PR—FDO=—XZHIELT
b\\i—g—o

a [Existing test object class] #4722 > Zi®R L, U R b5 JavaButton % 3%
RLES, ZOBGFOT AL - A7 V=7 O A ML, UFT BAHHR— KL T
WDTRTD Java A7 V=7 PREFRINET, AL L - FR— M 2587
LWTAL ATVl NEERTDE, ZOTAL ATV Fb U A MNIE
MENET,

b [Next] #7 U > 27 L%, [Custom Support Test Object Identification Properties] &
HERERIIET,

ImageButtonCS TRETHTA b ATV x ¥ FRBETONRTFoDEY FEREL
£,

COBEICE, JERLES E LTS R—=R - FR— | - 7 FRATHHR—-PIHL T
LT ONT 4 &, BRLIET AL - AT V=2 b+ 7 TATERSATNT, %
EEYR—=FENTOWRWVIBMT 08T ¢ RFRENET, ZOEETIE, B LK
THR—h2REELTA =T FFLT7 037 4 OB, BLTHF LT rA
T4 DBMELTH Z LN TEET,

& Mew UFT Custom Support Class

Custom Support Test Object Identification Properties

Determine the set of test object identification properties that vou want to support Far vaur cuskom cantral,

foreground
handle
height
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A OFRTHIZIE, CanvasCS THAR— MRFEIN TV DT v 37 0 BT NTE
RENFET, ZNDHOFET 73T 4 OV FR— ME, #H LV ImageButtonCS AR — b -
IR E TR ESNET, ZOVANDIFEAEDT v NT 1%, BEHEREDHE
ETHHTT,

a Fxzv/ Ry A%7 ) v 7 LTlabel 7u X7 4 IR L FI, 74P —FIC
L2V R—=b T A NDOEENTT LIS, 20T T  ODBFEOYR— %
HAL L ay ba—LD=—RE5bE T AY LNEETH—N—F 4 FLET,

b [Next] #7 VU v 2 L%7, [Custom Support Test Object Methods] M A3 TR S L
‘i—a—o

ImageButtonCS TRETHTA M ATV - AVYYFDEY FEREL
E 329

ZOBEICE, BRLET TV b VITRATERBSNTWET AL 7V
e XYy RRFRENTET, ZOEETIE, HLWVERECTHR— F2FEE 134 —
NR=FA RTBHAY oy FOBR, BIOHLWAY v ROBMEIT) ZENTEET,

& MHew UFT Custom Support Class

Custom Support Test Object Methods

Determine the set of test object methods that wou want ba suppart For your custarn conkral,

Dg‘ DblClick {Object arga, String argl, String arg2, String arg3) El Click {Object obj, String button)
Dg‘ MouseDrag (Object argl, String argl, String arg2, String args,
Dg‘ Type (Ohject argd, String argl)
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AR D FRHEIZIE, CanvasCS THAR— FNEEEINTWDE BIRLET A < 47
VI M VJTATERSINZ) TAL ATV T b AV RRTRTERESN
EFT, INODT AR AT V=T b AV y RO AR— M, ImageButtonCS (T L -
THk& S E 9, ImageButton TlX, T DEEFOFEETHL T, A——F A KF5 2
Vo REBRTOIMEITIHY EHA,

FHMDOFETRFTIL, JavaButton 7 A b« 47V x 7 k77 2AFITEF SN, CanvasCS
THR—=FENTWRNWT A AT V27 b AV Y REHERTHZENTEET,

a FUTDHAY Y DB 1OFFFEELTWET (Click(Object obj, String button)) .,
T4 Y= RICEDYR—R T A NVOERNBTET LIh, TOX Yy RIZtd 5
ImageButton DH R — & FEEEL £7,

b [Next] #27 V> 27 L¥7, [Custom Control Recording Support] 7 « %' — K DE[H
BERENET,

ImageButton 3> FA—/LTHRBEFYR— T 578, VUvRAVTELI RV D
ty FERELET,

ZOBEMEICIE, JEESGEOYR—b - 7711% énrw54&y%-9x%ﬁ§
ARINFET, TOBEETIE, LW TEEL S —N—F 1 T 5D | -
YRTZ AV ROBER, B LOEE Tééﬁﬁu\/f«\/b )Xfﬂ)uﬁbu%_*ﬁo;
MNTEET,

& Mew UFT Custom Suppoit Class

Custom Control Recording Support

Determine the set of events that krigger recording.

DgfocusGained (FocusEvent argd)
DEFocusLost {FocusEvent argd)
[m} E keyPressed (KeyEvent argd)
ngeyRelaased (KeyEvent argl)

DEkByTyped (KevEvent argl)
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EROFREETIE, CanvasCS TEIESN TV D U AT Z iR TE £7°, ImageButtonCS
HABZL - FHR—F « JTRATE, INbxA—"—F4 FTLLEITIHD EFHA,

HOFRTFHETIE, ImageButtonCS IZEMT 2 Y AF 2B ELET, BRLAEKY X
FIE, VAR—=bF - 7 TRTEMENDARX N e NV RT - XYy ROEY NEEA
«C“l/\ij—o

WOFNEEFITLET,
a [Add] #27 U > 2 LT ActionListener Z B/ L £7,
[Listener] #A 712 « Ry 7 ANBE £,

& Listener

LiEm mekhiod é
ok | come |

b 77 java.awt.event. ActionListener 23R XL TUWVie W51, [Listener] U X k7>
© java.awt.event.ActionListener Z SR L £9°, R L72 U R FICHEE O ER A
Vv Rd 55A121%, [Registration method] U A FivH X Y v K& 1 DI
LET,

¢ [OKl%#7 Vw7 LET, [Listener] ¥ A 717 «:R 7 AHEH L C, ActionListener
LINIZEENDITRTOARY F NV KT e XYy KRBT W — REiE o A1
DOFFREOY A MZBMENET,

d [Custom Control Recording Support] i C, [Override low-level mouse event
recording] =7 « Ry 7 AZRIRL T, kLA X2 FofbvIgEL
YL AR b (FEEREASR— ZOEME) BREEERENBRVWESIZLET, ZOF T T e
YOFECOWTIE, 198 2= T4 Ry FFEFEOV R — Mo T 2B LT
<TE&EWN,

e [Finish] #7V v 7 L%7, [Custom Control Support Class Summary [Hfi2 %~
SHET,
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7 AREL-av kA= -YR—F - VSRADYT)ERRLET,
ARG I PR—F « 7T ZAOFHBENEZHRBLT [OK] 227V v 7 LET,

& Hew UFT Custom Support Class [ x|

Custom Support Class Summary

Reviews and confirm the structure of the custom support class, ﬁa]

General s
Custorn class: com.demo mageButton

Support clazs: ImageButtonCs

Baze support clazs: com.mercury fijadin.gtzupport awt.cs CanvasCs

Test Object Identification Properties to Override
lahel

Additional Test Object Identification Properties to Implement
Test Object Methods to Override

Additional Test Obiect Methods to Implement
Click (Ohject obj, String button)

Event Handler Methods to Ouverride

Additional Event Handler Methods to Implement

java.awt evert. ActionListenar -
|1 =

(7] oK I Canicel |

ImageControlsSupport 7' &2 = 7 K Tli&, IROEETOITWET,

» HLWUFT H A K L - HR— |k « 77 X (ImageButtonCS) 73
com.mercury.ftjadin.qtsupport.imagecontrols.cs /X 7 — JIZER STV E T,
ZOT7AME, AUORFHEDZ 7ICFRSNET,

> #1 L\ ImageControlsTestObjects.xml ~ 7 -1 /L% Configuration\TestObjects ~ -+
WA STV ET,

» ImageControls.xml 7 7 A A DNEH SN TWET,

INODEEDFHEMMZONTIE, 196 2—2 THLWH A Z L« iR— MNIDOWT] &2
BLTLIEEN,

ImageButtonCS @7 7 A /L4 (ImageButtonCS ¥ 7) OREOT AX VA7 (*) X, 774
NOBRIFENRZET LTWRNWI EE2RLTVWET, Vg P — RTINS ET T EITEK
FT 27D, R=BRELLRWEIICHLTETLRETHLENHY 9, [File] >
[Save] #3257, [Save] RZ %7 VU v 7 LET,
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#7 LU UFT Java Add-in Extensibility 7 2 % & « > —)L% v k « - — bk - & ME, DUF
THRE SN TVET,

> 1 o0V —F v k- PR —F - 77X (ImageControlsSupport) : ZiLid,
ImageControlsSupport 7' 2> = 7 F DIEKIFIZ Y ¢ P — NIZ Lo TERR &, £
SNFEEA,

> 1 OOV — ¥y FREZ 7 1/ (ImageControls.xml) : Z D7 7 A /LiZ,
ImageControlsSupport 7' = = 7 N DERKIFIZ Y 1 FF— NI L o> TIER SV E T,
ZOY—=NFy MIHR—F - 77 2%BMTH5-ICEHRINET,

ImageControls.xml 7 7 1 JL'l%, com.demo.lmageButton 7 X% 4 - 2 fu— /L%
FDYR—F 7 T7AThHD
com.mercury.ftjadin.qtsupport.imagecontrols.cs.ImageButtonCS (2~ v &' 7§ 5 &

ICHEH SN TNET,

> 1 ODT A ATVl NRET 74 /L (ImageControlsTestObjects.xml) : JavaButton
TAN ATV b VTAIRHB T aNRT 4 RT AN ATV b AV YR
EEMULZDNST0, ZO7 7 A VCEERERIETEENTOERA,

ZDT 7 A INVOREEDFERIZ- OV TIE, TUFT Test Object Schema ~/L 7] (FJava Add-in
Extensibility SDK ~/L 7 ] Y& L T 72 &0y,

> DAF L+ PR—hK ITTR (DAEL T TRATEIZ1D), ZOHITHE, 15D
AH s FR—F + 75 % (ImageButtonCS) Z1ERL £ L7=,

VB DIE T, v 4% — FIiZX > T ImageButtonCS 7 7 A NIZERL & 5 EHEIZHS
WCHB L E T,

ImageButtonCS 7 5 ADEKREIF(IZDIVT

UFT Java Add-in Extensibility & « ¥ — Ri&, A SNIAARICENTH AL A - F R —
ke FRA%ERL, TNEY—NAFy b FR—FRET 7 A VNG LET,

PAR—= b « 7T A0 EANLREEL, RO 2OTT,

» R—h « 7 7R CkoTHRENDYHR—F - 7T R

> WAZL - ay b= MIwy VT ENTT A F T2/ b I TFR
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ImageButtonCS.java % V> C, ImageButton (2%} L CIERR SNV AHR— b « 7 T X%
ALET,

BOIDOESTIX, V4P —FTERIRLEZANRZXEE LT, CanvasCS 7 7 ANJLESI U
jzj_‘o

public class ImageButtonCS extends CanvasCS implements ActionListener {
private static final String DEBUG_IMAGEBUTTONCS =
"DEBUG_IMAGEBUTTONCS";

}

¥ : DEBUG_IMAGEBUTTONCS 1%, 12 « # v & —OH A ZHIET 5 - DI ER
NET, FEMCONTIE, 8 X—Y [HRE LY R—F 7 T7200 T LTy T
EZBLTLEEN,

to_class_attr » Vv R CHIE SN/~ to_class 7037 4 TlX, OB AX L+ a2k
O—NVERTTEODIGEREINTZT AN ATV b 7 TARERINET, UFT I3,
IOTy BV TIHNTT AL « A7 V=7 MRS 2RB#T 2 RT 1 LT A - AT
I M AV ROy NERELET,

public String to_class_attr(Object obj) {
return "JavaButton";

}

UFT THAH 5+ 3 b o= LORBORBBRERET 20101%, Z0RETHITT,
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FREITONRTAETAN AT k- AVYY FOYR—FZDUVT
FEEDAALZ N« 2y ha—UIkt L TFETELEMT T 11%, $FR—h -7
FADKTAINTAE> attr E VW H A Y v RTERENET, 203 bo—uWs LT
R—FTELET AL ATV - AV YR, <FRMFTOzH - AYYFR
%>_replayMethod &\ 25 2V v RTERINET,

T 4= KX, PR —b 7T RAEERT DRI, FET DL IGRIR LR 7 )
TAETAN F TV b Ay RIHEST, BRERA Yy NIZHIGTDAX T %
FALET,

TUFT A AZ A« R — b - 77 ZOFHER] OFIE 4 (191 ~—°) TIL, CanvasCS
INHIKEIND T _NVE T e RXT 42— N"—=F 4 RTDHIIITBIR L2720, kD
AV R« AZTRBMENE LA,

public String label_attr(Object arg0) {
return super.label_attr(arg0);

}

TUFT B A% L« YR — |+ 7 T ZOFHUERK ) OFIE 5 (192 X—) TIZ, Click(Object
obj) 7TA N AT V2l b AV FEFEETHIIICENLELD, ROAY v R -
AZTRBMSIVE Lz,

public Retval Click_replayMethod(Object obj, String button) {
return Retval.NOT_IMPLEMENTED;
}

ARy FREDYR— FZDWT
ImageButtonCS 27 7 A TlL, IROBEHENA N2 FFRFROX—R L7320 £77,

> L ANNARFEDF— =T A4 F (L0 @END L~ DA N2 R DOFTENFTREIC 2 D)

protected Object mouseRecordTarget(MouseEvent e) {
return null;

}
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TDRAYy RBMENDDIE, TUFT B AZ L - HR— b « 7 5 ZADOFHER] O
FE 6 (193 ~—°) T [Override low-level mouse event recording] = =~ 7 + R v
I A BRI L2720 TT,

ImageButton = > | 12—/ COREHNT ActionListener Z 4154 %

public ImageButtonCS() {
addSimpleListener("ActionListener", "addActionListener",
"removeActionListener");

DI ANTIH Ay RPBEIMENDDIE, TUFT AAZ L - HR—hK 77
A DFIRIER ] OFNE 6 (193 _X—) T, BETDHU A F DY R M ActionListener
ZEBMLIZ720TY,

ZDar A 77 Zi% addSimpleListener £ ' > N L C, ActionListener %
HAL L« 2y ha— /L TCORENLERY ZF DU A MIBMLUET,

TIvay e ARk ey RTOER

public void actionPerformed(ActionEvent arg0) {

try {
if (lisinRecord())
return;
/l TODO:Uncomment and edit the call to MicAPl.record
/I MicAPl.record(arg0.getSource(), <Operation>, new
/I String[[{<Parameters>});
} catch (Throwable th) {

TAF—RTIE, ZOAYy R« 2FZTRERSH, EREOERE I TbREYA, &
13206 — Rl P R—FTH72DDA R b e AN ERT - A Yy ROFELE)
DOFNECHEA TR TITNET, ZORA Yy R« AX T, try ...catch 72> 7 &
isinRecord DF = v 7/ RNEENTWET, ZHiE, ZDORA Yy NOHEREE T, 7+
HNZHONWTIE, 68— [FkA 7> a DU R—F] 2L TSN,
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Z Z T3, Eclipse T UFT @ Deploy Toolkit Support =~ > K% {# ] L T, ImageControls
Y—NFy b FAR— R EUFTIZT 7 rA LET, BUE, ZOY—LFy NNOHE—D
o hue—/LCTh 5 ImageButton = h 2 — /L3R — SN TWET, V—F v k-
PR—MIFLEZELTOWERALD, ZOBEETICERLEYR— 42T A M52
LIFTEET,

1 ImageControls Y—JL¥v kb « Y4R—rZ UFT [T 7OA LET,
[Eclipse Package Explorer] % 7 C, ImageControlsSupport 7’2 > = 7 F 28R L £,

[Deploy Toolkit Support] "% %7 U~ 273 5h, [UFT] >
[Deploy Toolkit Support] ##IR L E3, fERA v E—UNERRINTZDH, [Yes] %
7Yy LT [OK] 227V v 27 LET,

V=X NRET7ANET AN 727 NRETZ 7 AND, UFT DA > A
h—Ib s ZHVENOBET L7 L ZIZat—EnNET, ZOVAX L - FR—Fh
1%, RIEIUFT 2B L CHAZ L - T F ) r—ra UEBALEZ L XICHIAITE 5 &
T F7,

HAR L = F vy ko« FR— FOFTaA OEEMZHONTIE, 18— [HRHF
L= Fy ke PR DOT A LFET) ESRL TSN,
2 UFT ##&8L, JavaAdd-in EHRE L - Y—ILFy b - Y R—FrZE2O—FLET,

UFT #B& 9, [T KMy ~x—Vx] 470l - Ry s 2T, HAFMERT R
A DY A M Java 7 R4 »DF L LT ImageControls " F~ENET ([7 KA
URR—Ux ] XA Ta s Ry 7 AR WA 1L, THP Unified Functional Testing
TRAY - AR OFIEESRLTLEIW),

ImageControls ®F = v 7 - Ry 7 ZA%&EIRL, [OK] %27V 7 L$7, UFT A
X, FEH LY A —rEe—FNLET,

3 SampleApp 7 FUr—L 3 vERITLET,

UFT X, 77V r—varBlnwieexic7 7V r—va v Lo atxr LET,
ZD1=%, SampleApp 77U r—a VBRHWTWAEENEL, 7Y r—va vk
TLTOOHEIATTINERDY £,

[Eclipse Package Explorer] % 7 C, SampleApp #4577 U » 7 L £7, [Run As] > [Java
Application] %33R L9, SampleApp 7 7'V r— a VU HE £,
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4 FLOWAHRSL -YR—+ETRAMLET,

173 ~X— [ImageButton =1 > b @ —/ /LD 7R— hOFHHE | OFIE 2 B L) 3 240K
L, UFT A7 Y =7 b+ A3 % L C ImageButton = > ke — /L& FR L, Z0
ay hr—/)L ETO Click #/E&4 8 L £,

» UFT Ti¥, Z ® ImageButton (% ImageButton &\ 5 44 Fif JavaButton & L T8k S
EJ,

> FH LW AR— -7 F & (ImageButtonCS) 1%, ~\—RZ « #7K— k + 7 Z & (CanvasCS)
M6, JavaButton 7 A K« A7V b+ 7T ADERIZE ENRNO—HORE T 2
T 4B LE LTz, 2B D7 137 11, [Custom Support Test Object Identification
Properties] Eifi (191 =X—) ICFRINFETH, UFTD [AT7 V=7 b A31]
ATaT Ry I AR [Ty I RA L DT aRT 4] XA4T0a7 Ry I A
WWERRSNLEFAL ZhO0RFBT o T 4127 78R DHITI,
GetROProperty AV v FZ{EH L 9, GetROProperty X > v ROFEMIZDOWN
Ci%, [HP Unified Functional Testing Object Model Reference] &M L T 72& W,

> RLNVFEERO A — =T 4 FIEFET L TWET A,
actionPerformed(ActionEvent arg0) -1 X bk - NV KT « XV v ROEIENR
SETTHHID, "& %27 Y 27 LTH UFT Tl b itk E A,
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Z 2T, 1B L7ZEE (173 ~2—3 ImageButton = > b 1 —/L O 7R— h OFHHE ) (2
FEW T ImageButton = > b w—/L DA FT &2 RBWT 5 & 912, ImageButton = & h =2—/LD
UFT AR — b EHEE L E9, ZHE1T 5 729, ObjectCS THREEI N B KR/ T a7 ¢ -
A v R (tag_attr 35 X OY attached_text_attr) ([Z >\ T8 LET,

FAN ATVl NOLENE, AT V=S bDtag T RT 4 THRED £, AWT
A— K« 7 A3 T ObjectCS #JL7E L EF, ObjectCS i, FHL TV 5 tag_attr A
Yy REHEALTHRESNZIEFR T EO T T 4 2F 2w 7 L, ROMo&iD
AMEZIRLET, AEIEZETRUVMET, AN—RE2EHREHA,

ObjectCS 7 7 A D tag_attr AV v R TCIE, i SNEIEFTRO T a7 4 B3 F v
INET,

>» label

> attached_text GEAMIE, TRtz M)

> B AL L 7T

label 7’1 37 1%, label_attr 2 Y v FZEH LT AL L« $R—F - 7T A THEE

S FEF, ImageButtonCS T, BAEZ DA Y v RiFA—/—2 F AT % CanvasCS & [l
FRIZ Null 2 L 77,

attached_text_attr X  » K1 ObjectCS IZ L » THEINET, ZDOA Y v KX, 47
Px 7 MIBETAHINT XA ATV FERRLT, TOTFANEERLET,
IDAH=ALE, MEBOHHT FA N2 NT NN EOZT v k- Ry 7 A
RVAR Ry 2D XS 72ay ha—LOFHITEILHET,

£ : UFT Custom Static-Text Support Class 7  #— R&ZHEH L TH A X AFTF A b - F
TVl NEREETHEIICUFT 2FHIWHZENTEET, 20U 4 ¥— FITig,
Eclipse @ [New] ¥ A 707 « Ry 7 ANLT 7 E2ALET, dBIZOWTIE, 211 ~X—
D WAL BT FA R« ar ha— L OWR— b FEOEE | 22 L T IEE0,
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ErHE.OUTLEIY FO—LDOYR— FHFEDEE

ImageButton TiE, attached_text 7' /X7 ¢ N4ETY, ZD7=d, UFT TREA =X
LEFERATAZNEROY 5, S Fr—IAEEERVT 7 ADARTTH HIEEHHD X
BL-OSANEHINET, ZO%HA, 1 AX AL 7 T A com.demo.ImageButton
X, TA DM F TV =7 OIS ImageButton 1272 VD F 7,

HARL Ay ha—LDT AN -7Vl NOARIEERTHIZIE, YEAR—K-7
Z A TCtag_attr XV v R&A— =T 4 N7, BEFEOEELMHH LT, label_attr 2
Yy ReAd—nR—F4 FLET,

1 ImageButtonCS ¥ S5 X T label_attr Vv K&#4—/"—54 FLET,

a Eclipse C, ImageButtonCS.java 7 7 -{ /L ™ label_attr X / » K+ &A% 7 C, return
super.label_attr(arg0); Z Rk d =2 — NIZEE#Z 3, ZHITE Y, ImageButton T
FHINDEBRT 7 A VOL4FRT (GERNNRTRL) BDiRINET,

ImageButton ib = (ImageButton)arg0;
String res = ib.getimageString();
if(res == null || res.length() == 0)
return null;
int last = res.lastindexOf('/");
if(last == -1)
return res;
return res.substring(last+1);

b [Save] X% %7V w7 3%7, [File] > [Save] Z®IR L CEHNEZ{RE
L%,

T EELEDOITJavaD T TR« T 7 A NVDHRT, RETZ 7 AMIEFE L TV
b, V=¥ vy b VR — b EUFTICHET 7oA $T250F3IH0 FEA,
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2 HLWAREB L -HYR—FETAMLET,

173 ~2—< lTmageButton = > ks 2 —/LDHR— F DOl | OFNE 1B L 2 240K
Lf7fvﬁ~v3y%%ﬁb,mwmﬁ7/1&% A 34 7C ImageButton = > k
n—/LEFRLET,

¥ BHWTUWA UFT £ v 3 2 > (ImageControls 7 A X L« Y —)L&% v bk« FR— F &
m— RLUZRRETHEITH) 2322 SIFrBETT, BAX L - R — MIxtT

LT AW HI21%, SampleApp 77V 7 —a U EKT L THESRTT 20EN
%D \ijqo

UFT T, Z ® ImageButton {3 JavaExt1.gif &\ 9 40 JavaButton & L CRBsk S E T,

TAR-FTO2I b - AV Y FIZRHT 5 R— FDEEK
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Z ZCl¥, ImageButton @ UFT #AR"— R ZJLIELTC, RF¥ L - 7 U v I DT AL « A7
VI b AV REFR—=FLET, ZNEITHIICE, VAZL-HFKR—K- 7T
T Click_replayMethod %5235 L C, #%%9 % MicAPI B3 & MO MmN H Y £,

1 ImageButton T Click * Vv FOBREOHIEET A FLET,

a UFT THH O GUI 72 F&1ER L, JavaExtl.gif RZ L &2 A7V =r b« YRY
MUIZEBIILT, 207Vl NEFOAT vy FE2BMLET, 2hEiT 5 FIA
{22\ T, [HP Unified Functional Testing =—%— X « 74 K] 2L T 72
W,

ImageButton |% JavaExt1.gif &\ 5 £ A1 JavaButton ITHE (fEH SN 57 A 2102
HE) & LGRS ET, Click #4FI1%, Z 0B OREEERIETYT, Z 08X
9T D JavaButton XH H OIEHEEET T,
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w & Actionl

v|:| Sarplespn
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7A@ [Details] %7 Vv 7 LET, RONERERINET,

Run Error

X

ZDOT T —HFEAET DD, Click #FE% 79 57291Z, UFT A3 Click_replayMethod
ZIEOMH 9772 ¢ 7, Click_replayMethod 1%, =% —+ =2— F NOT_IMPLEMENTED
% i7" & 9 |2 ImageButtonCS THIEINTWET,

e [Stop] #7V v/ LT, TAMDEITEEIELET,

2 ImageButtonCS T Click_replayMethod * Vv F#RELFT,
a Click_replayMethod # Vv K« A X 7%, kROa— NICESH#I 9,

public Retval Click_replayMethod(Object obj, String button) {
ImageButton ib = (ImageButton) obj;
MicAPl.mouseClick((Object) ib, ib.getWidth() / 2,
ib.getHeight() / 2);
return Retval.OK;

3 U ¢ ¥— KT ImageButtonCS.java 7 7 A L OERIFIC, Z D3 — RO HR—
M Z#ZE 732 import com.mercury.ftiadin.custom.MicAPI 3 H BRI BT S L CWET,
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? MicAPL.mouseClick # /v FZIFOM T Z L8 ARETT, FEANC OV TS, TUFT
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AZTDA—RE, ROLIITERLET,

public void actionPerformed(ActionEvent arg0)
{
try {
if (lisinRecord())
return;
MicAPl.record(arg0.getSource(), "Click");
} catch (Throwable th)

{
MicAPI.logStackTrace(th);

}

MicAPl.logStackTrace * ¥ v Ni%, A% v 7 - k L — A % Java Add-in Extensibility
DFTRTOuT - AvEe—Vrgeul - 7y A MM LET, TOAY v RIZ
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nELE,
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to_class_attr
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WOBBEMMLE Lz,
addSimpleListener
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ImageLabel 3> FO—)LOYHR— FOFE

Z ZTiX, ImageLabel 2> ha— L EET L7 F A K « RNy 7 ADBFED UFT YR —
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LTLEEW),

b Java & ImageControls Ofi FDF = v 7 <R v 7 ARENI L TND Z & &R
L, [OK] 27 Vv 27 LET,
2 SampleApp 7 7V r—La vERITLET,
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3 ATPxH k- R/ EFERAL T ImagelLa

a UFT G, GUIT A h&Bx, [W—IL]
(FATSxH b RL] V=L R— - R
A1 FATas - Ry 7 2AEREET,

b A7V AA] FA4T707 K

bel D7ONRF4ERELET,

> [FTOxH b RNRA] ZBRT D0,
Ao Vw7 LT, A7V b AR
(FAamnFq] #7%2) v LET,
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M5, SampleApp 77V r—a v OLEMICH AHEBE U v LET,

ImageLabel = > b = —/ L, UFT TR ISRV T A Z L« 7 T ATHESHNTHD
*9, B¥ X ImageButton &\ 9 A REITOINH D JavaObject 47 =7 & L

TR SNDTD, RRENDT A 2

D £9, label i3i% 7 v X7 41345 T,

JAEHED JavaObject 7 7 ADT A a7

- Object Spy

EVRICER

Ohiject hierarchy:

(7wl

-4 JavaDbject : JRootPane
E-dp Jawalbject : JLaveredPane
El-& Javalbject : JPanel
E-4p Javalbject : Box
EI& JavaObject : Box

Properties | Dperations]

-4 JavaDbject : Imagelabel

Degcriptions are available only for test object operati

1 Mative @ |dentification
Properties Yalues -
o digplayed 1
o enabled 1
A focuzed 1
2T foreground 333333
T height 50
Al index
label
2 labeled containers path o
Selection;
label
Dezcription;

OrE,

LClose
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(7Yl N AL AT aly KRy AT,
M6, SampleApp 7 7V 7 —a VDT F A b
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o Ohject Spy

EVRICER

Qbject hierarchy:

-7 )]
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Properties | Dperations]

71 Mative @ |dentification

Properties Yalues

T end_selection 0

T focused 0
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Ty height 24

Ty indes

T label

T labeled containers patk

T logical_location

IR e LW W e W P B P Ern W Ern P En LW

Tt path TextField:B ox:1Panel. Layer

Selection;
Clasz Mame

Drescription:
Degcriptions are available only for test object operations.
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o7 nlpary ha—LOYR— s HFEOFE] OL v AT, ImageControlsSupport
UFT Java Add-in Extensibility 7’2 Y= 27 b (178 X—Y%2&M) Z2{ERLE L, 207
B Y= 7 b T, ImageButton = b B —)LDHAZ hHPR—b 7T AEEHRLE L,
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Select a wizard

€V Interface
(2% Java Project
s Java Project From Existing Ant Buildfile
12 Plug-in Project
ﬁ Product Configuration
H-E= CVS
H- [ Java
t- = Plug-in Development
=% Unified Functional Testing
ML |FT Custom Static-Text Support Class
E?* UFT Custom Suppart Class
UFT Java Add-in Extensibility Project

H- [~ Simple
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Custom Static-Text Class Selection
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com, demo E-java.lang.Object
|I| ImageConkrol E--java.awt.Component
|I| ImagelLabel Iél--java.awt.(:anvas
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DFE| DLy ALOLDERTWET (UFT B AX L - R — b - 7 T ZADH
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Custom Static-Text Support Class Summary
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General

Custom class: com.demo Imagelabel

Suppoart clazss: ImagelabelCs

Baze support class: commercury fijadin.gtsupport awt oz CanvasCs
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B ORIRRRE T 1 T 4 OFEHINC DWW T, 64 _X— [ R8T 0 X7 ¢ -
PAR—h - AV F] 2BZRLTIEEN,

HLOWARZLBHTERA N Y R—F-IFRAOTTOMETRE
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Z 2 ClZ, Eclipse T UFT @ Deploy Toolkit Support =~ > F%{# ] L C, ImageControls
V—nFy b YPR— b2 UFTIZT 7RA LET, ZHRICEY, TTEHR—-1 &7
1 A O ImageButton = > k2 —/L{ZH1 2T, ImageLabel ™ ¥ — k23 UFT IZiIBA1 &S
AVE T, ImageLabel DI AR — MIFLFER L TWETADN, ZORERE TIT/ER LY
N—br&ET7 AT HZLITTEET,

1 ImageControls Y—JL¥ v b - $7:R— rZ UFT ICFFBA LET,

[Eclipse Package Explorer] % 7 C, ImageControlsSupport 7 == 7 K &I L
\i j_‘o

[Deploy Toolkit Support] % > % 7 U » 73 575>, [UFT] > [Deploy Toolkit Support]
FERINLET, ERA v E—URFRENZD, [Yes] 27V v 7 LTHhH [OK] %
7V v 7 LET,
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V=¥ NRETT7ANET AN F T2 NRETZ 7 A NVD, UFT DA > A
=i« ZFVENOBEET D7+ L IZabt—SnNEd, TOHAX L - FFR— |
L, WICHAZ LT TV r—2a BB LIEEEICFIHTES LI E3 (7
AR ATVl MRET 7 A NVFETFIN TV W=, UFT #FER LEIEH
nEHEA),

HAL I Y —Fy ko« FR—ROT T 0 A OFEMDONTIL, 78— [h 2K
L V=Fy b YR-FDOT T A LRIT) 2BRLTI SN,
FLOAHREL - HR—FETAFLET,

212 ~— [ImageLabel = k@ — LD AR — hOFHE | OFIE 28X 3 20K
LCT 7V r—ar&3TL, UFT ®A 7Y =2 b« A/%1 T ImageLabel = > b
=T XA Ry I AEFRLET,

FEUFTIE, 770 =2 a v RRWEL ST 7Y r—ya v L Ok a L L E
T, FD, BIWTWS UFT &~ ¥ 3 > (ImageControls V' —/L% » b « iR— h &
12— R L72RBETHEITH) 2FEH L TEEELT A 952 LIXFEETY A, SampleApp
TTV = a v EK T LTHERITTA2LERH D £7°,

UFT !X ImageLabel % ImageLabel(st) &\ 5 £ Fio JavaStaticText =7 2 =7 &
LRk LET,

=& JavaObject : JRootPane
-4 JavaObject : JLayeredPane
El-4 JavaObject : JPanel
24 JavaObject: Baox
El-4 JavaObject: Box
O] | =St aticText - Imagel abel(st]

ImageLabelCS (2 & > THLIR S 115 CanvasCS 13, label 3857 v X7 4 [Tk 50 R—

MEREELERHA, EDD, ImageLabel @ label "m /N7 ¢ 322270 9
(attached text 7 1 /37 ¢ L[FKE) . ZOFER, A—/S—2 52D tag 70T 413
ImageLabel ® 2 7 A4 %K L, ImageLabel ® tag 7' & /37 ¢ | ImageLabel(st) (272 1
ESr RN
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UFTIZ, Bl &#&TF A b R v 7 A% TextField &\ 9 471 (7 7 A4) @ JavaEdit
TAN ATV PELTHAIILET, Zhuk, BETIHHTIAN -7V
27+ ImageLabel ® label 7' /X7 4 IRZEDFETHDHT-DHTT,

B[] Javawindow : Sampledpp
El-& JavaObiect : JRootPane
E-dp Jawalbject : JLaveredPane
El-& Javalbject : JPanel
E-4p Javalbject : Box
L JavaEdit: TextField

HWTEXR Loy bA—LOYER— FDOTRK

Z Z T, ImagelLabel TEAT HMEIE T 7 A L OAHITZIET 728, ImageLabelCS 7 T A
Tlabel_attr A Y v FZFHELFET, ZHIZ LY, UFT T ImageLabel @ label 7" = /37 ¢
RS H5 a2 b r—/L o attached text & U CHE T2 Z ENAIREICAD £3, &5
IZ, ImageLabel @ label 77 /37 ¢ %3245 L C, ImageLabel 7 A s - A7 ¥ =7 MIAMK
B & TRt L E 9,

1 ImageLabelCS 4 5 X T label_attr * Vv FEEELET,

a Eclipse T, ImageLabelCS.java 7 7 -f /L @ label_attr X /> K+ A% 7C, return
super.label_attr(obj); 2%k D a— RiZE &2 £,

ImageLabel il = (ImageLabel)obj;

String res = il.getText();

if(res != null && res.length() > 0)
return res;

res = il.getlmageString();

if(res == null || res.length() == 0)
return null;

int last = res.lastindexOf('/');

if(last == -1)
return res;

return res.substring(last+1);

TNV T v T 01X, TV EOT XA N (FET D% 6) F 7213 ImageLabel
THEMT 2B T 7 A VOLHT GERARL) ZRLET,
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b [Save] K% %7V w27 3%7, [File] > [Save] Z&IR L CEHNEZIRE
L%,

T EELEDOITJavaD T TR« T 7 A NVDHRT, RETZ 7 AMIEFEL TV
W, V—=F v b PR—F &2 UFTICHET 7oA/ 4$5083H0 T8 A,

HLOARZL - R—FETAFLET,

212 R_X— ’—ImageLabe] ay hr— OV R— NOEFHE ] OFE 2B 3 50K
LTV r—var&F 7L, UFTOA 7Y =2 b « 231 T ImageLabel = > b
O—/LLETXAR Ry RABERRLET,

ETAN ATV MRETFAMIEELTOERA, O, BHNTHD
UFT & v ¥ = > (ImageControls 7 A X Ly « Y —)L% v k « #7R— h&Eo— R L72REE
THEATH) ZEAT L EETEET, HAX L - FR— MIKTT2EE & ST
5H121%, SampleApp 77U r— a2 U ERKT LTHEFITTI2LENRH D £,
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UFT C, ImageLabel /& UFT Java(st) &\ 9 £ fij JavaStaticText 7 XA ~ - 7«
7 FELTE#BSN, label 7137 ¢ X UFT Java 1272 0 £7,

£ Object Spy (-5l
(& |CEE C

Qbject hierarchy:

=4 JavaObject : JRootPane
& Javal bject : JLayeredPane
S JavaObjsct : JPanel
E-& JavaObject : Box
=4 JavaObjsct : Box

Properties | Dperations]

() Mative @) |dentification
Properties Yalues -
Ty focuzed 1] ]
Ty foreqround 333333 N
Ty hieight 50
Ty inidex
I label | PUFT Jawa
Ty |abeled containers_path
Ty logical_location
Uy path Imagel abel B ox:B ow Panel L
Selection:
label
Dezcription:

Descriptions are available only for test object operations.

Cloze
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UFT G, 7% A b« Rv 7 2T UFT Java &\ 5 4D JavaEdit 7 2 - 47 2=
J FELTE#BEINET, JavaEdit 7 A | - 727 O label 71 /37 |32 T
7, ImageLabel ® label 7’737 ¢, JavaEdit @ attached text 7' = /37 1 D F F &
FEEELET, 2k, 7Ab A7V PAELTHERASINET,

. Object Spy

(& MR

Ohiject hierarchy:

(7|l
&)

B-[] JavaWindow : Samplefpp
£l 4% JavaObject : JRootPane
El- & JavaObject : JLayeredPane
= Q JavaObject : JPanel

= Q JavaCbject : Box

Propesties | Dperations]

) Mative @ |dentification
Properties Values -
Yl Class Name JavaEdit 1
U abs x 3
Wle abs v 72
9l attached text Cuick Test Java
Yl background white
Yl caret_position 1]
9l class description edit
3 class path java.awt. TextFieldjava.awt. | 7
Selection;
Quick Test Java
Drescription:

Degcriptions are available only for test object operations.

LCloze

7137 1 1% mercury.gif |

3 : SampleApp 7 7'V r—3 3 » A{EIE L T imagelb.setText("QuickTest Java"); ©1T7%
HiBk L7=%%, ImageLabel 137 % A h&E R R L EWHA, £DYA, UFT i ImageLabel %
mercury.gif(st) &\ 5 4 #iD JavaStaticText 7 A ~ - 477 & LTFERL, label
W20 ¥9, £/, UFT L, 7% A b R v 7 2 % mercury.gif
EWH i JavaEdit 7 A b - AT V27 MELTR#MLET,
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T, BAH LB AR— b OGRS TR IZHE - C, ImageLabel 7 F A b »
HAZ L3 hn */1/75‘ ZH R — &R E LTz, Z2H T, ImageControls 7 — /L& v
OV R—=RERLE Lz, 2OV R— FOBEROY 71,

<UFT Java Add-in Extensibility SDK € > X k—JL * 7 # L5 >\samples\
ImageControlsSupport 7 + L ZZH D £9 (ZOV T NEFETT 7oA 3555
1%, Bib-oTlavay 7 A& a A L$H0ERH Y ),

ImageControls Y—JL¥ v k - 7 R— FD&EL

228

ImageLabel 7 7 A D label 38i#% 7" = /37 ¢ Cffi [ L72522£(%, ImageButton 7 7 A D label
BT aNT 4 OFREL TP THWEST, ZnbD 7 7 A3 EH 5 E ImageControl 7 7
A HYEIET B 72 %, ImageControl (ImageControlCS) DYV R — bk « 7 7 AT label 8%~
B NT 4 OV R — N EFRET D HFNETD ThH o ARERH D F5,

Z g, ImageButton =22k —/L & ImageLabel = > k B — /L DV R — b &5 5 EED
216 R=Y [HAZ b 7T A« PiR— h#¥®%1/7)xhj@2§5@ iblebspcn
BIRIZEMN TEWL 7oz (RIS O Lt o> b e — O R — kEIRET & 725
72) ZEEEWLET, TOHAIE, ImageButtonCS & ImageLabelCS i3 ImageControlCS
Z¥i5E L, ImageLabelCS THE/& S 7= label_attr # ¥ v K& 4 —/3—F 1 KL label 7
BT 4 T LR ET

WOAETIE, label_attr 2 Y > ROEIENEE L 720 L 91T, lmageControls VL%
bePR—F by haZELET, ZOLEFICL-T, ¥R — FOEEPEEEZT
52 &EH Y £ A, ImageControlCS H7A— bk « 7 F X% {ERL L, ImageControlCS % ik
#92 & 51T ImageButtonCS & ImageLabelCS #ZH L £ 7,
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ImageControl AR & L+ 9 5 ADYKR— FDIER

Z Z Cli¥, ImageControlsSupport 7' 7 ¥ = 7 | C ImageControl 7 7 A D T3 A & 1k« ¥
R—h 7T 2AEERLET,

1 New UFT Custom Support Class 74 ¥— FZBHZEd,

a [Eclipse Package Explorer] # 7 T, #i L\ UFT Java Add-in Extensibility 7' 7 ¥ = 7
I ImageControlsSupport % %R L £7, [File] > [New] > [Other] % &R
LET, [New] A7 07 - Ry 7 ANRHEET,

b Unified Functional Testing 7 =+ /L % % & L, UFT Custom Support Class % i3
WLT, [Next] #27 VU v LEJ, [Custom Class Selection] 23R I E T,

2 Y R—FFBHREL - VSRERBRL, YR—F - V5ADFTL 3 VERE
LET,

a com.demo /¥ 7 — % & LT, ImageControl 27 7 A Z &R L E£7,

& Hew UFT Custom Support Class

Custom Class Selection

Select the custom class you want ko support, and sek the relevant aptions Far the ’?T
corresponding suppork class,

com.demo
RN 1= g=Control
com.sample
i cam,demo. ImageContral

I™ | Controls of Eiis Eif==i1R Ee e | =

- =i

[Custom toolkit tree] 7=+ C, ImageControl 7 7 A7} com.demo /X 7r—
DY HR—= R ENTWRWHE—D 7 T ATHDZ EBbnh £,
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230

[Custom class inheritance hierarchy] =~ TiX, # TIZERL TWD
ImageControl 7 7 ADEE % Fmd 5 2 L3 T& £, ImageControl 7 7 A%
java.awt.Canvas ZkiE L £4, £ D72, {ERLH @ ImageControl R —k « 7 F
A D Base support class /< CanvasCS (2720 £,

ImageControl AR — b « 7 7 2 TiX, fFEUERE D4 il ImageControlCS % 2 D &
EFERALET,

b [Next] #7 U 27 LE4, [TestObject Class Selection] i AFE RSN FE T,

3 AREL-AVFA—LERTTA-FTOzHO - VSRERBRLET,

ImageControlCS ¥R —k - 7 F Z&AEpT 2 BAIE, EBEOa L bu—LZ2HR— b
FTHEOTIHRL, FEPOP A=K+ 7 TADR—=Z « FR—h - 77 2L LT
T5720TT, £D7=, ImageControl WAX b+ VT AEEDT AN AT Vxy
Fe 7Ry BT TONIEETIIH Y A,

& New UFT Custom Support Class

Test Dbject Class Selection

Map the custom class ko a UFT test object class.,

JavaCbject |—
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ROFNRZIATLET,

a [Same as base support class] Z R L £, 2% EINT 5 &, java.awt.Canvas
vy BV 7 INDT AN ATV b« 77 A2 ImageControl 7 A X I+ 7
FANRVy B 7 ENET, EENR~ y B I3 T EE A, HiLWR—
k277X Tto_class_attr £ Vv FIFEEINT, X=X+ P K-k 77 2»
DR S ET,

b [Next] #27 VY > 7 L%7, [Custom Support Test Object Identification Properties] [
HRRRINET,

4 ImageControlCS TEETAHTA A IV ¥y FRETONRT1 DY FEREL
£,

ZOEMEICE, EELELIELTVERN—R « $R—F « 7 FATHEFR— FEH TN
LT NRT 4L, BRLET AN - AT7V27 b JTATERINATNC, F
EYR—= SN TWRVIBINT 0T o BRRSNET,

& New UFT Custom Support Class

Custom Support Test Object Identification Properties

Determine the set of test object identification properties that you want o support For your custom control,

foreground
handle

O
O
O
O
O
O
O
O
O
O
O
O
O
O:

FEAN D FRRHEIZIL, CanvasCS THAR— FRFEEINTVWDRH T =T 0 BT ITHR
RINET, TNHLOEHET 1T 1 DY AR — ME, # L ImageControlCS ¥ A —
e 7R EoTHRSINET, ZTZTIE, HLOVEETYHR— A —nN"—F 1
5707 ZBRTHENTEET,
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[Test Object Class Selection] M (230 ~X—3) TiX, BHEDT AL - AT V=7 b -
I TAEBRLEFATLE, 201D, V4P —RFIEDTAK - AT V= |-
27 A ImageControl H AKX L« 2 ha—)LZwy B 7 EINTNE0ERi# L T
WEHRA, ZORER, BT 0T A ITHMORTRICERRINET A,

a Fxv 7 Ry A% 7Y v7 LTlabel 7u /37 4 @R LET, V4P —NIZ
LY R—=1 T 7 A NVOERNTET LTED, ZOT0RT  OBEFOYR— bz
ARG e Ay b= D=—RIHDREIN AT LNFEETA—1"—=F 1 FL
i—a_o

b [Next] #7 VU v 2 L%7, [Custom Support Test Object Methods] i A3F/ R S L
£7,

5 ImageControlCS TRETETAF ATV b - AVYYFDEY FEREL
7,

COBEEICIE, BRLEAT V2T b JTATEREINTNWDT A AT V=7
b AV FRFRRSNET,

& Mew UFT Custom Support Class

Custom Support Test Object Methods

Determine the set of test object methods that you wank to suppart for your customn contral,
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[Test Object Class Selection] M (230 ~X—3) TiX, BHEDT AL - AT V=7 b -
I TAEBRLEFATLE, 201D, V4P —RIEDTARN AT V= b -
27 A ImageControl H AKX L« a2 ha—)LZ=y BV 7 ENTNE0 &R LT
WEHA, TORER, 7AL ATV b AV NIZZOBEHEICEREINERA,

a ImageControl # AKX L+ 22 ha— LY R— "BRERT AN« 77 b -
AV RBFIELZ W E Bl LET,

b [Next] #2V v 7 L%7, [Custom Control Recording Support] =7 ¢ H'— K DIHi[h]
BFRRINET,

ImageControl A FA—)LTORBEYR— T 570, UYyRUTHRAIRV D
vy "E&E Lij-o

ZOEEICIE, PERMROYR— b - 7 FATRESNLTND 4’“\“‘/]\-U}<“f75§2%
RESNET, ZOMETIE, HLWERETEREEZ S — =T 4 FF20A4 X |-
YRZ AV Y ROBER, BIOEETLIH LAV b - )X‘J‘(DLJJD’%ﬁﬁl
BTEET,

# Mew UFT Custom Support Class

Custom Control Recording Support

Determine the set of events that trigger recording,

DgfocusGained ({FocusEvent argd)
Dgfocusmst {FocusEvent arg)
ngeyPrassed (KevEvent argl)
ngeyReleased (KevEvent argl)

ngeﬂyped (keyEvent argl)
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FEA D/ TIE, CanvasCS THEIEXN TV D U AT %78 T & £, ImageControlCS
HABZL «HFR—F - VTFTRATHE, INbaxAd—"—F4 NTHUETH Y EHA,

a ImageControlCS ¥R — b« 7 T 2% ERT 5 BEUIE, EEDOa >y br—L & HR—
FT 572 TIEHRL, BPOYR—F - 7 TADR=RZ - YR—F - 7T 2L LT
T 5720 THHZLEBELET, £D72, ImageControl = b r—/L £ T
Lk AR— M OMEITH Y FH A,

b [Finish] #27 U v 27 L%¥, [Custom Control Support Class Summary] [ #i23FR
SNET,
7 ARZL-av kA= -HYR—F - ISROYTYERTLET,
HAZ I s FR—=b » 7T AOFBNELZHRAZL T [OK] 227U v 7 LET,

New UFT Custom Support Clazs

Custom Support Class Summary
Revievs and confirm the structure of the custom support class, E?

General

Custom class: com demo ImageControl

Support class: ImageContralCs

Basze support class: commercury fadin gtzupport avt cs CanvazCs

Test Object Identification Properties to Override
label

Additional Test Object Identification Properties to Implement
Test Object Methods to Override

Additional Test Object Methods to Implement

Event Handler Methods to Override

Additional Event Handler Methods to Implement

Selected Options
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ImageControlsSupport 7’2 = 7 KT, IROZEMTONTWVET,

» ImageControl 7 AKX I« 7 T A%ZDOYHR— b « 7T AT 5 ImageControlCS |Z
<~y 745X 9512, ImageControls.xml 7 7 A VIR EFE S TWET,

> BILWUFT A AZ A« R — bk « 75 A (ImageControlCS) 7%
com.mercury.ftjadin.qtsupport.imagecontrols.cs /> 7 —®
ImageControlCS.java 7 7 A MIAE SN TWET, 27 7 A%, AllloFk
TRIED B TICRREINET,

ImageControlCS 77 7 A (% CanvasCS ZLBEL, XY v R+ A¥ T % 1 DI2IFEAT
WET (label_attr),

ImageControlCS 7 7 A /L4 (ImageControlCS % 7) DD T ALY A7 (*) 1%, 77
ANDRIFNTET LTHWRNI L EZRLTNET, Vo ¥ — FTITb S AT ITHA
WRIFET D720, R—ERECRWE S I TERERFT 2 0ERH Y 3, [File]
> [Save] #i®&INT 575, [Save] A& %27V w7 LET,

8 ImageControlCS ¥ 5 AT label_attr AV w FERELZET,

a Eclipse C, ImageControlCS.java 7 7 f /L™ label_attr X /v~ K+ X% 7 C, return
super.label_attr(obj); kO a— NIZEEH X 7, ZNIZLY, ImageControl T
RS NDEE T 7 A VOAHT GERNARL) PIRSHET,

ImageControl ic = (ImageControl)arg0;

String res = ic.getlmageString();

if(res == null || res.length() == 0)
return null;

int last = res.lastindexOf('/");

if(last == -1)
return res;

return res.substring(last+1);

b [Save] "% %7V w27 4%%, [File] > [Save] Z&IR L TEHNE ZI1-F
L%,
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236

ImageControls YV—JL¥ v b - H/R— FEBDERE

YAR—F 7T 2AOWREIX, WAZXZ L7 T7AOHELE BT IHILERDLY £,
ImageControl 7 7 A3 %A — K + 7 F & ImageControlCS IZ~¥ v B> 7 I TWVWH DT,
ImageControl D FFRD PR — bk « 7 F 273 ImageControlCS ZJLIET D MENH D 7,

ImageButtonCS & ImageLabelCS (X &5 5 1 label_attr £~V ~ K& k& L % 7, ImageLabelCS
TIX, 2DORA Yy REA—1"—F 4 FLT label 712 /%5 ¢ ¥ R— | 2084 5 LE)N
HYET,

1 ImageControlCS Z#i5E9 % & 5 1< ImageButtonCS ¥ SR ZEELET,

a Eclipse ¢ ImageControlsSupport 7’12 = 7 k@ ImageButtonCS.java 7 7 1 /L &
Bl %, ImageButtonCS 7 7 A DE4 % o) £7,

public class ImageButtonCS extends CanvasCS implements ActionListener

b ImageButtonCS 73 ImageControlCS Z L5595 L 2 ICBAEZER L ET,

public class ImageButtonCS extends ImageControlCS implements
ActionListener

ImageButtonCS 77 7 A5 label_attr £ ' ~v F&HIBRL £,
d ImageButtonCS.java 7 7 1 L Z{R17F L £ 7,
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2 ImageControlCS #{57&$ % & 5 I ImageLabelCS ¥ SREZEELET,

a ImagelLabelCS.java 7 7 -f /L' C, public class ImageLabelCS extends CanvasCS
% public class ImagelLabelCS extends ImageControlCS |(Z& & #i 2 £4,

b ImageLabelCS 77 7 2 label_attr A Y > T, ROIT%

ImageLabel il = (ImageLabel)obj;
res = il.getlmageString();
if(res == null || res.length() == 0)
return null;
int last = res.lastindexOf('/");
if(last == -1)
return res;
return res.substring(last+1);

KOOI ITEEHZET,

return super.label_attr(obj);

¢ EEANRERFELET,

# L L) ImageControls Y—)LXv k - $7/R— FODTTAS ETR L

1 L\ ImageControlCS %A — k « 7 7 ADIERIFIZ, 7 ¢ ¥— KTl ImageControls.xml
7 7 A /L% ZEH LT ImageControl 77 7 A % ImageControlCS ¥/ — |k « 7 T R|Z~w v B
JLTWET, Z207, BENELRMT H7-9DIZ, ImageControls ¥V —/LF v b « H
R—beB/ET 7oA TOLERSY ET,

1 ImageControls Y—JL¥Xv k - $7;R— +# UFT ICTFRA LET,
[Eclipse Package Explorer] % 77 C, ImageControlsSupport 7’2 =7 F &38R L £,

[Deploy Toolkit Support] % > % 7 U 73 55>, [UFT] > [Deploy Toolkit Support]
EBRRLET, lERA vy E—VBRRRINED, [Yes] 227V v 7 LThb [OK] %
707 LET,

237



E8HEe JRALBUTER L - Oy FO—ILOYR— FHEZEDFEE

2 EELILHARSL -YR—bETRILET,

173 ~— [ImageButton = > k@ — LDV KR — hDF#E ] & 212 ~— [ImageLabel
ay hr—AOYR— FOFE] OFIEEZHED KL T, SampleApp 7 7'V r—3 g
ZFEFIT L, ImageButton & ImageLabel (2% 2% KR — "R IELSBERETLIZ L%
RLET,

FETAN ATV MRET 7 A NVBEEIL TRV, VTS UFT ©
¥ 3 (ImageControls # AKX L« Y —/L¥ v |« $R—hEo— FL7ZRETHE
T ZRHAT L ERTEET,

HAL LY —Fy hePR— ket MIEFEEZMZ -2 & T, UFT T® ImageLabel
= ke —/ LR ImageButton = > b B — L OFRFEAESLT A NHENREEZ T HZ
LiEbHYERA, T2EL, EHbDar br—ATh, label 5877 v /N7 4 DR —
I 23 ImageControlCS 7 7 ALk X415 K 912720 £9, ImageControl Z¥XiET 2
BIMOH AL L 7T ZAfBR LTcHR, £hEho label 70 37 ¢ b [FFRIC UFT
ETYHR— &, BINOE(EEZIT O LETHY E£H A,

ImageControls ¥ —/L'¥% v MIXIT 28BS IR — FOBEROY 71T,

<UFT Java Add-in Extensibility SDK £ > X k—JL = 7 # L5 >\samples\
ImageControlsSupportAdvanced 7 + L Z1ZH 0 £F (ZOV T LEFE#HTT 7o
AT HHEE, fiboTlavaZ 7 A2 a3 A VT HHERHY ET),

LYRVDFEED

238

ZDL vy AT, Imagelabel =2 s m—OHR— FEAERK L, Zii UFT THIOT
FRAR ATV FPELTHHILT, label 7 a7 4 ZET 22 ba—1o
attached text & L CfliHHC& 5L HICLELT,

eV T, ImageControl 7 7 ADYR— M EAERL L TY —/F v b « R — S OF#RIEE &
®, ZHIZA D T ImageControls > —/LF > bR — k-t NORBELETLE L,
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> RO m/\74’ YR—=bF - AV REFEHALT, DAZLBHTIFAL - o
=L DY R— -7 7X7E1”EEJZTZ>E/£ IZOWTEELE L,

class_attr
tag_attr
label_attr

value_attr

» [Test Object Class Selection] i < [Same as base support class] 47> 3 > % ff
AL, TOREONTEHLE LE,

Z DD IER

ZDOLy RTHMLIZ@M T 23T ¢ OFEMICONTE, 64 X— T—A722 i
/X7 e AR —h e AV N ZBRLTIZEN,

WOy AT, FILWT AN ATVl b IV TANDY BV T NRBEIR A
ALy bha—xtd 5% R — FOERFIEZOWTEE LES, LT X b -
FTV2 T b TR T HRNRRE T O RT A LT AN AT N Ay
FEERLT, HeT59FR—r2RELET,
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FOE

B ay rO—IILOYER— FAEDOEE

Z DLy AT, Javaboutique Y —/LF v hNIZ AllLights = > h v — L OH R — k& {E
M LET, Alllights 12, #HOT AN - A7V b+ 7 T AOERVLER, FHHO
BEEZE o 2 b — LT,

Ly A169 —2 [ urary ha— Ao R— NFEOFE] T, v Ak
HAZ Ly ba—OFR—kOIERITIEIZDNTHEE LE L7, Java Add-in
Extensibility DIEARFIHIZOWTIEB/EA TH LD, ZOL v AT, LR
NBEICDOWTORHBHA L E9,

COLYRVIE, RORBTEREIATHWET,

IOy RO (242°8—2)

AllLights = > b 0 —/L DY R — FDFE (2442—2)

UFT Java Add-in Extensibility 7’7 2= 7 F OFHIER (25072—2)

UFT H A X L« R — |k « 7 T ZAOFHIER (255-3—)

FHLWH AL L « FR—K « 77 A ZDONT (2695—3)

HLWHRZL - Y—LFy ks BR—FDF A LT AR 272°5—2)

AllLights = > b 2 — /LD R— FDEHE (27523—)

Y Y Y Y Y Y Y Y

Ly A LD (2832—)
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HAZ L s a2y hua—UZx L CUFT R — N &R T 2R0IC, TDJ TAEZNEE
1TT57 75— g ~DT VAR L TBLERDHY £9,

Z 2T, Javaboutique W AKX L+ —LF vk + 7T A& ETr Eclipse 7RV =7 b
ER LET, AllLights 7 7 A7 7Ly e LTFEITTE D720, WAZ L3 ha—
NEGTBMOT 7V r—a VITNEH Y T8 A,

Eclipse T Javaboutique > F)LZFERA L TH L IVJava TRO =Y FEERT BIZ
X, ROFIEERITLET,

1 Eclipse #317L, [File] > [New] > [Project] %R L £7, [New Project] &1
TRy Ry AREEET,

2 [Java Project] %R L, [Next] %27 VU v 27 LE7, [New Java Project] #4171
TRy APEEET,

3 [Project name] 7~ v 7 A(Z Javaboutique & AJ) L E7,
4 [Create project from existing source] 47> =3 VR L £,

5 [Browse] A"% > %2V > 27 LT, <UFT Java Add-in Extensibility SDK 4 X k—
JL = Z# L4 >\samples\Javaboutique\src 7 + /L Z ZHR L %7, [OK] 227V v~
L, [NewlJavaProject] A4 707 « Ry AZRD £7°,

6 [Finish] #7 U v 7 L, Javaboutique DV > 7 )b« Y —A « 77 A L Z&HEH LT,
FHLOD Java 71 ¥ = 7 MHMERCE IVE T, [Package Explorer] % 712, Javaboutique &
WOLHTIOFR T a0 =7 NRFRENET,

3 : Eclipse THLW v Y= 27 b &AERT 2 FNEIE, 75 Eclipse D/N— 5 1T
FoTRAEDZZERHY T,

Javaboutique 7' ¥ = 7 FRMERR I NTZD, YuV=s FERBBELTHNREZERLE
7, Javaboutique\src /X 7 — -« 7 4L X |Z1E, org.boutique.toolkit /X — 3
EEFhTCnET, 2oy —TIZiE, AllLights, AwtCalc, ETextField &9 3 >®
HAZ L Ay ha—ARNEENTNET,

Z DLy AT, Javaboutique 1 A K L -V — L% » MNIKT 5 UFT Java Add-in
Extensibility 7”11 2= 7 k & AllLights D% R— b « 7 5 X &2{Ek L £,
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AllLights 33 X O AwtCalc D73 — h OBE#LOY- 7 L%, <UFT Java Add-in Extensibility
SDK 4 YR b—JL - 7 # )L & >\samples\JavaboutiqueSupport 7 + /L Z 2% ¥ £ (=
DY TNEFEHTTTaAT5581E, FiboTlavaZ 7 2% 3L 3 L D080
HoEF),

WROFNET AllLights 77V r—3 3 &7 LT, AllLights = >~ @ —/LO@i{F & BLfig
LET,

[Eclipse Package Explorer] % 7 C, org.boutique.toolkit /< 7 — 2 ® Allights.java 77 7
A%47 Vv 7 L, [RunAs] > [Java Applet] % 4R L %9, AllLights 77" U 77—
va rUBHEET,

& Applet Viewer: org.boutique.toolki... [l[=] [E3

Applet started.

TL—bNOSESERGEHE7 ) v 7 LET,

> 7y FEBOIESERGHMEZ ) v 73258, REOL—L &y MIESNWT,
SEIFERTA MRA Y (F72idEA7) IZ720, LightOn & 7 % & LightOff 7 o
ZREFSNET,

> [RESTART] A& %27 Vv o 35L, §_XTOTA MRA 7Y £, LightOn
H oL LightOff 1o ZixzhildbdCEFTSNET,

> ZOMOMEEE 7 Y v 7 LTHMHEZ Y £HA,

> ZOF—LADOBRMETRTOTA ha A icT52L T, 7TOTA bRF VI
72% & [Congratulation] DA v EZ—UNERINET,
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AllLights 3> FO—JLDHR— kDO FE

Z ZTlE, AllLights =22 b r— L OBIED UFT AR — h 258 L, 95— [hRH
Lo TR Y R— HHOF =y 7 URANMIONWT) OBEMIZEXT, 249 3— [H
AL N7 TFA Y R—FNHEOF =y 7 UANMN IZFRALET,

ZOEOITIE, DAL ary b a—LVEGLT T r—a EETL, ATV

ke 2, F—=U—R:Ea— it 7T ar2HH L CUFT OBLENLHSIT 2T
D DN IE TI,

1 AllLights 77V — a3 v#RTLT, UFT 2RHEE T,

a AllLights 77U —2a VR TTIZIFATEINTWDIHEEIE, 77V r—var
NEROEBO X H22D X2, TV r—var - V—n =25 [Applet]
> [Restart] %R L FE 7, AllLights 77U 7r— 3 ViR E7EFIT IR TWRWE
1%, [Eclipse Package Explorer] % 7 C AllLights.Java #7477 U >~ L, [Run As]
> [Java Applet] ZER L THEITLET,

b UFT #BAVC, JavaAdd-in #2— F L £,

2 ATPxH b RIA#EFEALT AILights DFTANT 4 EAYY FERTRLET,

- a UFT T, GUITA FEBE, [W—I] > [Tz b ANRA] 2RIRT D0,
(ATSzH P RIL] V=N R—  RE %7 )7 LT, [FT7V=27 b AN
A1 FAT7al Ry 2&M&E+, [FankF«] 472270 v7 LET,

b (7= 20 ] 8470l - Ry AT, ELTA2v%27 Y v/ LT
26, AllLights 77U r—ar %27 U v 27 LET,
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AllLights = > h & — L%, UFT ¥R — R 23AAIA F 4172 JavaApplet ZHE5E L E T,
0=, 77V r—3a % AllLights &) 410 JavaApplet & L T8k L
FT, BRINDT A 2 IIHEARED JavaApplet 7 T ADT A 22700 7,

& Object Spy (5
[ |SE G

Qbject hierarchy:

Properties | Dperations]

@ Mative () |dentification
Properties Yalues -
A Clags Mame JavaPpplet
P 1030
oy abs_p 171
oy attached text
o backaground white
T class description window
o class_path sun. applet.Appletyiewer jave
1 developer name framel hd
Selection:
Class Mame
Dezcription:

Descriptions are available only for test object operations.

Cloze

FTTV 2l b AL EAUET,
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3 AllLights > FA— )L EDREEZEHRLET,
a UFT T, [RB8}] > [ESRERTRERE] 28N L C, [Risk s FTREERE] &

AT7al Ry 2%M&EE+, Javal #7T, [BAVTWSTRTD Java7 F
Viyr—oa v TTRAMERELTETTS] 28R LET, Web 7 FA b —
rFENDEHEIE, (Web]l #7 %2710 v 27 LT [RAWVTWATRTDISHFTT
A MERFELTRITTS] 28R LET, [OK] 27V v 7 LET,

(Rigk] A& %22V v r 3250, [BBER] > [BR] 2BRLET, 7V v,
[RESTART] "%, B 27 ¥, Alllights 7 7V 7r—a v NOSEE8E 7R
LiiiE s Uy LET,

Vw7 FTHENT, FHLOWAT Y 7R TF 2 MBMENET,

Item Operation | Value Documentation
v & Actionl

+ O allLights
LE alllights Click 142,144, "LEFT":Click the "allLights" applet with the "LEFT" mouse button,

42 allLights Click 16,188,"LEFT" Click the "allLights" applet with the "LEFT" mouse button,
i AllLights Click

(Bik] AZ2 22 ) v 7350, [RBE] > [BLE] 28R Gkt yva vz
BTLET,

AllLights &9 JavaApplet TP Click #4FiT, KL~V EEROFEMERTIIE (x
JERE L y SR LN Y v 7 BET LI TR RE ) RO Y v 7 T,

4 AllLights > FA—IBBTIHREL - Y—ILExy FERELET,

ay br—UIKkT D UFT AR — b &2RET 2581, 43y —AFy hoar 7%
ARTITVWET, 2OFa— R U TADREDIZ, AWT 245ET 53 2D 7 T R
(AllLights, AwtCalc, ETextField) % ¥ & # T, Javaboutique & N9 A X L+ Y — )L
X hEBEEKLTWET,

ZDO Ly AT, Javaboutique Y — /¥ v b O AR — M EAER LET R, KX
AllLights 7 7 A D&% HR— s LET,
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5 hREBL VSR -YR—MHEFT VI VA MERERLETY,

ZOFIETIL, AllLights = & b 2 —/WIZHE YR — M & FHE L, YR — FEHEF = v
JUANMIELDHET,

YR—FTDHAZL - VT AERELET,

AllLights 57 A &% 2+ 7 F A%, AppletCS (2L - T UFT L THAHR— K& D Applet
7T AR LET,

Z Z T, UFT T AllLights 283727 7 Ly b & LT, EIT SN DR 70
BV R—bL, 207 a7 4 ZRBETHLERDHY T, 207D, Zoav
k& —/ LI %9 % Extensibility $745— k1B L £3,

TAN AT b VT RAEHALZ L s ay ba—Lilvy 7 LET,

JavaApplet 7 A b« 477 b+ 7 F A% AllLights = > b a2 —/VHOFEARS R—
MEARAE L ET0, RERBHRT AT 4 T AN ATV e AV RET
NRTCHR=FT 20T THEHY EEA, ZD7, AllLights &9 JavaApplet &
JEET2HLWT AL A7 V27 b+ 75 ZA&MER LT, AllLights 7 A X L« =
Yhr—MZwy B LET,

HLWT AL« ATV b 7T AOFFMERELET,

> HILWT AR ATVl b7 TR, ROTA 2277 AL TRINET,
<UFT Java Add-in Extensibility SDK 4 X b—JL = 7 # JL & >\samples\
Javaboutique\AllLights_icon.ico

> TAL - ATV2T e RICERT L OIEETHEA SN LB#T 1 T 4
(T, 7TA, AT v I R) THHTT,

> EHREDT AR « A7V b+ AV v FiX ClickLight T3,

» L AR — b 2857 137 1%, OnCount, OnList, GameOver T3, =
H1E9~T, [UFT Checkpoint Properties] &4 7 17 « R v 7 A CEAETEIN
SINTWET,

ayha—nANhy VL)L e F T2 FNT o RN—=NEREL, TA N FT
Uzl NI&ARTEMT D FEERELET,

> AllLights 2> br—/LiZ by FLUL - 727 R T, Ty 3—TiEdH Y F
A,

> TAL ATV FEOLODLRIT Lights & LET,
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PR— "N RMERR T 0T s ZRELET,
» OnCount : H 3 ETH TR TWNETA FOFERLET,

» OnList: H 2K TH AR5 TVWBETA FOMNBEBEZRLET, 74 MIiT,
TEENGITZ 20 ~24 DFFZVRFHTOHNET, ZDOU R NMIE, Ao
TWE7 A FOFEPEMINET, EFFORNCANN—2A0 1 DEE S
iﬁqo

» GameOver : Yes F721X No OXLFFIT, §XCTHDT A FiRA Uil >oTWD
MEIDETRLET,
PR—INRUBERTF AR« F TV b Ay RERELET,

» ClickLight: 7'V v FNORED T A FD 7Y v 7% Ialb—hrLET, Z
DAYy RTE, 72V v73574 hOfE %<7 Row & Column ® 2 >®D
S EBMETT,

» Restart : [RESTART] R&Z > D7 Vv %3 Il —FLET,

FLERDOY R — N FEERELET,
> BKL~L e v TR« A XX NOFREREA—NN—T A4 FLET,

> VYR AR EEY R LET, 7V v OMEICESNT, FEEkA v E'—
¥ % #%f5 LT ClickLight % 721 Restart B{EZ fldk L £,

WON—=VIZ EROHHRICENTHER L F =y 7 VA MR LET,
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ARBL SR - HBR—FEHEDOFZ VI YR F

HREL - ISR -HR—FHEOF YV UR b

HAB I+ 7T AZUFT HAY b PAR— BRI TR WA= =T FARFEETIHIN? LA

BET 250, WBNO L0 = Fr— USR5 Y H— hE RN <& 07 BEEL

UFT A Y A b= SNTNE AL Ea—F ETHAZ L - av br—L&E73 57 7Y r—ya Vi’ fF
ET 207 [FL

ZDOHAR L avy ha—jb - JTADY —ANFET L5
Javaboutique & LV5 Eclipse 7AY x4 +

HAZ L w2y br— Wl THHFED JavaT7 A b« A7 V=7 MEEnnr? %L

EE B BEEEE

TFELROWGEIERT 28 L Java T A b « A7 V=7 b+ 75 A :AllLights
> HLWT AR« F 7Vl b« 7RI THEREND B O . (FEHE JavaObject) JavaApplet
> T A3y - Ty ANOYRT (K7 a ) <UFT Java Add-in Extensibility SDK 4 > X b—)L +
7 A JL & >\samples\Javaboutique\AllLights_icon.ico
> S ORRE T =T 1 label
> [EUEDT A « ATV b AV v R ClickLight

HAR L s ayba—LE by 7L« F T2 b2 (LY

TAB D ey ha—)LELT v/8—=mn? LWZ

TAN ATVl FOALRIOREELIEE "Lights" &LV & AT & E

EEEE

PR— T BT 0T 4 BIEL, EEREDTF =y VR A b OTaRT 4 ~—0T5
OnCount, OnList, GameOver (FzyvIRA Y FTRETTIRTERSIND)

E

PR=DFTLTAR ATV b AV REFZETD (MBEIIECT, 5IRERVELFIATD)
ClickLight (Variant Row, Variant Column)
Restart (51%7% L)

FLEkE VAR — T 50?7 (AWT _"—AD&H) [

ZOYE, FlEkE MU TT AR FESIZ

MouseEvents
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UFT Java Add-in Extensibility 70> =49 ~D#EER

Z Z TI%, Javaboutique ¥ —/LF v b« bR — FNHOT B V2 F N EFHFIER L T,
IR #E4T 9121, Eclipse T UFT Java Add-in Extensibility 77 7' A 2 L » CHEftE D
WO T 4 F— REERLET,

1 New UFT Java Add-in Extensibility Project ©7 1 *— K£B& %9,

a Eclipse T, [File] > [New] > [Project] Z®iRL £9, [New Project] ZA 7
vz - ARy 7 A& £7, Unified Functional Testing 7 + /L% Z & L, UFT
Java Add-in Extensibility Project 3%k L %9,

& Mew Project

Select a wizard

@ Java Project
& Java Project From Existing Ant Buildfile
----- @ Plug-in Project
-2 VS
H-[== Java
H--== Plug-in Development
=== Unified Functional Testing
UFT Jawa Add-in Extensibility Project
H--[== Simple

b [Next] #7 U > 2 L¥7, [UFT Java Add-in Extensibility Project] /3B X £,
Z O OFEMIL, fEHT 5 Eclipse D/3—V g VK- TRAEZZENRHY £,
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2 UFT Java Add-in Extensibility 7O x4 FOFHEZEAALET,

a [Project name] 7~ v 7 A2, JavaboutiqueSupport & AJjL %9, [Create
separate folders for sources and class files] #ZR L £9 (UETOA—T 3
@ Eclipse TlX, ZOA 7 a > DFK5EIE [Create separate source and output
folders] L7 > TWET), ZOXAT T « Ry 7 ADOFEMIZOWTIL, Eclipse
DT BTSN,

&= New UFT Java Add-in Extensibility Project

UFT lava Add-in Extensibility Project

Create a UFT Java Add-in Extensibility project in the workspace or in an external ﬂ
location.

JawvaboutiqueSuppart

b [Next] %7 V v 7 L%9, [Custom Toolkit Details] HENFRINET,
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3 WREL-Y—LFy FOFBEANLET,

ZOMEETIE, R TAIRAZ L Y —AFy kPR —K-Ey  ET 4 F— T
ERTE D X H1Z, Javaboutique Y —/L & v FOFEMAEREL £,

& Mew UFT Java Add-in Extensibility Project

Custom Toolkit Details

Enter the details Far the custom toolkit you wank to suppart.,
The support toolkit and its name are created based on these details,

WOFEMIEREAT LET,
a [Unique custom toolkit name] |Z Javaboutique & AJJ L,

b [Support toolkit description] 7~ -~ 7 22, Javaboutique toolkit support & AJJ L
E9,
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€ AllLights 7 2% I+ 7 5 2T AWT 2 K—3% > F ZH5IE 5 729, [Base toolkit]
IIERERED AWT O I LT E £,

d [Custom toolkit class locations] ik T [Add project] %7 U~ 7 LT,
Javaboutique YV —/L % v OB A Z L« 7T A% ETe Belipse O Java 7R Y = 7
b &I L FE 9, [Select Project] & A 7 12 « K> 7 AW &, BIFED Eclipse 7 —
JAR=ADTu Y =7 FINERENET,

& Select Project

O= mageControls
O'= ImageControlsSuppart
O Javaboutique

e [Javaboutique] ¥ = v 7 - Ry 7 Z&@EIRL £+, [OK] 227 U v LET,
Javaboutique 7’1 = 7 k7% [Custom toolkit class locations] 7 v 7 22BN S
WWET, [Finish] 227V > 27 L¥J, [Project Summary] EE2HH& E7,
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4 [Project Summary] EIEZ&RLET,
IurYxy hOFEHMEHRLT [0OK] 227V v 7 LET,

& Mew UFT Java Add-in Extenszibility Project

Project Summary

Reviews and confirm the project properties,

Project Information

Project name: JavaboutiqueSuppoart

Location: C:/MavaExdensibiltyivorkspace_final

Project JRE Compliance: Default Compiler Compliance (1.4)
Source root folder: src

Clazs roct folder: hin

Toolkit Information

Custom toolkit name: Javahboutique

Suppoart toolkit description: Javaboutigue toolkit support.
Base toolkit Mame: 24T

WDAAZ I Y —Fy bk« FR—b vy NOERN Ry r—T L7 7 A4 V%
fEF LC, # L\ UFT Java Add-in Extensibility 7' &2 3 = 7 k JavaboutiqueSupport A3 {E
ENET,

>

» /X /r— com.mercury.ftjadin.qtsupport.javaboutique.cs

> Configuration 7 + /1% (TestObjects 7 + /L& L H LWV —/LF v FRET 7 A

) Javaboutique.xml % & i¢)

% /r—3 com.mercury.ftjadin.qtsupport.javaboutique G L\ > —/1F%» | -
PR—h « 75 R+ 771/ JavaboutiqueSupport.java %z & ir)
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FarvBa—F EIZEEDIRE BA VA F—LENTWDHEAIL, Javaboutique 7' 1
Y= 7 k& JavaboutiqueSupport 727 N TRIUIRE N—Ta U AEHTH L 51ICL
TLEZEWN, RILIRE A=V a VEHFALTHARVWESE, Cbbno7av=y bo
JREZZEHELT, MUA—=Ta v EEAT5L91CLTIEE N,

UFT hRB L« HR—F - 7S5 AOEFRER

Z ZTIZ, Javaboutique ' —/VF v MI@ZEN S AllLights = ha—/LDH AL L« H
R—h 7T ABMERLET, ZTNEFTHIZIE, Eclipse T UFT Java Add-in Extensibility
TIITA Lo TRt S D WT DU 4 F—FEALET, &0« F— NHEi#E
T, BAZ L HR— MHEONFICEGDLE GEIZRELET, M<HETIE, Vg
PF—=RIZEoTZD7 T ANHER SN D A Y v ROEEZRITNET,

FEROHETIE, ZOLy AVCHET 2T P — REROA 7Y 3 SO0 TOR
HLET, V44— NEHCTIRETEX 2 TXTOL 7> 3 oL, %5 % [UFT Java
Add-in Extensibility Eclipse 77 7 A O] 2B L T 7230,
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1 New UFT Custom Support Class 9 ¢ ¥— FZBIE £,

a [Eclipse Package Explorer] # 7T, #iL > UFT Java Add-in Extensibility 7' 7 ¥ = 7
I JavaboutiqueSupport % 3R L £7°, [File] > [New] > [Other] Z 3R L
FT, [New] AT 0T - Ry 7 ARHEET,

Select a wizard

€ Interface
@ Java Project
& Java Project From Existing Ant Buildfile
‘EFS}- Plug-in Project
&= Product Configuration
-2 CYS
H-[== Java
H--[== Plug-in Development
=== Unified Functional Testing
L BB8] JFT Test Custom Static-Text Support Class
i UFT Cuskom Support Class
UFT Jawa Add-in Extensibility Projeck
H--[== Simple

b Unified Functional Testing 7 =+ /L % % J&£[# L, UFT Custom Support Class % i
WLET,

¢ [Next] #27 Y v 27 L%9, [Custom Class Selection] M FE RN ET,
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2 Y R—rFBHREL-VFRERBRL, Y R—bF-VFRDFTL a3 VEH/E
LEY,
a org.boutique.toolkit /< /77— ® AllLights 7 7 2 % &R L £7°,

& Mew UFT Custom Support Class

Custom Class Selection

Select the custom class vou want to support, and set the relevant options For the corresponding ’?T
support class.

org. boutique. koolkit Bl java.lang. Object
: m E--java.awt.CDmponent
3] ETextField Bl java.awt. Containsr
e [ kCale El- java.awt.Pangl
=N java.applet. Applet
org. boutique  koolkit, AllLights

[aigiscs

AllLights 7 A & 2« 7 Z A%, UFT ETH AR — b X5 java.applet. Applet & 53R
LEd, TD7H, AllLights 77— - 7 Z A%, Base support class:
com.mercury.ftjadin.qtsupport.awt.cs.AppletCS Z{LiE L 9, TOREE,
[Controls of this class represent top-level objects] = v 7 « /R v 7 A3 & HE
TERRENET,

b —0oF=v/ - Ry 7 XTERLAZEFICLET, ZhiE, UFT T AllLights = >
fR—NETAL - F T2y NEEOR LD Java T A « 707 bEL
THRBT DVERDHDHT-DTT,

C MR FEDONAK L PR —1b 27T 24 (AlLightsCS) #ZDFEEMHLET,
d [Next] #27 VU v 7 LE7, [TestObject Selection] MifiNFE R IIET,
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3 AREL-AVFA—LERTTAE-FTOzHO - VSRERBRLET,

ZOWETIE, WAA Lo ba—LVET AL A TV2T b FJ TRV
JL%Ed, UFTGUI DT A NTIE, BDAX LI TR arba—UL, ZOTA k-
FT2 I N ITADT AN ATV Mo TEINET,

& Mew UFT Custom Support Class

Test Object Class Selection

fap the custom class to a UFT test object class.

JavaObiect |—

lAllLights == > b @ —/L D% R— L OFHEOFIE 5 2473— 25 M) TIZ, AllLights
HAR L« 2y hr—/L%& JavaApplet ZILIRT HHLWT AN - ATV b I T
2 (AllLights) IZ~ v B 742522 R0OFE LR,

a [New test objectclass] =7 a v ABIRL, HILWT AN AT Vxs b7
S 204 TE LT AllLights & AT LET,

b [Extends existing test object] U X T, JavaApplet Z# R L EJ, ZDVU =R
MZIE, UFT THREV AR — RSN TWDLTRTO Java A7 V=7 EREFN TN
FP, DAL L -V R=MHTEHLWT AR AT V=7 bEERTDHE, Z
DT AL« A7V FH YA MOBMENET,

¢ [Next] #7 U > 27 L¥E7F, [Custom Support Test Object Identification Properties] [Hj
HARTRSINET,
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4 AllLightsCS TEETITAM A Iz H FREBIONRTs DY FEREL
E3 R

OB, ELEIELTVAR—R « FR—F « Z7FZATHR—FENTW
LR TaNT oL, RLET AR - ATVl b JTATEREINTNC, F
ZHFR— kSR ThayviBnra Xy o RFERENET, ZO®E T, FR—
FEEFITH LVEE TA— =T 4 RT257 037 ¢ OFIR, BLOH LT R
T4 DBMETH ZENTEET,

& Mew UFT Custom Support Class

Custom Support Test Object Identification Properties

Determine the set of test object identification properties that vou want to support For your custom contral,

O @Eabs_}c @ maximizable
O @ abs_y @ maximized
O @ attached_text @ mic_if_handles_windows
O @] background @ minimizable
] @ dass_path @ minimized
a @ displayable @ resizable
O @ displayed

O & enabled

O @ focusable

] @ focused

O & foreground

a LMOFFBITIL, AppletCS THR— MRFIEIN T HFEIRT 7 /8T ¢ BT
TERENFET, INOLORFB T 0T 4 O R— L, #H L AllLightsCS W
R—=b 7T AL > THRENET, 2OV A FDIFEAED T 8T 4 1%, 1=
SR TEDFETHITT,

[label] = v 7 « Ry 7 A% RINLET, V4 P—RIZLDIFR—F - T77 11
DERNBET Lich, 207 a7  OBGFEOY R — e DAL Lar fa—)b
D=—RZEPEIEN AR LFETH—"—F (4 FLET,

b HAHOFTFHICERENDEM T 18T 113, AppletCS THHR—FENTHARN
JavaApplet D7 137 4 T, ZNHDO T 187 1%, AllLights DV R — MMIME
HYFEFA, TNHEHERLT [Remove] 227 U v L, [Yes] 27V 7 L
THELET,
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INHOFE T 1T 4 1%, JavaApplet T A b - ATV b o 7T AITESNT
ERR &7z AllLights 7 A « A7V b+ 7 T AOEBRICEENE T, DV
A R BEIEE L7 87 4 0F, AllLights = b — L CTHR—bFESNEHA, 2
NHEOTaNNT A IZTUFT A7 V=7 b« AL ICFRENDIRB#H T 0T 4DV
A MIFSIEFmERREINETY, HIZHY WA,

c TAllLights =¥ Fa— O} KR— hOFHE] OFIE 5 (247 X—TY%5R) T,
AllLights 7 A ks + A7V =27 N ETCHLOVBR T e AT 42V FR— b 452 L%
WHFE L, WOFIETIE, N7 F 45T AR F T b 752
WCHBERBINT BT 4DV A NMIBMLET, VAP —RIcLsR—hr-77
ANVDERNBTT Lizh, ZbD7aTr OV R— MaFEELET,
INODEBHRT O RT 41, TAL ATV b I TADOERITBMENE
T, TNE, TOTZTADTRTOT AN - A7 V=7 ML, UFT OFB#7
ONRTF 4 DY A NIHF LT RNT A RBINENRD I EEERLET, HILL
AllLights 7 Ak + A7 V=7 b+ 7T ARERTD2DEZDTHTT,

5 AllLightsCS TRETAHFLWLWTA L -AT2z ) brBEBIONRTEZEBMLET.

a [Additional properties required for test object class] £/~ [Add] 27 V »
2 L% ¥, [Identification Property] A 717 « Ry 7 ANRPHEET,

& Identification Property

b [Name] "> 7 ZiZ, OnCount E AHLET, [OK] 227V v 7 LT, HLWVWER
a7 2 A MEMLUET,

ZOFNEEEYIK LT, 7 v/37 ¢ OnList & GameOver B L £7°,

d [Next] #2 VU v 2 L%7, [Custom Support Test Object Methods] A3 F R~ S 41
i‘g—o
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6 AllLightsCS TEETITA M ATz H - AVYYFDEY FERELET,

ZOWEICE, BRLEFT T2/ hc VITRATERZESINTVWDLT AL - F TV
he XYy RRFRENET, ZOMWETIE, B LV T R— MR 2134 —
N=F 4 RTBHAY v ROBRIR, BLOHLWAY v ROBMEITY ZENTEET,

£ New UFT Custom Support Class

Custom Support Test Object Methods

Determine the set of test object methods that vou want to support For wour custom control,

=
L
Dg‘ Click {Object arg0, String argl, String arg2, String arg3)

DEI DhIClick (Object argl, String argl, String arg2, String arg3) ’7
0] MouseDrag (Object arg0d, String argl, String arg2, String arg3,

DE‘ Type (Object argd, String argl)

A DOFRPEIZIE, AppletCS THAHR— MR FEEINTWND BIRLET A - 47
VxR VTATERENT) TAR ATV b AV y FRTRTERSN
9, INGDOT AR - AT V=7 b« AV vy ROV FR— M, AllLightsCS (2 &> T
WARSNET, A—NN—TA FTDHRAY Y REBIRTZXLEIH Y THA,

FHlDOFRHIZIE, Alllights T A b« A7 =27 b« 7 7 AHITEFRE SN, AppletCS
THR—FENTORWVWT AR « TV b AV y RRFERENET, BUE, #%
YF D52 Yy FEERSNTWERA,

[AllLights = > s 2 —/LDH K — NOFHE | OFIE 5 (247 ~— T %5 M) T, AllLights
TAN - FT7V2 NETHLWT AN ATV b« Ay REYFR—-bF5Z
EERDELL, ZIZTIHE, ZNHDAY Y RETAN ATVl b 7T AT
BRBMT AN AT V=27 h e AV ROUAMIGBINT2LERS D ET, 7o
P=FRIZEDIR—bF « T ANVDERNPTET LD, BT 252y ROPR—
IELET,
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TAN AT F e Ay Rk, BEOT AL AT V7 b - 7T RGBS
NET, 2L, TOVFADTRTDOTFAL - A7 V=2 ML, ZnbD47
Tl FTYR—FEINENE I NCERRL, UFTIZH LW A Y v RpBnaEhb
ZEEBWLET, UFTGUIDOT A FTIX, A7 V= MZHTD5T7 AL - A7V
I b AV RENRRHLT, 202X Yy KRR —FINTWRWES, FITRT
F—0FEAELET, HrLWAlLights T A b « A7V 22 b« 7 T AEB/ERT HDIEZ
DI=HTI,

a [Additional test object methods required for test object class]# =~ [Add]
7V v LET, [TestObject Method] ¥ A 7 27 « RNy 7 ANKRRINET,

& Test Object Method

> [Method Name] R > 7 22, Restart © AJJLE7, Restart 7 A b « A7V«
J ke AV y RIZIE, BAZ L a3 ba—/LEETHED obj (Object) LISt
DOFIEIIVEDH Y £H A,

> [Method returns a string value] &= v 7 « &R v 7 A TR S L7REED
FFEICLET, ZTOAY Y R, V¥ —rv - a—FROHEERLET,

» [Description] R v 7 22, WO L HICATILET : [RESTART] RE2 2%
Yy LET,

» [Documentation] =~ 27 212, kDL I AN LET : [RESTART] RE >
U9 LET,

» [OK] #27 Y v 2 LT [Test Object Method] A 7 a2 « Ry 7 ZA%HALT,
Restart X Y »v K& U A MIEBMLET,
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b [Add] #6527V v/ LT, BIOF AL - A7 V27 b« AV w KEBML
F 9, [Test Object Method] ' A 7 1 7'+ R v 7 AWRBAWZ &, IROBAEE FITLET,
» [Method Name] 7~ 7 Z|Z, ClickLight & AJJ L £,
» ClickLight £ ¥~ KiZ5[¥& LT Row & Column BN L £,

> [Arguments] fEi% T, [Add] %2 U v 27 L £, [Test Object Method Argument]
HATaT « Ry I ARERINET,

& Test Object Method Argument E

[Name] &> 27 22, Row & AH LT,
[Type] &>~ 27 AT Variant %&£ 7 (String %8R L7234, ClickLight
A Yy REHEHALTUFTGUI OF A MIAT v 7 &8MT 512, 17& 505
BESI AT CHLLERDY £9),
[Mandatory argument] = > 7 « AR v 7 A TRINS N REOE FIZ L ET,
[OK] %27 U w2 LT [Test Object Method Argument] ¥ A 717 « Ry 7 A%
FAL, ClickLight 7 A b « 7= 7 k « XV v ROFED Y 2~ Row 513Kk
ZBMLET,

> ZOFNEABHEVIEL T, Column31%%& YU R MIBMLET,

» [Method returns a string value] = v 7 « 7R v 7 Z 3B S - kEED
FFEIZLET,

> [Description] &> 7 212, ROLHICANLET HBESNESA4 &2V Y
JLET,

» [Documentation] 7R >~ 7 2|2, IRD X 512 A S LE9 : 4T <Row> FI| <Column>
D54 rEIY 9o LEFT M 220 07 LCMilT 255 ®mIRL, ASL
72 LD <Row> 518 & <Column> 513% A7) L £7, [Documentation] 7>
JADTFAMIBMEIZRO L2720 £ : 1T %al §l %a2 D54 L&Y
Jwo LET,

» [OK]% 7 U v 2 L C[Test Object Method] %' 7 2 7'+ 7R v 7 A% [ U, ClickLight
AV F&EYZMIBMLET,
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¢ [Next] #7 Y 27 L%79, [Custom Control Recording Support] ¥ o ' — RO
NERRINET,

7 AllLights 3> FO—)LTORFEVR—FT 528, VIRVTEIRUEDEY
FERELET.
ORI, EEAGRRLEYR—K - 772 THR—-FERDZA N0 b VX

—

FRFRENTET, ZOEETIE, LWV CTEELZ A —NX—TF 4 K95V 2D
B, BIOSEETIZH LA b - VAT OBMEIT) ZENTEET,

& Mew UFT Custom Support Class

Custom Control Recording Support

Determine the set of events that trigger recording.

DgcomponentHidden {ComponentEvent argd)
Dgcnmpnnentmnved (ComponentEvent argd)
DgcomponentResized {CormponentEvent argd)
Dgcomponentshown (ComponentEvent argd)
DgfocusGained ({FocusEvent argl)
Dgfocusmst {FocusEvent argd)
ngeyPressed (KevEvenk argl)
DEkeyReleased {KeyEvent argd)
DEk&yTyped (KevEwvent argl)

D FR- A TIE, AppletCS TEESN TN D U AT %S TE £ 3, AllLightsCS 7
AL L YPR—b - 7 TATE, TNHEA—=TF4 FTOLETH Y A,
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FMOEARFETIE, AllLightsCS (BN 2 U AT A ELE T, BIRL& D 2101,
HAB I s FR—=F « 7 TRBNMT LA NN KT - XYy ROy Mg
ATVET,

a [Add] #7 Y v 2 LT MouseListener ZB1L £7,

[Listener] # A4 72 « Ry 7 ANREXET,

ok | oo |

[Listener] U 2 k)5 java.awt.event.MouseListener Zi&{R L, [OK] %7 VU v
7 L¥Ed, [Listener] ¥ A 712 « KRy ANHE LT, MouseListener & Z 11
BENDTRTOANRU LNV RT e 2y RPY ¢ HF— Rl O 4 M O R
DU R MaBMEhET,

[Custom Control Recording Support] EiifiC, WOEHIELFEITLET,

» [Treat controls of this class as wrapper controls] = v 7 « Ry 7 X%
R LET, ZOF v - Ry 7 AMEECTRIRSNREBICR ST E
9, iU, AllLights 7 7 A7 java.awt.container % JiiE 572 T,

> [Override low-level mouse event recording] = v 7 - R v 7 A %RIRN L C,
FERLIZWA R FORD VIR L~ - A R0 b (BEES— 2 OEME) AE
sk iz LET,

€ [Next] #7 VU > 27 LE7, [New Test Object Class Details] M3 F/R I ET,
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8 HLWFRI-FTZxH k- V5XAllLights DFHEERLET.

COBETIE, WAZ L ary o=l y BT HEOIER L TWDH L
TFTAKN ATV T b I TAOFHMEERELET,

&= New UFT Custom Support Clazs

New Test Object Class Details
Specify the details for the new test object dass AllLights.

foreground
handle
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ROFNAZFTLET,

a

[Test object icon] T [Browse] %7 U >~ L, <UFT Java Add-in Extensibility
SDK 4 Y X b—JL * 7 # JL&F>\samples\Javaboutique 7 + /L % % L T
AllLights_icon.ico 7 7 A /L& #R L £ 77,

[Identification property for unique description] 7~ v 7 AT, &K X7z label
TanRT 4 EEOEEICLET,

F: T AP ATV FRERICEFE T 0T 4 2BNT2LEE, TAN AT
Vel MREZ 7 ANTINEFHTHET DLERH Y £9, FEMICONTIE,
144 ~=*—7 T[New Test Object Class Details] ] ZZH LTI ZIW,

[Default test object method] U Z hC, ClickLight %33R L £ 7,

[Default checkpoint properties] 7"~ 7 AT, @IREADOT /T 4 2ZDFEE
\Z L C, GameOver, OnCount, OnList = v 7 « Ry 7 A& TR L E T,

[Finish] %27 U >~ 2 L%, [Custom Control Support Class Summary] & 7337~
INET,
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9 hRAL-avbtA—=)L-HR—F+-HISRAOHIYVERTELET,
HAB L FR—=bk 7T ZAOFHBANEEZHZRLT [OK] 227U v 27 LET,

New UFT Custom Support Clazs

Custom Support Class Summary
Review and confirm the skructure of the custom support class, :.'l{?

General

Custom class: org boutigue toolkit. AllLights

Support class: AllLightsCs

Basze support class: com.mercury fjadin gtsupport ant cs AppletCs

Test Object Identification Properties to Override
label

Additional Test Object Identification Properties to Implement

Test Object Methods to Override

Additional Test Object Methods to Implement
ClickLight (Ohject okj, Yariant Row, Yariant Column)
Restart (Ohject okj)

JavaboutiqueSupport 7' 2 ¥ = 7 KN TIE, ROEBITHOILTNET,

> HLWUFT #AH A - R —F - 75 A (AllLightsCS) 73
com.mercury.ftjadin.qtsupport.Javaboutique.cs /X v 7 — VITER SN TV E

T, ZOT AT, FROFRFHREOZ TICFRREINET,

1 LV JavaboutiqueTestObjects.xml ~ 7 1 /L3 Configuration\TestObjects

7 A NVEIHER SN TWET,

Javaboutique.xml 7 7 A VN EEINTWET, 77 A /UZEZNBINS N,

AllLights &7 A % 2+ 7 Z A8 AlILightCS R— |« 7 F R v v B 7 3nET,
ZDT 7 A NOFEEIZ-OWTIE, TUFT Java Add-in Extensibility Toolkit Configuration
Schema ~/L' 7] ([Java Add-in Extensibility SDK ~/L "] TR #[fE) Z#&M L T

<TEEWN,
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AllLightsCS 7 7 2 1 L O JavaboutiqueTestObjects.xml ~7 7 1 /L D FEAMIZ DT
1%, 269 X—=Y BRI LWHRAZ L« HR— K - T 7 A MZDONT] ZBRLTIZIN,

AllLightsCS 7 7 1 /L4, (AllLightsCS % 7)) OREOT AZ YR (*) 1%, 774/
DIRAFEVTET LTWWRWZ 2R LET, Vg — FTITO 2 ETIIHEITKFET
D7, R—BBELRVWES LT ETLRET OLERDHY £7, [File] >
[Save] ZEIRT %57, [Save] R¥ %27V v LET,

FLWHRAL -HR—Fk+ T7ALILIZDNT

New UFT Custom Support Class 7 « ' — RIZ#E TERIZ, HLMER LY T 252y — L
Xy NRET 7 ANMTEEL, ROT7 7 A NVEERLET,

> AllLightsCS.java: = ® 7 7 A JLIZiX, # L\ AllLightsCS R — bk « 7 T AR &£
jij_‘o

» JavaboutiqueTestObject.xml: = @ 7 7 A JLIZIZ, Javaboutique > — /L% v b« $ R —
FRICEBZRSNEHLWT AR AT V=7 b 7 ITAREGEENET, ZORET,
HETAHT AN AT V=T b 7T AT AllLights O 1 2721 TH,

DIBEDETIE, AP —RZEkoTInNbD7 7 A VHITHERENDARKICOWNTH
LET,

AllLightsCS H R A L - Y R—F - V5 RIZDT

169 X—y [T nigary ba—nOYR—NHFEOFEE OLy A 2BUT, Vg
P—RBHF LN RAZ L PR — b« 75 RHERT BERN R ERIZHON LT TIZ
PR T E TWET, # L\ AllLightsCS.java 7 7 A VONEERRFEL, IROAY v RF&
HE XA LET,

» AllLightsCS 77— « 7 7 AD'ES : AppletCS VAR — K « 7/ T R &EPLR L,
MouseListener { > % 7 = — 2 &2 FE3H LU £,

» DEBUG_ALLLIGHTSCS 7 7 V7 DEE : v « X vk —Y D)2 HI5 5 DI
TEET,

%
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» AllLightsCS =2 X FJ 7 % - 2 » K : addSimpleListener % MO L C,

MouseListener % AllLights = > s B — /L TOBRGENRME/R Y AFD Y A MEML
£7,

> to_class_attr £ Vv K:iLWT A heA T V=7 b7 7 24 AllLights 2R L 9,
> super.label_attr 2iX7" label_attr O A Y v R+ 2% 7 AR T ~VIZEESHZ D

TENTEET,

oncount_attr, onlist_attr, gameover_attr X >~ KO XY v K+« 22X 7 BIILT-
BT aNRT 4 Y R— b T OO EETOINERNH Y 3, FEETLHETOM,
INEDA Yy RIINul ZIRLUET, ZiUL, 2B BIMENZHLWA Y v KT,
AllLightsCS THBR SN D A — 38— T ATEREIN TNz TT,

v F— FEECIRET 50T 08T 1 4T, KXFEHAT S EARTE
T, ELEANIRT A b - A7 V2 MRET 7 A MCEOE Eb SRET,
L, INLORBIT 0T A OYHR—F - AV y FOAHNE, Va4 PF—FiTko
TRELFANLFICE S ME SNET, UFT TR, Bl 057 4 ANCFEORT
#RENET,

Restart_replayMethod i5 L O ClickLight_replayMethod 2 Y v KD X Y » K« XA %
TOBMLET AN ATV b XYy REYVR— M A0 EET BTN
b FEF, BEFTHETOM, ZNHOAY Yy RiFZTF—+ a—FK
NOT_IMPLEMENTED %#i&E L %7,

> mouseRecordTarget 2V v K KL~ - v TR « ARV FOFigRE A —"—F 4

R4 2572% null 2K L %7,


JavaExtAPIRef.chm::/com/mercury/ftjadin/infra/abstr/ObjectCS.html#addSimpleListener (java.lang.String, java.lang.String, java.lang.String)

FIOE-EMLIL FO—ILDOYR— +FEOFEE

> MouselListener { > % 7 = — A TERINDA XK« N RT e XYy R
(mouseClicked, mouseEntered, mouseExited, mousePressed, mouseReleased)
HOAYy KRBT, ZNHDORAY v K 2F 7120, SLBEIZIHG L TEET S
(MicAPLrecord ZIE M LT A v —% UFT ICET3) SERHBLZ L%
RTAAY IBREENTVET,

> is_window # v | (true #iX9) 7% AllLightsCS V-7R"—k « 7 Z R ZiBMEnE L
72o Z#UE, [Custom Class Selection] i T [Controls of this class represent top-
level objects] F = v 7 « Ry 7 AEBRLIZTZHTY, TAL - A7V =7 hD%
BHFZ, UFT iXis_window * ¥ v REFFOH LT, BAT V=7 F&ETH, Z0
FTV 2 NEBBEBNOER EN D Java A7V =7 bE LTERTAIDEZHRELET,

Javaboutique TRA bk = AT H FERET 7AILIZDINT
U4 = KT, HELZHEMICESWTT AN A7V NRET 7 A MIT A b -
FTV T b T TADEBRNDEREINE T,

#1 L\ JavaboutiqueTestObject.xml 7 7 A VW ZBHWTC, ZONEBEEZMRELET, 2D
7 7 AV OEEIZ OV TIE, [UFT Test Object Schema -~/ 7] ([Java Add-in Extensibility
SDK ~/V 7] THIAFRE) 2B LT 7E3vy,

TAL ATV FRET7ANT, ROBREHEBLET,

> ZDTFANNDT AN ATV b e JTARBTDHAAL L Y —)LF v k&
7 KA > D451 (Typelnformation ZHEN) :

PackageName="Javaboutique" AddinName="Java"

>» HLWT AL ATV b VTR LSTHEEINDET AN ATV O
Z 2 (ClassInfo EHEN) :

BaseClassIinfoName="JavaApplet"

>» HLWT AL ATVl b 7 TADLRIEZFDOEREDT AN « TVl ko R
v v K (ClassInfo E#EWH) :

DefaultOperationName="ClickLight" Name="AllLights"
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> T A3y - 77 A LDEFT (Iconinfo EHEWN) :

IconFile="<UFT Java Add-in Extensibility SDK 4 >~ X k—)L -
7 # )L & >\samples\Javaboutique\AllLights_icon.ico"

> BIILEH LWT AN ATV 7 b AV ROERE, TOHH, F¥o A b
J%# (<Typelnfo> EHEN),

> ZDOT AR ATV b TAOFT 03T ¢ DES (<IdentificationProperties>
FHEN), Wik 7 v 37 ¢ 12i%, ForVerification, ForDefaultVerification, ForDescription
LW v —IBHEET,

HFLWAREL-Y—)Lxy k- PR—FDTFOSETRE

Z Z T, Eclipse T UFT ¢ Deploy Toolkit Support =~ > K% L C, Javaboutique
V=X b BR— b EUFTIZT 7oA LET, BfE, ZOY—1F%y NNOMWE—OD
2> hr—/ThD AllLights 2> b —ABYR—FIRTWET, YV—Fv bV
A= MIEFERELTWERAR, ZORERETIER LY RA— 2T AN T52 &
ILTEET,

1 Javaboutique Y—JL¥v b« H/R—FZ UFT 2T 7OA LET,
a [Eclipse Package Explorer] % 77 C, JavaboutiqueSupport 7' &2 = 7 h Z®IN L £ 7,

ﬂ b [Deploy Toolkit Support] R% > %27V v 74 %7, [UFT] >
[Deploy Toolkit Support] IR L E 3, @A v —UNRERRINTZH, [Yes]
7 Vw7 LTho [OK] 227U v LET,
V=X FRETFANET AR ATV FRET 7 A D, UFT DA >~
AR—)b s TH N EZRNOBEETL 7 LA Cat—SNET, ZOHRZ L -
A— ML, WEIUFT ZEBLTHRE L - 77V r—a &R L & &SR]
HTExXo2kenEd,
HAL I T —=Fy b PR— hOF FaA OFEMTHONTIE, 78 2= [
ALK = Fy kPR OTFT T A LFET] ESRLTLITEEN,
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2 UFT #iE£8L, JavaAdd-in EHRR L -Y—)LFy b -YR—+EO—FLET,

a UFTZB& £, [T FM v v~x—=Vx] A4 7w Ry 7 AT, EHFERERT
KA DY A Mz Java 7 KA D1 & LT Javaboutique N E RSN ET ([7 F
AV 3= x] FAT BT Ry 7 AREANRNEETE, THP Unified Functional
Testing 7 KA« A ] OFIEESR LT ZEW),

b Javaboutique DF = v 7 - Ay 7 AEFRL, [OK] #2 Vv 7 LET, UFT A
BE, LR —bEr—RLET,
3 ILWARSL-HKR—FETFRMLET,

244 ~X— TAllLights 2> k@ —/ L O R — hOFHE] OFIE 2 8LV 3 2V IEL
T, ROBHAEEFATLET,

> 77V r—varEFETLET (UFT 137 7Y r— g COREBIICT 7 ) 7r—
va OBk EMSLT 572, SampleApp 77V r—3 3 U EKT LT LEE
FATTHAMERH Y 7).

» UFT A7V =7k« AL 2 LT, AllLights 2> hr— L &2 &R LET,
> AllLights == > ks 1 —/L o Click #/E& 78k L3,

273



EoBEFEHLIY FO—ILDYR— FHEDEE

274

UFT i%, (to_class_attr X ¥ v RiZfit~> ) AllLights = > k@ —/ L% AllLights &\ 9
BB (IAB I 7T ADLET) O AllLights T A b - 47 V=27 & LT LET,
AT b ARSI, ZOTAL AT b I TRIHKH LT 4=
TRELETA arnFrEnEd,

2 Object Spy @
(& S e

Ohiject hierarchy:

Properties | Dperations]

) Mative @ |dentification
Properties Values (FE
o Class Name AllLights il
Aoy abs_x 4 e
Ay abs_y 42
T attached text
4T+ background white
4o class_path org boutique toalkit AllLights
4o developer_name
%o displavable 0 i
Selection;
Class Mame
Dezcription;

Degcriptions are available only for test object operations.

Lloze

KL NAFLERD A —"—F 4 RIZ5ET LTWE T2, mouseClicked (MouseEvent
arg0) A XUk N RT Ay ROEEPRET THLIZD, 77V r—var
D7 L—b%E7 Yy LThH UFT T bREINET A,
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UFT T, AllLights 47 V=7 v &4 7 V=7 F« VR FVIZBEML, ¥—U—FK -
Ea—TCTIDA TVl beGheT AN« A7 v 7 HERLET,

Item Operation | Yalue Comment | Documentation
w @ Action]

] AllLights él:ilil::Ii.Lig}'llE Clicks a specific light

R E TlX, ZDAT v 7 Of#{E (Operation) & LC, ClickLight 7 A k « A7 Y=
Kb Ay RREIRENET, ZOXA Yy NIIRERGIEEZRMILL, Z0oRXT v
EELT A NEIAT LIZGE, FATHD 7 —RRAELET, 2L,
ClickLight_replayMethod # >~ K73 NOT_IMPLEMENTED % ik7 7% C9,

AllLights 3> FO—JLDHR— DR

ZZTIE, TERRL7-EHE (244 22— TAllLights =2 h m— L DHR— F OFHE]) (2
W T, AllLightsCS 27 5 A %258 LT AllLights = > b 2 —/L®D UFT ¥ R— b Z¥RE L £ 4,

AllLightsCS.java 7 7 1 V% B X £ 9, label_attr X >~ KT, =2— K return
super.label_attr(obj); % = — K return "Lights"; TEEZ#2C, T A K « ATV 7 FO4
MEZE LET, £0%, ROFIEZFEITLET,

LW T 08T 4 O R— FDFEE (275 =TV EBMR)
HLWT AR ATVl b e AV RIZHT AT R— FOFERE 277 X— %)

FEROY R — FDFEE 2718 R—V 25 M)

Y Y VY Y

SER LY R—FOTF AR (280 X— T EHIR)

FLLWRBE IO/ T 1 DY R— FORE
ZZTIE, Alllights 7A b « ATV x s b I TRAZERBLIZH LWV T 2T 1 &
PR—=bTDAY Y REFEELET,

AllLights W AX I« 7 T A&GHT LT, P R—hENTWB 707 o 2R LTI, B
HT AR T 0T 4 &2 UFT IR 272018, TILWTER—h « 7T ANBT 78R
TEAHA7aXT 42 RELET,
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RXT Y w7« A K GetcounterOn (DR TA N2> TWD T A MO EHERT
x3) LisSet FHFEDTA FDAT—H ZA%&RT) [ZHEHLTLEEW,

1 oncount_attr A Yy FERELFT,

oncount_attr X ¥ > NG, =2— K return null; %
return String.valueOf(((AllLights)obj).GetcounterOn()); TEE#ZF T,

T DEIEIZ X 5T, AllLights B AF 5+ 7 T ANE 00 2 PEIG ST UFT IZIRE
nET,

2 onlist_attr AV FERELFT,

onlist_attr X ' » K¢, ==— Rreturn null; ZHIfRL, RO XL IIZ, $XTOITA b %
AFx LT, AR TNDHTRTDOTA DY R MEERT DAY v NE el
LET,

public String onlist_attr (Object obj) {
AllLights lights = (AllLights) obj;
StringBuffer buffer = new StringBuffer();
for (int i=0; i<5; i++)
for (int j=0;j<5;j++)
if (lights.isSet(j,i)) {
buffer.append (" ");
buffer.append (i*5+j+1);
}
return buffer.toString();

3 gameover_attr * Vv FZEELET,

gameover_attr A v KT, 22— Kreturn null; Z{IBRL, RO L IIZ, +XTHTA
FRF AT TODEE I DTG LT Yes 721 No KT A Y v REFHELET,

public String gameover_attr(Object obj) {
if (((AllLights) obj).GetcounterOn() == 25)
return "Yes";
return "No";

[File] > [Save] ##E{RJ 52>, [Save] "¥ %7 U v LT AllLightsCS.java
T ANERELET,
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FLOWTFRAR AT H b AYy FIZHT 2H9R— FOERE
ZZTlE, Alllights 7A b « A7 V27 b« ZTRAZHLTERLIZHLWT A K - F
TVl b AV REYR—FTDHAYy REEELET,

AllLights #AZ I« 7 TADAY v REGHTL, =—¥2 [RESTART] A& £
Uy FNOTA b7 Vw7 LTmE XL, VAL oTHEITEINDT 7V a U ERE
LEd, UFT CT AN ATV b+ AV REFTTIEI, o7 7y
a2l —bMTAMENRHY T,

1 Restart_replayMethod * Vv F£EZL %7,

a2 —H%73 [RESTART] R& L OEERONME 2 U > 735 L, AllLights H A X A+
Z A% init & update(lights.getGraphics()) Z/ O L, 77V 7r— a > 2 #Hb
L CHEHiE L £9, Restart_replayMethod * ¥ > KTi&, RIU A Y v REFOHL
T, ZOEMEEY I 2 L— N H0ERHY 7,

I NEAT HZiE, =— K return Retval. NOT_IMPLEMENTED; #HI%& L T, kD X 5
WZA Yy REFELET,

public Retval Restart_replayMethod (Object obj){
AllLights lights = (AllLights) obj;
lights.init();
lights.update(lights.getGraphics());
return Retval.OK;

2 ClickLight_replayMethod * Vv K& L% T,

AllLights 7 A 4% A« 7 F A%, mouseUp £ X M aZ I TW -7z & X2, 7 U v 7%
CTIA MaAERBFATICTHT7 VT AL &eFETLET, £D), UFT T
ClickLight_replayMethod Z#E4T L, $5ED T A R TDI/ Vw7 %I al— T 55
&%, AllLights 47 ¥ = 7 MO 72 EIE % & T mouseUp £ N M &EEFET 2721 T
WHET,
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A v | ClickLight_replayMethod T, = — [ return Retval. NOT_IMPLEMENTED;
ZHIFRL, ROE DAY v FEFIELET,

public Retval ClickLight_replayMethod(Object obj, String Row, String Column) {
AllLights lights = (AllLights) obj;
int col_num = Integer.valueOf(Column).intValue();
int row_num = Integer.valueOf(Row).intValue();
/* Row and column are 40 pixels wide*/
Event event = new Event (lights, System.currentTimeMillis(),
Event. MOUSE_UP, col_num *40, row_num *40, 0, 0);
lights.mouseUp(event, col_num *40, row_num *40);
return Retval.OK;

F:Zo=a— &V AR— T 5203, AllLightsCS.java T java.awt.Event % 1 7K —
]\ Lijﬁo

[File] > [Save] #&{RJ %7, [Save] ¥ %27 U v 7 LT AllLightsCS.java
T ANERFELET,

RERDOYR— FDEE
AllLights = h = — /L TOREFKE YR — b THLIFEH L TWDHIED, ZOFT V=
7 b ETOR L~ VEEETIEL, Z0aryha— L ETI TR A XU RE2Y v R
THIEOITEELE LT,

AllLights = b r—/L ECRsaE MY T DU EOH LI T A < A XU ML, U A -
7y ZIEGTY, D7), Z 2 TiE, mouseClicked (MouseEvent arg0) - <> | -
NYRT =AYy ROBZEFEEL, ZOMDA X b N RT - AV Y RIIZEOEF
ICLET,
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mouseClicked 2 ¥ v & kD J 51254 L, AllLightsCS.java 7 7 A LV Z{REL E T,

public void mouseClicked(MouseEvent arg0) {
AllLights lights = (AllLights) arg0.getSource();
int x = arg0.getX();
inty = arg0.getY();

try {
if (lisinRecord())
return;
/* If click is within the Restart button borders*/
if (x >210) && (x < 270) && (y > 165) && (y < 185)) {
MicAPl.logLine(DEBUG_ALLLIGHTSCS, "Record Restart operation");
MicAPl.record(lights, "Restart");

}

/* If click is within the borders of the grid - record a ClickLights*/
if (x >= 0) && (x < 200) && (y >=0) && (y < 200)) {
MicAPl.logLine(DEBUG_ALLLIGHTSCS, "Record ClickLight operation");
MicAPl.record(lights, "ClickLight", new String[]
{String.valueOf(y/40), String.valueOf(x/40)});

}
} catch (Throwable th) { MicAPl.logStackTrace(th);}

3 : AllLightsCS.java 7 7 A /L DERREEIZ, Z D 23— RO YR — T &4 ZE 7 import
com.mercury.ftjadin.custom.MicAPI 28 7 ¢ ¥ — RIZ X > THEMIZEM I TV ET,

TDARS B e N RT e XYy RTIE, MicAPLrecord % & £ X £/ HIETIHEOH L
¥, Restart BEZ T HHEAIE, A7V 27 N e BELAEIEETHEITTT,
ClickLight #{E% FRe%9 DAL, 7V v 7 L7 4 M OEEEZ RT5I5EETREL
351;_‘0

isinRecord 2 V v RZIEOH T DIE, UFT DNEREZ T TWRWIEAID, HED RO
TEEFIT LW E 52T 5720 T,
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MicAPl.logLine #* ¥ v Ri%, DEBUG ALLLIGHTSCS 7 734 Th DB AT DT,
Avk—UEal « 7y A UIHAOLET, GOV TIE, 88—V THRAZ A -
R—h 27207 TNy 7] ZHRLTITEIN,

try ...catch 7 2 v 7 (X, UFT 37 A R/VIREED L X2 Java 77V r— a & FITL
TZDa—RIZHEELEZLAIL, LEORVWEIEREITIA VI SITL T,
MicAPl.logStackTrace * > FiX, A% > 7 + kL —Z% Java Add-in Extensibility D%
Mous s Aye—VERILRY - 77 AMIHTILET, 2L Y, mouseClicked
AV RRBOTHRHENTEA IV T ERETHIENTEET,

SR LY ER—FDTX K
T ZTUE, SERK L7z Javaboutique Y —/b¥ » b AR — R ETFTAMLET, TOLDIT
%, UFT T® AllLights 2> hB— L DERRBED LS mEEEZ T I0E 0T LET,

EELI=DXJava DI T A+ T 7 A VDIRT, RET 7 A WVTEEL TR\, ¥ —
¥y b BR— e UFTICHET 704 LTT A M H083IH 0 A, BT
% UFT & v ¥ 3 (Javaboutique Y —/L& v b » iR— b & o — K L72IREETEITH) %
T2 Z SIZTFTRETT S, W AKX A - YR — MR 5 2 K4 5121%, AllLights
TV r—var il T L THEFEITTOILERD D £7°,
1Tz RNRLTHLWHIRE L - HR—FE2FRAMLET,

a AllLights 77V r—a v z#kTL, BERITLET,

b UFT %#i£#) L, Java Add-in & Javaboutique > —/VF v h R —FrE2r—RKLET,

€ GUITAR&ME, A7 V=2 b« A3 2l LT AllLights D7 1255 1 & A
Vv %A LET, Alllights 7 2 b+ 47 Y= 7 k047 Lights 12720 £
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2 AliLights 3> FO—JLE®D UFT TR FZERRLTETLET,
a AllLights 2> hu—A%FT AR« A7 V=27 b« VR RVICBEMLET,

b 7VyFNO2005FHE7 ) v 7L, F—bB3 & TLTWRNWI LEEZRLT,
[RESTART] %27 Vv 7357 A ME{EHRLET,

YERRT 2T A2 M, kDXL DT £,

Itern Operation | Yalue Comment | Dacumentation
@ Action
Q Lights ClickLight :"4"."4" Click the light in raw 4" column 4"
Q Lights ClickLight :"1","2" Click the light in row 1" column 2",
Q Lights Check CheckPaint[ Lights") Check whether the "Lights" object has the proper walue
Q Lights Restart Click the RESTART button,

3 : ClickLight_replayMethod I%, SI#DEZTF = > 7 L THEPARTH D028 5 D>
ERER L ET A, BSOS ERE L72HE FIEIITRA 4 L0 KREWEE),
FATHE T —NHELET,

€ TAMEFITLTC, ELLKEETAZ LE2MERLET (F—2BKTLTWARWE
LT EMHERTDIEIIICTF v I RA LV FEERLIEEA, 7 A MITh LET),
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3 AllLights aY FA—JLEDQBREEFTHELET,
a UFT T, HILWUFT 7R b&{ERL, [FRER] > [REREETRIRHRE] 23BN L

T, (RS EFITRIERTE] ¥4 70l Ry 7 A& ET, [Javal] ¥ 7 C, [F
WTWB3FRTDJavaZ7 TV —S a3V TTRAMERBELTRITTS] @R L
F9, Web 7 FA v bu—REns%540E, (Web]l 7%V 7 LT [RWT
WBRTRTHDTSHUYFTTRAMERBELTENTTS] @R LE7, [OK] 27
Vw7 LET,

(Fe8%] A& %270y o350, [RE8&] > [RBEk] 2&#RLET, 7V v K,
[RESTART] "%, B 272 ¥, Allights 77V 7r—3 a v NOSFE8F 7R
Yz )y 7 LET,

7Yy RNE2Z Y w745 &, T A M ClickLight 27 > 7 & B4 5 5154380
SNhFET, [RESTART] A& > %7 U w735 &, Restat A7 v 7B I E
T, 1ENOEFHEZ Y v/ LTH, BRIk shErA (KL -wo X - A
AU NRRERE NS LT2To®), RERSIIZT A BT, IROX DT £,

Item Operation | Walue Comment | Documentation
~ @ Action

----- Q Lightz ClickLight 2,2 Click the light in row 2" colurmn 2"
) Light:s:é Restart Click the RESTART button.

(k] RE 2 V7350, (B > [(Bk] 28R Rty va vz
HTLET,

IIT, HAX L - YR — NOFERHIRD I ERICHE > T, AllLights 7 A X A - 33
b= L REEICR— hEhE LT,
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LYRVDEED

IOV AT, BT e T4 T AN AT V27 b AV REEHELT, #H
LWFA b A7 Yx2 b+ 2752 (AllLights) Z1FR L% L7, $£7=, AllLights =
ra—O¥AR—hE/ER L, UFT T AllLights 7 A ~ «+ A7 Y= 7 & LTRR#MEND
LoltLE L,

> TAL ATV FRET 7 ANMTONWTEHLE L,

> DAF L« PR —h - JTRATOFLOVRHE T XT 4 ET AN ATV b A
Yy ROYHR— FHFEIZOWTFEELE L,

> is_window = —7 4 UT ¢ « AV v R&EMFEHL, BT A —2%HH LT
MicAPlLrecord X ¥V v REZMOH L E L7,

T DRDIER

INT, ZOFa—FrITADL Y AT RTERTLELE, ZOLYy AL TEEL
7= Java Add-in Extensibility D& X FRAX NV EZBH DT AL LV —LF vk« $R— |k
DOYERRICIEA L TL 72 &0,

HAL L —)bFy ke FR—F -y hO#EELENEOFEMIL, 35— ThR¥
Lo V=X FhOPR—FDFEE] 2L TLEE N,

TAN ATV NEET 7 A NVORERE & NEDOFEMIL, TUFT Test Object Schema ~/L
7 ([Java Add-in Extensibility SDK ~/L 7] CTHIHAEE) 2B L T E &0,
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